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INTRODUCTION
WHAT IS ARCON?
ArCon is a software program that turns your dreams of living into reality.

It is completely irrelevant whether you prefer to live in an apartment or a house. You use the methods that
you would apply in a real-life situation: first you build your home, then you furnish it. Except that it’s a lot 
quicker and it takes place in three-dimensional space. But don’t worry, you won’t need to take a course in
computing. ArCon takes care of sorting out the microcosm of bits and bytes. You draw as usual, only 
more elegantly. Instead of a drawing pad you use the screen, and instead of a pencil and eraser you use 
the mouse cursor.

ArCon needs a fast Pentium computer with at least 16 MB of RAM memory, a high-resolution monitor and
the Windows 95 operating system. More information can be found in the chapter Installation.

You will probably remember the term plan view from your school days. Firstly the plan view is drawn. The 
screen contains a dot grid into which you can insert the walls. Then doors, windows and staircases are 
installed. Then the decisive step follows: you can furnish your home. Make use of ArCon’s self-service 
furniture market. Everything that goes into making a comfortable home you will find in the catalog, and it’s
completely free! Paint and paper the walls, install a luxurious fitted kitchen, tile the bathrooms, fill the 
rooms with furniture and hang curtains and lamps. There are no limits to your imagination. Is there 
enough daylight coming through the cellar windows? ArCon will let you know. Because you are working to
scale, you notice by coincidence that the wardrobe is too wide for the wall section. No problem. ArCon 
works accurately to size. Just lean back in comfort and admire your work.

Build your house up by adding more stories. You can have the perfect roof for your house with just a few 
inputs. Face or plaster the outside walls.

ArCon is self-explanatory. You can get new ideas while reading up the manual. To save you the trouble of 
looking up a command in the printed reference section, ArCon also provides on On-line Help system.

With a click of the mouse, you are given context-related information on the current command.

And now you can really get to know ArCon: walk into your home, look around. Switch on the lights and 
observe the shadows they cast. Of course, your can also look around the outside of your house. Are the 
wall construction, facade and roof shape to your liking? Any details you are satisfied with you can print out
in color and show to your friends. This is anticipated reality through virtual architecture. And if there’s 
anything you don’t like, change it - at the flick of a wrist. ArCon will forgive your mistakes - and it doesn’t 
present you with an invoice.



WHO IS ARCON AIMED AT?

ArCon is for the expert and for everyman.

With ArCon you can work accurately and professionally, and it enables you to get a first impression of 
your building project. Why? Because to answer the question “is it possible?”, you don’t need accuracy to 
the centimeter.

You don’t need to be a computer freak, nor do you need to be an architect or construction engineer. But 
you should enjoy designing. This is a challenge to your creativity. ArCon takes care of everything else. 
ArCon takes its name from architecture and construction. But ArCon can do a lot more than this. With 
ArCon you can “do magic”.

ArCon is intended for people planning to build a house, or even for young people who may wish to build a
house at some time in the future and are still at the pre-planning, or even the dreaming stage. If you are 
about to buy a house, draw it with ArCon and furnish it. This will mean the end of expensive surprises. 
And if you intend to modernize or newly furnish your home, ArCon can also help by answering the 
question “how would the living room look if we laid a burgundy carpet? Does it match the green leather 
upholstery?”. Well, why not have a look. Perhaps you will then decide for a carpet in rosewood. Perhaps 
you would prefer something completely different.

But may be you are a computer freak, or simply enjoy working with computers. ArCon is also fun to use. 
You can create and modify three-dimensional objects with playful ease. And all this in real time and in 
impressive quality.



HELP IN ARCON

ArCon contains a comprehensive On-line Help System, which comes to your aid when you don’t know 
the meaning of a particular term or what a certain button does. There are several ways of obtaining Help 
in ArCon: the first is to press the F1 function key. The F1 key can be pressed at any time, and you are 
presented with the ArCon Help Overview screen, from where you can branch to any other point in the 
Help system. The mouse equivalent to pressing the F1 key is to choose Contents from the Help menu.

The second means of obtaining help is to select Search from the Help menu. You can then enter a 
specific expression you wish to search for help on. You have undoubtedly used this function in other 
Windows programs.

The third possibility is to use the  button. When you click on this button, the normal mouse pointer 
changes to a mouse pointer with a question point attached. Click the modified mouse pointer on the item 
of interest. ArCon will then automatically switch to the corresponding place in the Help text and presents 
you with the required information.

The final method of obtaining help is through ArCon’s status line, which is always displayed at the bottom 
of the ArCon window and provides information on the item currently under the mouse pointer as well as 
the short help messages displayed when you hold the mouse pointer over a button for longer that a few 
seconds. By the way, you can switch off these help messages by choosing Brief infos from the Help 
menu.

The final item in the Help menu is the item Info. Click on this menu item to read information on ArCon.

If while reading the Help file you click on the  button to advance one page, you can use the Help 
file just like a “User Manual”. In this way, you can “thumb through” the Help file from beginning to end.

One more tip: by clicking on one of the buttons that appear in the Help text, you will be taken in most 
cases straight to the place in the text that describes this button. Try it out using this: 



USING THE OPTION SWITCHES

At various points during the Working with ArCon , you will need to use    so-called option switches. These 
can be recognized by the fact that a small black triangle appears in the bottom right-hand corner of the 
button. These tools can take on various forms; to obtain a form other than that currently displayed, hold 
down the left mouse button on the required tool and drag the mouse pointer out and to the right. The 
various alternate forms available will be displayed. Move the mouse pointer to the required form and then 
release the left mouse button.



SETTINGS TO MAKE 
ArCon gives you the opportunity to make a wide range of adjustments to its operational behavior to match
the capabilities of your computer with respect to storage capacity and speed. Although ArCon will in 
principle run on “smaller” PCs, we urgently recommend the use of a Pentium processor with at least 16 
MB, preferably 32 MB of memory. To adjust ArCon to your computer’s specifications, proceed as follows:

· Start ArCon

· Choose Program Settings from the Options - Program menu. A dialog box will be displayed in which
you should make the following entries, depending on the specifications of your computer.

For computers with less than 16 MB of memory:

1. Buffer memory for 3D views 1600 Kbytes

3D pixel size 2 times 2 pixels

Color depth for 3D pixels High Color

Size pre-generation (Mipmaps) not marked

Buffer size for textures 256 Kbytes

Path for objects freely selectable

Path for textures freely selectable

For computers with more than 16 MB of memory:

Buffer size for 3D views for the entire Monitor

3D pixel size one pixel

Color depth for 3D pixels High Color

Size pre-generation (Mipmaps) marked

Buffer size for textures 256 Kbytes



Path for objects freely selectable

Path for textures freely selectable

The entries for Path for Objects and Path for Textures may be different from those shown in the 
illustration. The correct entries will be made automatically by ArCon’s Setup program and there is no 
need for you to make any amendments.

· Confirm your entries by clicking OK.

· Choose General from the Options - Program menu. The one dialog box will be displayed:

· In the area Limit the number of polygons on walkabouts select show all if you have a very fast 
Pentium. Otherwise select limit to and enter a number between 1000 and 2000, depending on the 
speed of your computer. In the area Display of moving picture components select as wire frame, 
colored, without texture, textured, average quality or as for stationary picture components, 
whereby the first option is the one which is least demanding on processor power; the last option is the 
most demanding. Deselect Update illumination while moving lamps.

· In the area Observation head, 3D input you should deselect swap left and right for the Observation 
button and for Movement with right mouse button pressed select “into” the screen.

· Close the dialog box by clicking on OK.

· Exit ArCon by choosing Exit from the File menu.

Note: the settings you made in the first dialog box (Program Settings) are evaluated only at the start of 
ArCon. Therefore, to achieve the desired effect, you must make the required changes, exit ArCon and 
then restart ArCon. Normally you will make these changes only once for your particular computer and 
won’t need to change them again.

After making the entries described above, the settings for ArCon are complete.

These adjustments are necessary because the settings described depend on your computer’s memory 
configuration, and also on your own decision as to whether you prefer a slow, but high-quality screen 
display or a very fast screen display, but perhaps with a reduced image quality. If you have a fast Pentium
computer with at least 16 MB of memory, the settings made on installation should be correct for you. In 
this case, there is no need for you to make any of the above changes.

 BASIC INFORMATION



BASIC INFORMATION FOR PROGRAM OPERATION

ArCon is in many ways very similar to other Windows 95 programs, but differs in other ways. If you have 
already worked with other Windows programs, which we will assume, then you will be familiar with the 
principles of operation. You know how menu items are chosen from menus, how to enlarge and reduce 
window sizes and how to start programs. If you are unfamiliar with any of these procedures, then now is 
the right time to brush up on them in your Windows 95 User’s Guide. 



BASIC LAYOUT OF THE ARCON SCREEN

As is also the case for other Windows programs, the ArCon screen consists of a menu bar and one or two
other tools bars below this menu bar, and one or two other tools bars at the left-hand side of the ArCon 
screen. The menu in the menu bar can take on one of three different forms. The first is displayed when no
project has been loaded. It consists only of the two menu items File and Options. You are presented with
the second view of the menu bar when you are in the Construction Mode . Here you can make the 
adjustments that are valid in this mode. The third variation of the menu bar appears in Design Mode    
Some parts of the menus for Design and Construction Mode are identical, others are different, just as 
parts of the program operation in Design Mode are the same as in Construction Mode and other parts are
different. 

Apart from the menu bars, you will also see the toolbars already mentioned. Buttons are grouped in the 
toolbars which allow selection of certain operations or various types of views, etc. Buttons appear in the 
upper, horizontal toolbar which are valid for the entire project. The second horizontal toolbar, which is 
always situated below the first one, can only be seen in Design Mode. Here you can make adjustments 
that apply to the current window. 

Apart from the horizontal toolbars, ArCon uses vertical toolbars which are always placed to the left of the 
screen. From these toolbars you can choose the various tools used in Construction Mode, in Design 
Mode you can manipulate your furniture items using these buttons. Neither the upper horizontal toolbar 
nor the left vertical toolbar will change as long as you remain in the same mode. This means that you will 
always find the same buttons, whether in Design or Construction Mode. This is in contrast to the inner, 
second horizontal and vertical toolbars. The second horizontal bar appears only in Design Mode, as 
already mentioned. This is used for making adjustments which apply to the view currently being 
displayed. Thus, if you have opened several views of your project, you can make changes that apply only 
to the current version using the second horizontal toolbar. The vertical toolbar appears only in 
Construction Mode. In contrast to the first vertical toolbar – with which you determine what you enter 
(“What” toolbar) – you use the buttons of the second vertical toolbar (i.e., the innermost of the two 
toolbars), to determine how the selected element should look (“How” toolbar).



A FEW DETAILS CONCERNING THE BUTTONS IN THE TOOLBARS

The individual buttons on the toolbars in the same way as buttons in Windows 95. You click on them, and 
appropriate operations are performed or an appropriate dialog box will be opened. However, in contrast to
other Windows 95 buttons, some of these buttons can show different contents which are defined directly 
by you, the user. These option Buttons, or option switches, can be recognized by the fact that they are 
marked by a small black triangle in the lower right-hand corner. To see the selections provided by the 
option switches, click on the appropriate button however, do not release the mouse button, drag the 
mouse to the right out of the button. A list of the various options associated with this button will appear, 
and you can then position the mouse on the option that you wish to select. Information on the function of 
the individual options is given in ArCon’s status line, at the bottom of the window. Whenever you 
encounter option switches in the following text, the text will show all of the possible options on this button 
displayed alongside one another. For example, when you see the picture , you will 
know that this is an option switch with seven options. On the other hand, single buttons are displayed, for 
example, as 

. 

Apart from the button’s property of being an option switch, you can generally also make certain settings 
by right-clicking on the button. A dialog box will then appear in which the required settings can be made. A
not inconsiderable part of this manual deals with these settings, by means of which you can make a wide 
range of adjustments to ArCon to suit your individual requirements. 



THE CONSTRUCTION AND DESIGN MODES OF ARCON
A principle and important concept in ArCon is working in two different modes –Construction Mode and 
Design Mode.

In Construction Mode you enter all “static” elements of your home. These include walls, windows and 
doors, chimney stacks and roofs; that is, all the elements that won’t change when you move in. However, 
in Design Mode you fit out your home with furniture and accessories and you can change the appearance
of your design using paint and wallpaper, for example. 

In Construction Mode you always work on a plan view, which shows your plans from above. In Design 
Mode, however, you can use various views: a view which is very similar to the view in Construction Mode,
as well as a colored plan view and a perspective view, in which you can freely define the position from 
which you view your design in all three spatial directions. a detailed description of Construction Mode and 
Design Mode    find by clicking on the required Mode.



WORKING WITH STORIES

In ArCon, you can plan and visualize your home with almost as many stories as you wish. The main 
influence on the number of stories you can have is the amount of memory you have in your computer; it 
will generally be sufficient. 

So as not to lose sight of what you are doing, in Construction Mode you can only enter data for one story 
– the story you are currently working on. However, you can swap between defined stories whenever you 
wish, but entries refer only to the current story. In Design Mode, You can display all stories at once, to 
obtain an overall impression of the house, for example, and you can also display individual stories or a 
selection of stories. 



THE MEANING OF SPECIAL KEYS IN ARCON
Almost all input in ArCon is made using the mouse. Exceptions to this are numerals, input in dialog boxes 
and certain control commands. In the Appendix you will find a list of all keyboard shortcuts and their 
functions. The Control (Ctrl) key has a special significance in ArCon as does the Shift key. In ArCon, 
these two keys have the function of modifying certain commands or program behavior. 

THE CONTROL KEY

The Ctrl key in ArCon serves the purpose of suppressing certain dialog boxes which would normally 
appear after clicking on a button. If you hold down the Ctrl key while clicking on a button, the relevant 
dialog box will not appear; normally it will. If the dialog box does not appear, the settings used will be 
either those you last entered into this dialog box, or, if you have not made any changes, the standard 
settings, which contain reasonable values. In principle, the use of the Ctrl key when clicking on a button 
has exactly the same effect as clicking on the button without Ctrl and then immediately closing the dialog 
box by clicking on OK. In a way, therefore, using the Control key is a shortcut.

THE SHIFT KEY

In contrast to the Ctrl key, which represents a shortcut, the Shift key provides a sort of workaround. By 
pressing the Shift key when making certain inputs in Construction Mode, you can increase the 
functionality of this input. You can use the Shift key to manage certain difficult constructional tasks. You 
will find more detailed information on this in the description of the various input options in Construction 
Mode .

In departure from the above, the significance of the Ctrl and Shift keys is somewhat different for the 
Walkabout function . If you press Ctrl or Shift when walking around your home, the speed of motion is 
increased by a factor of 4; if you press both together, the speed of motion is increased by a factor of 16. 
This feature can be used, for example, to approach your house more quickly when you are at a relatively 
great distance from it.



THE PAGE 
Because ArCon uses the “what you see is what you get” approach, you are not only able to display your 
three-dimensional designs on the screen, but your plans will look exactly the same on paper when they 
are later printed out. For this purpose, ArCon has two different views in Construction Mode , the Normal 
View, in which your workspace is “unlimited”, the Layout View, in which you can also see the borders of 
the paper in the workspace. If you display the whole page in Layout View by choosing Whole Page in the 
View menu, you can see what you will get in the final printout. You can switch between Layout View and 
Normal View by choosing Layout View or Normal View in the View menu.

The menu item Whole Page in the View menu is only available in the Layout View, it is grayed out in the 
Normal View. Both of these views also exist in the 2D display in Design Mode. The Layout View is 
incidentally of special interest if you want to shift the page beneath the plan .



DISPLAYING PARTS OF THE PLAN

In the 2D views, both in Construction Mode and in Design Mode, you can display details of the plan by 
selecting any desired degree of enlargement or reduction. This is done either by using the  and 

 buttons or by choosing Enlargement, Reduction or Show all from the View menu. If you are in the 
Layout View , you can display the entire page by choosing Whole Page from the View menu. If, while in 
this view, you notice that what you have constructed in Normal View does not fit completely onto a sheet 
of paper, (and therefore only part of would be printed out), you have several possibilities to move your 
construction into the correct position.

1. You can change the scale of your plan so that your construction is smaller relative to the page size.

2. Change the paper format.

3. Shift the page “beneath your plan”. This is done as follows: switch to Layout View and zoom the 
screen display until it is so small that you can still see enough gray border around the page.

Following this, you can shift the page by clicking with the mouse on the edge of the page and then move 
the page while holding down the left mouse button. During the shift operation, your entire plan will appear,
including the part that had originally “disappeared” outside of the page. You can now position the page as 
you require it. When you release the mouse button, the page will be centered in the display and the 
contents of the plan will “slide” accordingly in the opposite direction. 



SOUNDS

Certain operations in ArCon can be “signaled” using sounds. These include the opening and closing of 
doors, walkabouts, elevator riding, etc. Of course, you will only hear the sounds if your PC is equipped for
this.

In principle, there are only three reasons why you may not want to use sounds.

1. You don’t have a sound card. In this case, you should switch off the sounds so as not to “waste” 
computing time.

2. You prefer things to be a bit quieter. 

3. You wish to achieve better speed on walkabouts. In this case, it is recommended that the sounds be 
switched off to relieve the additional burden on your PC.



PREVIEW WINDOW

In every dialog box for defining object options, ArCon displays a preview window. It displays the object to 
be worked on together with the standard values that have been entered for this. All changes that you then
make in the dialog box, be it dimensions or the surface finish, can be viewed immediately. If there is a 
Preview button to the right of the dialog box, then the contents of the preview window will be updated by 
clicking on this button after extensive calculations have been carried out. (e.g. staircases). For most 
objects, the preview window updates automatically after a change has been made to an entry. The 
objects can be viewed by the user from any desired position. 

The following picture provides an example of a preview window:

The procedures to be followed are as follows.

If your mouse pointer is placed in the preview window, it will change to the following shape

.

ROTATION 
Click the left mouse button in the preview window and hold the mouse button down. Move the mouse 
pointer around in the window and you will see that you are able to rotate the image in all directions.

ZOOMING

In the lower right-hand corner of the preview window you will see key fields with “+” and “-”. at the ends 
of the scroll bars. If you click the left mouse button on “+”, the object will be enlarged, if you click on “-” it 
will be reduced.

Additionally, it is also possible to zoom directly in the preview window. Move the mouse pointer into the 
window and press the right mouse button. By moving the mouse downwards while pressing the right 
mouse button, the object will be enlarged, by moving the mouse upwards, it will be reduced.

SCROLLING

Scroll bars are provided at the right and lower edges of the preview window. By clicking and dragging the 
control bars, you can move the screen contents up and down or right and left. By clicking on a, the 
complete object will re-appear in the window.



GENERAL WORKING PROCEDURES IN ARCON

In contrast to all other toolbars, the buttons of the upper horizontal toolbar do not change while you are 
working with ArCon. The buttons on this toolbar can be used to change settings or to initiate operations, 
which is possible both in Construction Mode    and in Design Mode . This includes the creation of new 
projects, loading and saving a project, printing or saving images, enlarging and reducing views and 
switching various plan details in and out of the plan. For example, you can define whether the 
dimensions, the rule or the roof are visible or not. The toolbar contains in addition a selection list from 
which you can select the story to work on. 

In contrast to all other buttons on the upper horizontal toolbar, the stories selection list applies only to the 
current window. If you have more than one window open, then you can display, for example, the ground 
floor in one window and the second floor in the other window. 

Certain views are possible only under certain conditions. If these conditions are not met, then the 
corresponding buttons are shown grayed out. 

Various options can be set for most buttons. This is done by right-clicking on the button. The options in 
question can be found in the corresponding sections of this User’s Guide. 



AN OVERVIEW OF ARCON’S CONSTRUCTION MODE

Apart from the Design Mode, the Construction Mode is ArCon’s most important mode. In this mode you 
enter the architectural features of your house plan. All fixed items in your house or apartment – that is, 
things which are generally immovable (which will not change on moving house) – are constructed in 
Construction Mode. In contrast to this, in Design Mode you fit out your home, to which end a whole range 
of furniture and accessories are available. You can switch Construction and Design Mode at any time by 
clicking the  button    . When you start a new project, you automatically start in Construction Mode. 

The Construction Mode shows your current plan from above in one or several views - you can use as 
many views as you wish. Depending on the degree of enlargement     you will either see just parts of 
your plan, or the entire plan. Apart from the views of your plan, you also have use of the menu and a 
horizontal toolbar directly below the menu and two toolbars at the left-hand side of the ArCon window. The
entire left-hand toolbar contains all items that you are able to place Construction Mode; it is therefore a 
“what toolbar”, so to speak. This allows you to select windows, doors, walls, and staircases, etc. 

Through the use of option switches various options are “hidden” behind the various buttons, from which 
you can select the right one for your purpose. The second vertical toolbar has various buttons with which 
you can define the “how”, depending on the “what” selected. “How” in this case means how you enter a 
certain constructional element into your plan. 

This is illustrated by the following example: If you wish to set up a floor plan in ArCon without windows 
and doors, then you can draw each wall separately by clicking on two points,  or, if setting up a series 
of adjoining walls, 

.

Having the possibility to decide how you enter certain elements means that you can work very effectively. 
Certain elements on the “what” toolbar are equipped with various options. In this case the “how” toolbar is
empty.



GUIDES AND RULES
A very important constructional aid in ArCon are the guides. You can use these guides to take care of 
various constructional tasks in your plan. You used the guides together with the Snapping function    to 
position items in your plan exactly or to define a new position by the intersection of several guides. 
Constructions to scale in ArCon are made very simple through the use of guides. You will find further 
information on Guides on clicking.

Apart from guides, Construction Mode also provides rules as a further aid to entering objects. This rule is 
reminiscent of a normal rule you may have on your desk; its purpose is certainly very similar. With a little 
practice you will be able to solve practically all constructional tasks with precision using guides and the. 
rule    .



WHAT CAN BE ENTERED IN CONSTRUCTION MODE

In Construction Mode, ArCon offers you the possibility to enter walls, windows, doors, supports, chimney 
stacks, staircases, roofs and slabs, etc. Furthermore, you can afterwards insert openings in ceilings and 
vary the properties of automatically constructed ceilings and floors. And last, but not least, apart from the 
guides already mentioned, the insertion of text at any point as well as semi-automated scaling is possible.
ArCon possesses a high degree of intelligence and provides you with optimal assistance when using 
these constructional elements.

Of course, you will have to enter the individual walls into your ground plan yourself, as every ground plan 
is different. But you generally don’t need to concern yourself with providing your rooms with ceilings and 
floors: ArCon knows that rooms are surrounded by walls and the required floors and ceilings. However, 
many of these automatic functions can be varied within a wide range. This goes as far as to allow you to 
enter not only the pitch of a staircase (in principle, the number of steps), but also the width of the 
individual steps.



AN OVERVIEW OF ARCON’S DESIGN MODE

Apart from the Construction Mode, the Design Mode is ArCon’s most important mode. In this mode you 
create the interior design of your home by fitting it out with furniture and other items. In Design Mode you 
can also design the exterior finish and the surroundings of your house.

Apart from the upper horizontal toolbar – which is identical with that found in Construction Mode– Design 
Mode has a second horizontal toolbar by means of which you make entries relating to the current window.
The second horizontal toolbar contains buttons with which you can define the type of display and the 
position of the viewer. Additionally, there is just one vertical toolbar. The buttons on this toolbar mainly 
serve the purpose of organizing objects: furniture, for example; i.e. grouping, deleting, rotating, mirroring 
and directing. You can also determine whether any individual lamp should be switched on or off.

When you switch from Construction Mode to Design Mode, an additional special window will be displayed
which is only visible in Design Mode – the Objects and Textures Catalog. This window has a pivotal 
significance in Design Mode. It acts as a catalog, so to speak, from which you can use the mouse to drag 
items of furniture and accessories, even wallpaper textures, into your home (drag and drop technique). 
Because of its pivotal significance, a separate chapter has been devoted to the Objects and Textures 
Catalog !



WORKING IN DESIGN MODE

The four main tasks you can fulfill in Design Mode are

1. Loading Objects

2. Deleting Objects

3. Positioning Objects and

4. Changing the size and appearance of objects 

In addition to these four tasks, you can also wallpaper rooms, change the floor or ceiling materials and 
also the material on the house exterior. Finally, it is also possible in Design Mode to view your apartment 
or house from various standpoints or even to walk through it. It is, of course, also possible to save the 
current view of your home to the hard disk and to print it out.



LOADING OBJECTS

After having drawn your floor plan and inserted doors, windows and other constructional elements in 
Construction Mode , you can begin to furnish your home. To do this, you will need to load the various 
furnishing items. There are basically two methods available for Loading objects    or Loading object groups
:

· Loading from the Objects and Textures Catalog using drag and drop

· Loading via the Furnishings menu – Load object or Load group. 

After having loaded an object or group in the manner described. this must then be placed in your plan. 
How this is done depends on the view type.



PLACING OBJECTS

ArCon has three different view types in Design Mode: the floor plan view, the plan view and the 
perspective view. Just as the display of height is different in each of these views, so is also the input of 
the height of an object when placing it in these three views.

It is not possible to directly determine the height in the floor plan view. Thus, if you place an object in this 
view, you simply enter the horizontal and vertical position of the object, ArCon will determine the height for
you.

In the plan view and the perspective view you can enter the height yourself. In contrast to the plan view, in
which, apart from the object itself, you see the mouse pointer as a cross-wire, a “3D mouse pointer” 
appears when placing objects in the plan view and the perspective view. 

The cross-wire in the plan view and the 3D-mouse pointer in the plan view and the perspective view are 
placeholders for the actual object to be loaded. Only when you release the mouse button after a drag and 
drop operation will you see the actual object. 



HEIGHT INPUT

When you drag an object into the current view using drag and drop, the operation in the plan view is 
relatively simple. If you release the left mouse button, the object will “land” at the position where the 
cross-wires is currently located. You determine the height in the plan view and the perspective view using 
the right mouse button while you are still holding down the left mouse button. Moving the mouse up or 
down in the plan view while holding down the right mouse button will alter the height of the object, i.e., in 
the direction of the ceiling or floor. In the perspective view, you can decide for yourself what will happen 
when you press the right mouse button during a drag and drop operation – i.e., whether the mouse 
pointer moves “away from you”, i.e., into the screen, or whether it moves to the back while remaining at 
the same height or remains at the same depth while moving up or down. You make these Settings in a 
dialog box accessed via Program – General... in the Options menu .

At this point, instead of confusing you with further explanations, try it out for yourself on the screen. It may
take a few minutes, but sooner or later it will go “click” and you’ll be using the 3-D mouse as easily as the 
normal mouse.



DROPPING FURNISHING ITEMS

After having positioned a furnishing item in your plan using the drag and drop method described in the 
previous section, release the left mouse button. What happens next you can best see in the perspective 
view: depending on the object you have loaded, it will either fall to the floor or fly upwards or it remains in 
the position in which you released it. Objects such as tables, chairs and cups fall downwards, lamps 
intended for ceiling attachment “fall” upwards and objects you would normally fix to the wall, such as 
pictures, washbasins, etc. remain in the position in which they were loaded. This behavior is, by the way, 
the same in all three views, even if you don’t see it in the plan view and only to a certain degree in the top
view. 

As you are not able to define the height in the plan view, ArCon does this for you in accordance with the 
following rules:

· Objects which fall downwards are loaded such that they are positioned just below the ceiling of the 
current story when you release the mouse button. In other words, they fall onto whatever you can see 
in your plan view. For examples, if you load a cup and position it above a table, then it will land on the 
table in the plan view.

· Objects which “fall” upwards are loaded such that they are positioned just above the floor of the 
current story and then land under the object immediately above them. If, for example, you load a 
ceiling lamp that will fit under a table in a position where a table is situated, then it will land under the 
table when you release the mouse button. 

· Objects which “float” will be positioned at half the height of the current story.



MOVING OBJECTS THAT HAVE ALREADY BEEN LOADED

Moving objects that have already been loaded is almost identical to moving new objects loaded using 
drag and drop. If you wish to move an object, click on it, but do not release the left mouse button. From 
this point onwards, the object behaves exactly as if you had loaded it using drag and drop. The only 
difference is that you don’t move the cross-wire or the 3D mouse pointer as placeholder for the object, but
the object itself. Otherwise the procedure is identical to that described in the previous section.



SELECTING OBJECTS

If you briefly click on an object, i.e. you immediately release the left mouse button again, this object will be
selected. Selected objects in the plan view are marked using a rectangle, in the top view and the 
perspective view by means of a three-dimensional frame. In the top view, you will only see the top edges 
of the frame.

You can select more than one object at a time by clicking on further objects whilst holding down the Shift 
key. 

If you have selected one or more objects, you can perform various operations with these selected objects:

You can rotate the object using the buttons  , delete it using the button 

    or by pressing the Del key.
If you have selected more than one object, you can align the selected objects to one another using the 
buttons     or group them together using the button 

 .
If at least one of the selected objects is a lamp, you can switch the lamp on and off using the button  . 

By the way, it is also possible to move more than one object at a time by selecting all objects as 
described, but not releasing the mouse button after selecting the last object. If you now move the mouse, 
all selected objects will move together. If you now release the left mouse button again, the objects will fall 
in turn upwards or downwards. 



THE VARIOUS VIEWS IN DESIGN MODE

In Design Mode, every window of your plan can be displayed in plan view, top view or perspective view. 
The three buttons  , 

 and 
, which are to be found at the far left of the second horizontal toolbar, are provided for this purpose . 

For the top view and the perspective view you can also determine the quality of the display required. This 
is achieved using the option switch  .

The various views not only influence the quality of the display, but also the speed. The  variety is the 
most abstract, but also the fastest; the 

 variety is the best, but also the slowest.



WALKING AROUND THE PLAN AND VIEWING IT FROM ALL SIDES
If you are in the perspective view, the  button will appear in the second horizontal toolbar . When you 
click on this button, you will be able to walk through your home. To do this, position the mouse pointer in 
the view and steer your way through your home while holding down the left mouse button – the walking 
direction depends on the position of the mouse in the view.

A walkabout in the plan view or top view is neither possible nor practical. In both of these views you have 
the possibility, as also in the perspective view, to change the observation position using the  button. In 
contrast to all other buttons in ArCon, the position on the button on which you click is important in this 
case. For example, if you click at the left, you will move left in the plan view and in the top view – the view 
itself will shift correspondingly to the right. In the perspective view you will turn to the left going around 
your view. The view therefore appears to be turning to the right. The same applies when you click on the 
right side of the button 

. Clicking on the upper or lower part of the button in the plan view and the top view causes the view to 
shift up or down. In the perspective view, it results in the observer moving up or down. 

Note: With the  button you determine the position of the viewer and not the position of the design. But 
when you move around an object to the left, for example, the object will appear to move around to the 
right. It has become apparent that this exchange of right and left is difficult to understand for some users. 
For this reason, it is possible to swap these functions using the Program – Program settings... dialog 
box in the Options menu.



  
 ELEVATOR RIDES

If you have selected the top view or the perspective view in the current window, the buttons  and 

 will appear in the second horizontal toolbar. With these buttons you have the possibility to travel from 
one floor to another. In the perspective view you even have the possibility to animate your “elevator ride” 
instead of moving in jerks. This is done by holding down the Ctrl key while clicking on the buttons 

 and 
.



FOR USERS IN A HURRY: MMX
And last, but not least, at the far right of the second horizontal toolbar the  button will appear under 
certain conditions . To see this button, you must start ArCon on a Pentium computer with the MMX-
extension . If this button is pressed and ArCon is operating in High Color mode , 3D images, i.e., the top 
view and the perspective view, will be computed using MMX commands. This will result in a considerable 
increase in display speed. If the button is not pressed, calculations will be performed as if no MMX 
processor were present. 

Note: ArCon uses MMX commands only for images in High Color mode ; for images in True Color mode 
the “normal” Pentium commands will be used. 



FIXED PROGRAM SETTINGS

Basic setting for ArCon which are used only at the start of the program are defined in the dialog box Fixed
program settings. This can be found under Program – Program settings... in the Options menu As 
any changes made in this dialog box only take effect when the program is next started, provision has 
been made for making the required settings when starting ArCon by pressing the Ctrl key during program 
start.

For calculating a 3D view, each dot on the screen (also called a pixel) requires a certain amount of 
memory.. The amount required depends on the screen resolution and the color depth of each pixel as set 
in the Windows operating system and used in ArCon.

If the memory required for this exceeds the amount of memory installed in your computer, Windows will 
swap the memory to the hard disk - assuming that you have installed virtual memory in your Windows 
system. As this considerably slows down the 3D display, you can make the following adjustments to the 
settings in ArCon in order to minimize the amount of memory required.

You will find explanations on the individual areas of the dialog box in the following Help pages. Click on 
the  button in the button bar of the Help window to obtain the required information.



FIXED PROGRAM SETTINGS: BUFFER MEMORY FOR 3D DISPLAYS

Here you can determine the amount of memory ArCon should allocate for 3D displays. If you select the 
option for the whole Monitor, ArCon automatically defines and allocates the amount of memory that 
would be required for a full-screen 3D display. If you enter the memory allocation as an absolute value, it 
is possible that ArCon’s program window will then no longer be displayed in full-screen mode.

If you limit the size of the buffer by choosing the second alternative, you can prevent the continuous 
swapping of data to the hard disk, therefore increasing the speed at which ArCon runs, especially in the 
case of computers with less than 16 Mbytes of memory. 



FIXED PROGRAM SETTINGS: 3D PIXEL SIZE

Here you can change the size of a 3D pixel to reduce the amount of memory used, thus allowing you to 
work even with less memory.

THE OPTION ONE PIXEL

If you select this option, one 3D pixel in the memory will represent one pixel on the screen. This will 
provide you with an optimal display, but the memory requirements are relatively large.

The setting One Pixel is the default setting and should be changed only if problems with performance are
observed.

THE OPTION 2 X 2 PIXELS

After selecting this option, one 3D pixel in the memory will represent 4 pixels on the screen.. Working with
2 x 2 pixels has one major advantage: as only one quarter of the pixels needs to be calculated for a 
scene, this takes place considerably faster and the display is therefore correspondingly faster.. This is of 
special interest if you a making a presentation using a projector and the projector does not provide a 
particularly high resolution from a distance. 

The 3D display will therefore be somewhat coarse, depending on the screen resolution, but the memory 
requirements are reduced by a factor of 4.

THE OPTION 4 X 4 PIXELS

If you select this option, one 3D pixel in the memory will represent 16 pixels on the screen, displayed as a
block. The 3D display will thus be even coarser, however, similarly to the previous example, the memory 
requirement is reduced by a factor of 16.



FIXED PROGRAM SETTINGS: COLOR DEPTH OF A 3D PIXEL

Just as for the pixel size adjustment, setting the color depth of a 3D pixel also has a considerable 
influence on the memory requirements for displaying a perspective view. The following options are 
available for this.

THE OPTION HIGH COLOR (= 8 BYTES PER PIXEL)
With this option, ca. 32,000 colors are available for the 3D display. Of course, this is only the case if you 
have also selected High Color or True Color as the color depth in the Windows operating system. 

If your computer is capable of MMX , High Color-3D display will be output using MMX commends, i.e., 
speeded up. 

THE OPTION TRUE COLOR (= 12 BYTES PER PIXEL)
When you select the option True Color, ca. 16 million colors are available for the 3D display. As in the 
previous example, this assumes that you have selected True Color as the color depth in the Windows 
operating system. If this is not the case, ArCon will accept your selection, but the color resolution will not 
change. 

However – with one exception – it can be useful to select the option True Color, even if your monitor is 
only capable of less– and that is if you wish to produce high-quality images for printing out or for transfer 
to another computer. ArCon will use the selected setting for saving and printing images. You can thus 
avoid the typical “jagged” color renderings of High Color on your printer, for example. However, you 
should switch ArCon back to High Color mode after using this special output facility as this provides a 
much faster display output. This applies in particular to MMX computers ; as this speeds up the display in 
High Color mode, but not in True Color. 

With the screen resolution you have selected in the Windows operating system and the selected color 
depth, it is now simple a matter for you to calculate the memory requirements yourself. Remember that 
ca. 20% of the screen is occupied by the menu and toolbars. The approximate memory requirement at a 
resolution of 1024x768 and True Color mode is therefore 7.4 MB, whereas only about 5 MB are 
necessary in High Color mode.



FIXED PROGRAM SETTINGS: TEXTURES

Settings are made in this area to establish the way textures are managed internally. For this purpose, 
data should be entered for the two items shown below in accordance with your hardware.

THE OPTION PREGENERATED SIZES (MIPMAPS)
If you have activated this control field, the textures will be stored internally in various resolution when 
loading. When textures are shown in a 3D view, the most suitable resolution will then be selected. Apart 
from this optical improvement, using this option means that more time is needed for computation of the 
various resolutions on loading the textures, and that the memory requirement for textures is about 33% 
greater than is the case when mipmaps are not used.

BUFFER SIZE FOR TEXTURES

All textures that you load are placed into a buffer memory, regardless of whether or not they are currently 
being used. They will only be deleted from the buffer if the buffer is full and other textures are loaded in 
addition. This has the advantage that you have much quicker access to frequently used textures. The 
value given here in Kbytes represents the size of the buffer memory for textures. You should set this value
according to the amount of RAM memory in your computer.

The maximum amount of memory required for a texture is about 60 kB without and 90 kB with the use of 
mipmaps.

Incidentally, all textures currently being used as well as the textures still in the buffer memory can be 
displayed in the catalog    by clicking on the  button. 



FIXED PROGRAM SETTINGS: PATH FOR OBJECTS

The path statement refers to the directory in which ArCon will search for its objects, i.e., all furnishings. 
This information is set up automatically by ArCon on installation of the program and normally requires no 
change to be made. If you need to change the path at some future time, you can do this by entering the 
information directly into this field via the keyboard or by using the Browse... button in a standard dialog 
box.

If space is limited on your hard disk, it is recommended that the files be copied onto a compressed drive. 
Of course in this case you will have to make the corresponding change to the path information.



FIXED PROGRAM SETTINGS: PATH FOR TEXTURES

The program will search in this directory for the textures you use in ArCon. This information is also set up 
automatically and correctly by the installation program. If, however, you need to change the path, you can 
also do this by entering the information directly into this field or by using the Browse... button.

The above notes for objects also apply to textures, as these are usually well suited to compression.

When you have made the required changes, click on OK to record the changes and quit the dialog.

BASICS

You access the relevant dialog box by choosing Program – General... from the Options menu. The 
settings you make here mainly serve the purpose of optimizing ArCon’s operating speed with and 
handling of 3D views. 

These settings are divided into the various areas as described in the following.

LIMIT THE NUMBER OF POLYGONS ON WALKABOUTS 
If the speed provided by your computer on walkabouts is unacceptable, you have the possibility to 
manually reduce the number of polygons displayed. Depending on the project, the number of polygons 
can amount to several hundred thousand. To limit this number, select limit to and enter a number to suit 
the hardware you are using. In this way it is possible to walk around your project at a brisk speed whilst 
obtaining a tolerable screen display. Enter a value of 3000, for example.

DISPLAY OF MOVING IMAGE ELEMENTS

Motion in a 3D view using the View button and placing of objects may be somewhat slower on your 
computer. By making appropriate settings in this area, you can increase the speed by using simpler 
screen representations..

AS WIRE MODEL

After clicking on the View button, the type of 3D view changes to a wire model representation during a 
walkabout (see also  ).

WITHOUT TEXTURE

During a walkabout, surfaces in your project will be displayed filled with an appropriate solid color, rather 
than with textures (see also  ).

TEXTURED, AVERAGE QUALITY

This option displays your project during motion with all textures and colors assigned to the objects. 
Textured walls are, however, shown without any additional color bleeds.



For non-MMX computers , this setting is the optimal compromise between quality and speed (see also
 ).

AS CURRENT DISPLAY

If you have selected this option, the display type does not change during motion, regardless of the display
type you have chosen for your 3D view.

ACTUALIZE ILLUMINATION ON MOVING LAMPS

Irrespective of the options described above, the possibility exists to deactivate updating the display of 
illumination during the movement of lamps that are switched on, as this is very demanding on computer 
power. In contrast to “normal” objects, not only must the object be moved, but the entire scene must be 
continuously reconstructed. The lamps are therefore not switched off, but the display is not quite in 
accordance with reality at the time of movement. When movement is interrupted, the illumination is 
automatically computed again and redisplayed.

VIEW BUTTON, 3D INPUT

Here you can adapt the function of the View button and of the right mouse button in the 3D view to your 
own requirements using the options described in the following.

THE VIEW BUTTON

Using the View button, either the viewer rotates around the building or you can rotate the building itself. 
Choose the required option. You can change the way in which this works by activating the option swap 
left and right. This means that if you click on the left arrow of the View button, the viewer will turn to the 
right. You should adapt this function to suit your own personal taste.

MOVEMENT WHILE HOLDING DOWN THE RIGHT MOUSE BUTTON

The options described provide a control of movements executed while holding down the right mouse 
button. These can be individually adapted to optimize operation of the software.

“Into” the screen

If you have selected this option, the object that you are presently manipulating while holding down the 
right mouse button will always move into the screen as seen from your position. This happens regardless 
of whether you are viewing your house from above or from the front.

To the “back” (height unchanged)

This option also depends on the perspective and, while holding down the right mouse button, moves the 



selected object to a fixed height above the floor of your building.

If, for example, you view your house from above in the 3D perspective and move an object while holding 
down the right mouse button, this setting may not meet with your intuitive idea of how the operation 
should appear. If this is the case, we recommend you use the option automatic switching between 
“back” and “down” (see below).

“Downwards”

The option to the “back” (height unchanged) described above leads to strange effects if you view your 
scene in the 3D perspective almost vertically from above. If you then move the mouse upwards – that is, 
away from yourself –the object will not follow your mouse movements, but will move towards the floor. You
must hold down the right mouse button to make the object move upwards on the screen. 

If you have selected the radio button “downwards”, this behavior is reversed. This means that when you 
move the mouse upwards without holding down the right mouse button, the object will move up the 
screen. This is, however, only the case if you are looking almost vertically from above. If you press the 
right mouse button and drag the mouse upwards, the object will move into the screen. 

Both of these options only make sense when used at certain angles. The following option exists for this 
reason alone:

Switch automatically between “back” and “down” ...

Using this setting, you can combine the options to the “back” and “up” and define an angle at which 
switching between these two options is to take place. In this way you can circumvent the effect described 
under the option to the “back” and avoid the need for manual shifting.



FUNCTIONS ON THE HORIZONTAL TOOLBAR I
In this section, the buttons on the horizontal toolbar and the functions associated with these are 
described. Some of the buttons shown here may not be available, depending on the mode you are 
currently working in. In this case they will be displayed grayed out.

The group of six at the left with the buttons  , 

 , 
 , 
 , 
    and 
    is used for project management and for working with views.

By clicking with the left mouse button on  you create a new project. If you click the button with the right 
mouse button, a dialog box will appear with the corresponding project options.

Clicking on  opens a standard dialog box by means of which you can load an existing project. 
By clicking with the left mouse button on  you will save the current project. If you have not yet supplied 
a name for this, a standard dialog box will open to let you do this. A right mouse click on this button opens
a dialog box for the saving options. You will find more information on these buttons in the sections 
Loading projects    and Saving projects .

By clicking with the left mouse button on  the current view or the current plan will be printed on your 
default Windows printer using the printer options accessed by clicking the right mouse button. You will find
a detailed description of these functions in the section Printing .

By clicking on  you can save the current view as a bitmap or Windows metafile. You are presented with 
the corresponding options in a dialog box by clicking this button with the right mouse button. For further 
details see the section Saving views .

By clicking with the left mouse button on  you can create a further window with a new view. The 
available options are accessed by clicking on this button with the right mouse button. You will find a 
detailed description in the section Creating new views .



FUNCTIONS ON THE HORIZONTAL TOOLBAR II

The following button standing on its own  or 

    plays a pivotal role in ArCon, as it switches between the Construction Mode    and the Design 
Mode . An exact description of these two modes can be found in the relevant chapters..



FUNCTIONS ON THE HORIZONTAL TOOLBAR III

The next group of two buttons, consisting of     and 

    is concerned with displaying the current view. For example, the button 
    corresponds with the Show all command in the View menu and the button 
    corresponds with Enlarge or Reduce in the View menu. You can access the dialog box with the 

relevant option by clicking with the right mouse button on the last button. You will find a detailed 
description of these options and of the zoom function in general in the section Zooming .



FUNCTIONS ON THE HORIZONTAL TOOLBAR IV

The following group of four buttons consists of the buttons  , 

 , 
    and 
    and provides a help function for construction.

For example, using the buttons     it is possible to shift the origin, the grid or the origin and the grid 
together, depending on your selection. You will find a detailed description of these functions in the section 
Setting coordinates and grid origin . 

The rule can be switched off by clicking with the left mouse button on . If you click on this symbol with 
the right mouse button, you will be presented with a dialog box with the relevant options. You will find a 
description of the rule in the section The rule .

The buttons  and 
 switch the grid or the guides in the plan view on and off.



FUNCTIONS ON THE HORIZONTAL TOOLBAR V
The final group of five buttons  , 

 , 
 , 
    and 
 consist purely of on/off switches which change the type of display in the views. The 
 button switches wall shading on and off, 
 is for switching the furnishings in and out, 
 for switching all of the roofs present in and out, 
 for switching the labeling on and off and 
 for switching dimensions on and off. These switches affect all active views.

The next element on the toolbar is a drop-down list, from which you can select the current story. 

Click on this button with the left mouse button to obtain a list of all available stories. You can then select a 
story from this list.



FUNCTIONS ON THE HORIZONTAL TOOLBAR VI

To the far right of the horizontal toolbar you will find one or two buttons, the Help button     and the 
button for switching the Catalog on and off 

 , which only appears in Design Mode, however. If you click on the Help button with the left mouse 
button, the mouse pointer will change. You cab then click on any visible element in the screen with this 
mouse pointer and get context-sensitive Help on the subject. 

By clicking on the button for the Catalog  in Design Mode, you can switch the display of the catalog on 
and off. 



 CREATING A NEW PROJECT
To create a new project, either choose New from the File menu or click on the  button. The current 
project options will be used for this new project. Normally when creating a new project the dialog box will 
appear in which you enter the data for the first story. 

However, you can prevent this by holding down the Ctrl key when clicking on  . 

PROJECT OPTIONS (DIALOG BOX)
You access the Project options dialog box by clicking with the right mouse button on  or by choosing 
Project options.... from the File menu.

ArCon uses the data entered here when creating the new project. However, these data do not have to be 
established right from the start, as you can make adjustments to meet your requirements as you work. 
You should, however, observe the notes given in the following.
Descriptions of the individual items in the dialog box can be found in the following Help pages. For the 
relevant information, click on  in the upper part of the Help toolbar.



PROJECT OPTIONS: PAGE FORMAT

Here you can select the size of the paper on which you wish to draw and print your plans. The formats 
available are A4 Portrait, A4 Landscape, A3 Portrait, A3 Landscape, printer-specific formats and also 
other, a user -defined Format. The printer-specific formats depend, of course, on the type of printer you 
are using.

Apart from providing the settings for printer output, the Page setup selected also affects the maximum 
size of your plan. For this reason, you should establish the Page setup and the Scale to be applied as far 
as possible at the start of your project. At a later stage you could, for example, display your complete plan
on one page again by reducing the page size from A3 to A4, changing the scale and moving the page.

Note that when using an option which exceeds the maximum paper size supported by your printer, the 
printout will be split over several pages. You will find further information on this in the description of Printer
output .



PROJECT OPTIONS: BACKGROUND FOR 3D VIEWS

Here you define the background color that you would like to use in the perspective view or in the top view.
This information is entered separately for day and for night. Click on the corresponding button define... 
and in the standard dialog box that appears choose the color you require. Here you also have the 
possibility to define your own color. You will find further information on defining colors in your Windows 95 
User’s Guide.

The background color used here must not necessarily be identical to that used for printing a view. This 
can be set individually in the Print options .



PROJECT OPTIONS: SCALE

The scale selected here will be used for outputting your plans to the printer and additionally affects the 
maximum size of your plan.

Apart from the scales generally used in the construction industry, which can be selected simply by 
clicking, you also have the option of selecting any scale between 1:1 and 1:250 for your project by clicking
on other scale.



PROJECT OPTIONS: UNITS OF MEASUREMENT

All measurement information you enter for your project in ArCon uses the measurement units defined 
here. The available units are millimeters (mm), centimeters (cm) and meters (m).

After making the required changes, click on OK. By clicking the button make default, the current settings 
in the dialog box will be used as default values for all future projects. 



 LOADING PROJECTS
Projects are loaded in ArCon via a standard Windows dialog box. This is accessed by clicking on the  
button or by choosing Open in the File menu. Alternatively, you can also use the keyboard shortcut 
Ctrl+O. The standard file extension for ArCon projects is .acp, and for the corresponding backup files
.acb. ArCon supports long filenames when entering a project description, i.e., up to 256 characters can be
entered for the name. If you call up a standard Windows dialog box once again for opening or saving a 
project in ArCon, the last-used path will be selected for the operation.

During loading a progress bar is visible in the status line showing the percentage of the file loaded. and 
the information that has so far been read. This information can be very useful, especially in the case of 
large projects, as the loading process can be slowed down through recalculations performed with textures
and can be interrupted by pressing the Esc key. If the loading process is interrupted, the dialog box 
described in the following section will appear.

INTERRUPTED LOADING OF A PROJECT

If you have followed the loading process in the status line and know which information has already been 
loaded, you can determine the further course of the loading operation in this dialog box, which you access
by pressing the Esc key.

THE BUTTON DISCARD REST

The loading operation will be interrupted immediately and the information already loaded will be 
displayed.

THE BUTTON DO NOT LOAD THIS PART

The part of the project shown in the status line that was being loaded at the time of interruption will be 
omitted and the loading operation continued.

THE BUTTON CONTINUE LOADING

The interrupted loading operation will be resumed and the complete project loaded.

THE BUTTON DISCARD EVERYTHING

The loading operation will be aborted and all data discarded, i.e., the condition existing before the load 
operation will be restored.



 SAVING PROJECT
Projects are saved in ArCon in a similar manner to loading, using a standard Windows dialog box. You 
access this by clicking on the  button or by choosing Save as... in the File menu. If you have already 
given your project a name, (in other words, you have already saved it once before), this dialog box will 
only appear if you select the menu command. Clicking on 

 in this case would initiate the menu command File – Save. Alternatively, you can also use the 
keyboard shortcut Ctrl+S. The standard file extension for ArCon projects is .acp, and for the 
corresponding backup files .acb. ArCon supports long filenames when entering a project description, i.e., 
up to 256 characters can be entered for the name. If you call up a standard Windows dialog box once 
again for opening or saving a project in ArCon, the last-used path will be selected for the operation.

ArCon also saves all program and windows information applying to your project, for example, the view 
last displayed and the screen resolution at the time of saving.



THE SAVE DIALOG BOX

You access this dialog box by clicking with the right mouse button on or by choosing Save....from the 
Options – Program menu.

You will normally save your projects by clicking on the  button or by choosing Save or Save as... in the 
File menu. ArCon also offers you the possibility to save your project automatically at fixed time intervals.
Descriptions of the individual items in the dialog box can be found in the following Help pages. For the 
relevant information, click on  in the upper part of the Help toolbar.



THE SAVE DIALOG BOX: ON PROGRAM EXIT

This allows you to set how, if at all, your project is to be saved on closing, exiting ArCon or opening a new 
project. The following options are available for this purpose.

The option Always without prompting

If you choose this option, ArCon saves your current project automatically whenever you close the file, 
open another project or exit from the program.

The option Prompt for save

If you choose this option, ArCon will always ask if you would like to save your project whenever you close 
the file, open another project or exit from the program.

The option Do not save

If you choose this option, ArCon will execute the menu commands File – Close... , File – Open... and 
File – Exit.. or the corresponding shortcuts and buttons without saving the current project or displaying a 
warning message.

This option must be used with caution, as in this case the most recent changes to your current project 
could be lost by mistake.



THE SAVE DIALOG BOX: AUTOMATIC SAVE

To increase the level of data security, you have the possibility to define time intervals at which ArCon 
should automatically save temporary a copy of your project. This temporary copy is made independently 
of any projects you have already saved and is deleted when ArCon terminates normally.

We recommend that you activate this option, as the automatic saving of a backup copy takes place very 
quickly and you will hardly notice it while working. 

However, if ArCon has not terminated normally and automatic saving was active, a dialog box will appear 
the next time you run ArCon. You then have the possibility of restoring your lost project.

Should you see this dialog box after starting ArCon and you click on Yes, then the next step is to save the
loaded project under a new name. The reason is as follows: if you do not save this project under a new 
name and ArCon terminates again unexpectedly, the project you are currently working on will be 
overwritten by the new automatic temporary copy; which is not what is intended in this special case. 



THE SAVE DIALOG BOX: MAKE BACKUP COPY

If you have selected this option, ArCon creates a copy of the old version of an existing project on saving. 
The file is saved with the file extension *.acb (whereby “b” stands for backup). If after saving your project 
you wish you hadn’t made the changes you did, you can reinstate the previous version by loading the acb
file. You are probably familiar with this system from using word processing programs.

If you load an acb file, i.e., a backup file, and continue to work on it, you should save it under a new 
name. If you save it using the old name, you will overwrite the backup file with your project file, which has 
the same name, thus effectively losing your backup.



CLOSING PROJECTS

When you exit a project by choosing Exit from the File menu, you may be asked whether you wish to save
the current project or not. Whether or not this question is asked depends on the Options,    you have set 
for saving operations.



 PRINTING
ArCon provides the possibility to print floor plans and views directly on a printer using the  button. Plans
are printed at the scale you have selected, 3D views are printed at a definable size.

A particular characteristic of ArCon is that work can be printed at any size, regardless of the paper sizes 
supported by your printer. This is achieved by printing the work over several pages and then arranging the
individual pages as required and joining them together. To help you do this, the pages are printed with a 
slight overlap and with small marks on the edges to be joined. Additionally, adjoining edges are numbered
consecutively, whereby you simply need to lay the pages together so that the same numbers lie on top of 
one another. Using this procedure, it is possible to print an A0 drawing on your A4 printer, or to produce 
graphics of any size.

As output can be made to any installed Windows device and modified under Windows 95 using the 
command sequence Start - Settings - Printer, it is also possible to output an floor plan to a plotter. To 
make full use of this function in ArCon, you should always check and, if necessary, modify the print 
options as described in the following section.



DIALOG BOX PRINT OPTIONS

You access this dialog box by clicking with the right mouse button on  or by choosing Program – 
Printing... in the Options menu. Here you specify the quality and size at which you would like to print 
your projects.

PRINT

Here you define what you would like to print. Select the option Floor plan to obtain a printout of the floor 
plan regardless of which view you are presently in. The option Current Window provides a printout of the
currently active window. This can apply both to the floor plan and to 3D views.

If you are working in several windows, you should be sure to check that the “right” window is selected 
before clicking on the  button..

3D PRINTOUT

Settings made here apply to printing of 3D views. The size of floor plans is determined by the scale you 
have selected..

SIZE

With the option as Window , the size of your printout will match the size of the window you are printing. 
By entering 1.00 in the following field, you can adjust your view to fit exactly on one page. Of course, you 
can also spread your printout over several pages, but note that the height of the graphic will be adjusted 
accordingly, and a correspondingly greater number of pages may be needed.

BACKGROUND COLOR

Here you have the choice of using the background color used for your project also for printing by 
choosing the option as 3D views or whether the background color should remain white.

The option white can on the one hand reduce costs, and on the other hand improve the print quality, 
particularly when outputting to a monochrome printer.

RESOLUTION

Here you set the resolution at which your printer is to work. If you select a lower resolution than the 
maximum resolution of your printer, the printing operation will be speeded up, however the output quality 
will be reduced. On the other hand, using a higher resolution than the maximum supported by your printer
will naturally not improve the quality of output. If you choose the option use printer’s, the maximum 
resolution supported by your printer will automatically be used.



 SAVING VIEWS
In ArCon you have the possibility to save the view, i.e. the contents of the current window, as a bitmap or -
in the case of floor plans - as a Windows metafile. Bitmap files can be optimized during saving by using 
up to 16 times oversampling and an edge smoothing filter. With the help of this function you can obtain 
amazingly good results suitable for use for presentation purposes.

In order to obtain the maximum possible benefit from this feature, before saving a view, you should first 
make the settings as described in the following section according to your requirements. Once you have 
done this, you can save your view to the hard disk simply by clicking the left mouse button on the  after 
entering the required file name and directory for the graphics file in the standard dialog box that appears.

In addition to the possibilities for saving graphic images described above, you can also use the ray tracer 
to generate the image for saving. After having selected the appropriate option (see below), a raytracing 
computation is performed during the save operation. Using this option, you can produce raytracing 
images of your scene of almost limitless resolution.



DIALOG BOX SAVE VIEW

You access this dialog box by clicking with the right mouse button on  or by choosing Save graphic... 
in the Options – Program menu.

FLOOR PLANS (2D VIEWS)
Here you can select the file format to be used for saving a 2D view, i.e., the view in Construction Mode or 
the plan view     in Design Mode. This selection is available only for plan views, as 3D views can be 
saved only as bitmaps.

THE OPTION AS BMP-FILE (BITMAP)
If you choose to save your file as a bitmap, the file you create will consists purely of a pixel-for-pixel 
representation of your window which you can subsequently edit in a drawing program. The advantage of 
this method is that this file format can be read by practically any drawing program. Depending on the 
screen resolution at which they were saved, these files are generally larger than Windows metafiles and 
are subject to large quality losses on scaling.

THE OPTION AS WMF FILE (WINDOWS METAFILE)
If you choose to save your floor plan as a Windows metafile, instead of generating an image of your 
screen as for a bitmap, vector information will be saved describing the lines, points, etc. which make up 
your plan. This makes it possible to rescale the plan to produce a different sized graphic without having to
suffer a loss in quality. Additionally, the file size, which depends on the number of elements in your plan, 
can usually be expected to be smaller than that of a bitmap.

Descriptions of the individual items in the dialog box can be found in the following Help pages. For the 
relevant information, click on  in the upper part of the Help toolbar.



DIALOG BOX SAVE VIEW: 3D VIEWS

Information entered in this area applies only if you wish to save a top view     or a perspective view 

 . ArCon’s current window must therefore contain one of these two view types. 
Make adjustments here to the size and appearance of the 3D view you wish to save. Several additional 
options are available for improving the optical presentation of your graphic.



DIALOG BOX SAVE VIEW: DIMENSIONS

In this area, you have the possibility to specify the size of the graphic when saving a 3D view. By 
choosing the option as view, the current size of the view is used to generate the bitmap. This will produce
the best size for viewing the graphic. Of course, it is also possible to select any other size. If you choose 
the option custom, border ratio as view, changing either the width or the height will alter the other 
component accordingly. By selecting this option, an image will be saved that corresponds exactly to the 
current view, however the resolution may be higher or lower. Finally, it is possible with the option custom 
to freely select the width and height of the image to be saved. To prevent the image from distorting, the 
saved version may then contain more of the scene than is currently visible in the window if the border 
ratio entered does not correspond with that of the current view. 



DIALOG BOX SAVE VIEW: COLOR PALETTE

In this area, you specify the color depth in which a graphic file is to be saved. You have the two options 
Color index (256 colors) and TrueColor (16.7 million colors). Your decision as to the option to select 
should be based on the intended use of the saved file. Images saved using the Color index option are 
very suitable for conversion into other graphic file formats, for example for transmission via the Internet or 
for inclusion in WWW pages. You should use the option TrueColor if you require your image to be saved 
with the ultimate quality, as the space requirement on the hard disk is three times that for color index 
images. When saving with Color index, the optimal colors     function will be performed automatically. 
This function causes ArCon to automatically generate a color table optimized for the current view 
containing 256 colors and to save this together with the image. 

Note: If ArCon itself is operating in High Color mode, only 32.000 different colors will be used, even if 
when saving as a True Color graphic – the disk space required is however identical with that for a True 
Color image (for the expert: the lower bits for the color value are not used). Only when ArCon itself is 
operating in True Color mode are all possible color values used when saving a graphic file. You should 
take this fact into consideration if you wish to save really high-quality images. In this case, you should 
start ArCon in True Color   mode   .



DIALOG BOX SAVE VIEW: OVERSAMPLING

Several aids are available to help you improve the quality of your graphic images. One of these is 
oversampling. Using this method, each pixel will have multiple internal representations depending on the 
selected rate and the colors of neighboring points are mixed together. This will result in a smoothing of the
edges and color spreads will be displayed more realistically. For the options provided in this area, choose 
without, 4 times, 9 times or 16 times to establish whether and at what rate oversampling should take 
place.We recommend that you use oversampling together with the Edge filter option described below.

THE EDGE FILTER OPTION

If you have activated this option, ArCon searches for all “visible” edges in your graphic when saving a 
view and attempts to smooth them. As this function has little effect on computing time, we recommend 
you always keep this option active.

We recommend you use the option Edge filter in combination with oversampling.



DIALOG BOX SAVE VIEW: THE OPTION RAY TRACING

If you have activated this option, the image will be additionally processed by the raytracer before saving. 
This will take place using the raytracer’s current settings (accessed by clicking on  with the right mouse
button). 

Note: After activating the option ray tracing, the computing time required to save an image can become 
very great, as a completely new raytracing image is generated on saving. This is particularly the case if 
you have selected a high resolution and, in addition, perhaps 4, or even 16-times oversampling. You 
should always be aware of this when using the ray tracing option.



 GENERATING NEW VIEWS
You generate a new view in ArCon by clicking with the left mouse button on the  button. Alternatively, 
you can choose New view from the Window menu. This view will be generated in accordance with the 
settings described in the following section and displayed in an additional windows. If you wish to work with
several windows, this is possible by choosing Cascade or Tile from the Window menu.



DIALOG BOX NEW VIEW

You access this dialog box by clicking with the right mouse button on the  button or by choosing 
Program - New view from the Options menu. You can then make the following settings to select the 
view type for a new view. 

TYPE OF NEW WINDOW

Here you define the contents of the new window. The option as current window effectively produces a 
copy of the currently active window. You can explicitly define the contents of a window to be newly 
created using the options plan view, top view (color) and perspective view. The window view selected 
here can, of course, be adapted later to suit your requirements 

TYPE OF 3D VIEW

You select the required view type  in this field. The four options available are as wire-frame model, with 
uniform shading, textured (average quality) and textured (high quality), all of which can be later 
adapted . However, if you always work with your one preferred view type, you can save time by defining 
the required settings as default..

ILLUMINATION

In this selection field you can choose between the options Day and Night. These options can also be 
changed at a later time using the button  .



 ZOOMING
ArCon provides you with the possibility to enlarge or reduce a section of your current view. Click with the 
left mouse button on  , to activate the zoom function. After you have enlarged or reduced the size of 
your view, the zoom function will be automatically deactivated, i.e. the button is no longer depressed. If 
you wish to discard the zoom setting (for example, if you have walked up to your house) and see your 
whole project, click on 

. Clicking on this button also has the effect of fitting your project view optimally to the screen, 
regardless of the size.

Enlarging a screen section is always performed by clicking with the left mouse button. Reduction is also 
performed by clicking with the left mouse button while at the same time holding down the Ctrl key. If you 
have entered a fixed enlargement factor, you only need to click with the left mouse button in your current 
view window to zoom. If you haven’t entered a fixed factor, you will need to define a zoom range in your 
view while holding down the left mouse button.

The way you enter this range depends on the settings you made in the Zoom dialog box (see below). 

Note: In the perspective view, the depth is also adjusted on zooming, so that the center point of the 
selected region becomes the new observation point. Accordingly, the depth of what you see in the center 
is the new depth.

Apart from zooming with the  button, you can also use the numeric keypad for zooming and shifting the 
visible section. The key assignments are as follows: 

Key 0 Corresponds with the function Show all

Key 1 Shifts the image section down and left

Key 2 Shifts the image section down

Key 3 Shifts the image section down and right

Key 4 Shifts the image section left

Key 6 Shifts the image section right

Key 7 Shifts the image section up and left

Key 8 Shifts the image section up

Key 9 Shifts the image section up and right

Key + Image section is centrally enlarged

Key - Image section is centrally reduced

Key * Image section is enlarged centrally around the current mouse 



pointer position

Key / Image section is centrally reduced around the current mouse 

pointer position

You can easily remember the key assignments by thinking of the numeric keypad as a “compass” with the
4, 8, 6 and 2 keys showing the principle directions and the numbers 1, 3, 9 and 7 the intermediate 
directions. 

With the settings described in the following section, you can adjust the zoom function to meet your 
individual requirements.



ZOOM DIALOG BOX

You access this dialog box by clicking with the right mouse button on  or by selecting Program – Zoom
factor....from the Options menu.

ENLARGEMENT FACTOR

Here, by selecting the appropriate options, you can adjust the settings for the zoom function. The settings 
made here apply both to enlargement and reduction.

THE OPTION SELECTED (FREE)
With this option you can freely select the section to be enlarged or reduced by clicking on any desired part
of the image and, while holding down the left mouse button, drawing a box around the desired section to 
define the zoom area. When you release the mouse button, the final size of the zoom area is established.

THE OPTION SELECTED (CENTERED)
If you select this option, a zoom box is generated exactly as for the option Selected (free). In contrast to 
this, however, you do not click on two opposite corners of the zoom area, but on the center and one 
additional corner of the area to be zoomed. Compared with the first, the second variation has the 
advantage that you can choose in advance of zooming exactly what is to be in the center of the screen. 
This is particularly important in the perspective view for determining the depth (see above). Which 
variation you decide to use depends on your personal taste. 

THE OPTIONS 1.414, 2.0 AND 4.0
These are predefined zoom factors. You use these simply by clicking with the left mouse button in your 
current view window when the zoom function is active. The view will then be enlarged or, by pressing Ctrl,
reduced by the stated factor.

THE OPTION OTHER

Here you have the opportunity to enter a freely selectable zoom factor. The only limitation to this is that 
the factor must lie in the range 1.00 to 20.00.



WORKING WITH STORIES

In ArCon, you are not only able to model one story of your house, you can also create a complete house. 
From the foundations to the attic. The menu item Stories is provided for this purpose and contains the 
following entries, both in Construction Mode and in Design Mode: 

Before explaining these menu entries in detail, we would like to make a few general comments on stories.
ArCon always works with just one current story. The story that is currently selected can be seen in the 
drop-down list in the upper horizontal toolbar. 

You can make any other story the current story at any time by selecting it from the drop-down list.

Entries you make in Construction Mode    always apply to the current story. So whether you insert 
windows, doors or walls, the corresponding elements will always be inserted in the current story.

In Design Mode, the current story is visible in any case. However, you can also make further stories 
visible. One exception is the top view, where only the current story will be shown



ALL THAT BELONGS TO A STORY

ArCon assigns all entries that you make to a certain story. in Construction Mode, this means all input you 
have made for this particular story. As a reminder: in Construction Mode, all entries you make always 
apply to the current story. These entries also include text, guides and dimensions. Objects that you have 
placed in Design Mode will be assigned to the various stories as follows: objects which are situated within
an enclosed room belong to the story in which the room is also situated. “Within” in this context means 
that the center point of the object is in the room. Objects which are not situated in any room do not belong
to any story. They will therefore not be altered when you alter the various stories and will not be deleted 
when you delete various stories.



DEFINITION OF THE FIRST STORY OF A NEW PROJECT

If you create a new project in ArCon by clicking on the button     or by choosing New from the File 
menu, a dialog box at first appears in which you must enter information on the first story of your project. In
principle, your enter the same information here as would be necessary for any other story. This 
information is described in more detail in the section covering the menu items Stories – New story 
above… and Stories – New story below…. 

In contrast to the dialog box which appears after choosing the menu items mentioned, the dialog box that 
appears when creating a new project does not contain the field Copy elements. The reason is clear: as 
the story you are defining is the only story, you naturally can’t copy elements from other stories. But you 
can define the Height of the Floor. If you wish to start with the cellar, you can enter a value of, for 
example, - 3 m. This information together with the information on the story height provides the height of 
the stories yet to be defined.



INTERDEPENDENCY BETWEEN STORIES

If you are working with several stories in ArCon, the floor levels of the various stories will be set such that 
all stories join together “seamlessly”. For example, if you have defined the ground floor as having a story 
height of 2.80 m, and the upper surface of the floor of the ground floor has an absolute height of 0.0 m, 
then the upper surface of the floor of the second story will be at a height of 2.80 m. There is no way you 
can change this, unless you change the story height or the zero level of the ground floor.

This seamless fitting together of stories has consequences for the input of zero levels and story heights. If
you have defined only one single story, you can define its zero level – i.e., the level of the upper surface of
the finished floor – and the story height independently. Accordingly, it is possible to enter both values in 
the relevant dialog box. 

If you have defined at least one story and you define a further story below all other defined stories, you 
can enter on the one hand the story height for this – the lowest – story, but also the level of the upper 
surface of the finished floor. However, these values are interdependent. If, therefore, you change the 
level, the story height will also change accordingly. You cannot enter the level for any story – apart from 
the lowest story in your plan. Although the value is shown for your information, no direct change is 
possible.

To help you to understand this dependency somewhat better, we recommend that you produce a simple 
plan with several stories and then enter the relevant information for the various stories.



MENU ITEM STORIES/VISIBLE STORIES

When you select this menu item, the following dialog box appears:

The contents of the list in this dialog box naturally depend on the number and types of stories contained in
your project. Our example project has five stories.

You enter information into this dialog box to indicate which stories are to be visible in addition to the 
current story. In the Construction Mode window, the current story is shown normally, all other visible 
stories are shown grayed out. You can, however, snap to elements of the grayed-out stories. In Design 
Mode, the appearance depends on the view type of the window: In the Design Mode plan view, the 
appearance is identical to that in Construction Mode – i.e., all visible stories are shown grayed out, only 
the furnishings of the current story are shown in black. The appearance in the top view is independent of 
the information you provide in the dialog box. Here, only the current story is shown - otherwise you would 
only ever see the upper story. Finally, in the perspective view, all stories are shown equally. Specifically in 
the case of this view, you can use the dialog box to achieve special effects: 

If you select Display the current story, you can display your house “layer for layer” if you make each level 
in the selection list in turn the current level. 

Note: You can use the cursor keys (up, down) on the keyboard to select the stories if you first click in the 
selection list. 

If you select Display all stories in the dialog box, you will be able to admire your entire house in the 
perspective view. The final option, Display the current story <story name> and the selected stories is of 
interest if you only wish to display certain stories of your house. 



MENU ITEMS STORY – NEW STORY ABOVE … 
AND STORY – NEW STORY BELOW …
If you wish to add a further story to your plans, choose one of these two menu items. “Above” in this case 
means above the topmost story and “below” means below the bottom-most story. The dialog box is split 
into two different areas, Story data and Copy element. 

Story data:

In the selection field Description you can enter a description for the new story or select a predefined 
description from the list. This description is used to identify the story to be defined. After closing the dialog
box by clicking on OK, you will find this description in the selection list for the current story in the upper 
horizontal toolbar. 

Note: If you enter a name that has already been assigned, ArCon automatically adds a sequential 
number to differentiate the stories from one another.

You can enter the height of the newly created story and enter information for the individual parts of the 
ceiling for this new story. 

Note: In ArCon, the ceiling and the room below it belong to a story. A story therefore goes from the upper 
surface of the finished floor to the upper surface of the finished floor of the ceiling above. 

CEILING HEIGHT

As the ceiling in ArCon belongs to a story, when defining a new story you must define not only the height 
of the story, but also the heights of the various areas of the ceiling. The required terminology can be found
in the following sketch. Note that the room height is equal to the story height minus the heights of the 
individual ceiling layers. The final data entry item in the Story data is Level of upper floor surface. This 
value is generally grayed out and cannot be changed. This is because it is calculated automatically from 
the sum of the story heights of the stories below.

Hs  = Story height



Hw = Wall height

Hr = Room height

USFF = Upper surface of finished floor

USUC = Upper surface of unfinished ceiling

COPY ELEMENTS

Normally the floor plan of stacked stories is in large parts very similar. To avoid having to enter a 
completely new floor plan for every new story, in this area you can define the parts of an existing story, if 
any, that are to be copied. If you wish to copy elements, then rather than entering nothing in the sub-area
Copy, you enter the story which is to serve as the source for the elements to be copied. For this you use 
the drop-down list. 

In the sub-area Copy you can select the items that are to be copied from this story. You can choose 
between nothing, whole story, floor plan only and floor plan with doors, windows, supports, 
chimney stack, staircases, ceilings, ceiling openings, wall openings, texts, dimensions, guides 
and furnishings. After making the entries are required, close the dialog box by clicking on OK. ArCon will
then generate the new story for you. 



MENU ITEM STORIES – EDIT CURRENT STORY …
Select this menu item if you would like to make changes with regard to the height or the name of a story 
that has already been defined. You can then change the definition of the current story in the same way as 
naming a newly defined story. Additionally, you can change the story height and the height of the 
individual ceiling areas. In principle, the dialog box corresponds with the left half of the dialog box which 
are presented with when defining a new story. By clicking on OK to close the box, the new values will be 
accepted. 

If you have changed the story height, then you still need to decide what is to happen with the stories 
above and below the current story.

Make your selection in the additional dialog box that appears. When you close this dialog box by clicking 
on OK, the final changes will be made to the current story. If you click on Cancel in this dialog box, the 
whole procedure will be canceled, i.e. no changes will be made to the story. 

Note: If you change the story height, ArCon automatically makes certain changes to this story. These are:

· Staircases in the current story are adapted to the new story height. 

· Objects in the current story having the characteristic of “falling upwards” will be shifted upwards by the
same amount as the increase in ceiling height of the current story. 

· All other objects, i.e., those that automatically fall and those that “float”, will move down by the amount 
that the ceiling of the next lower story moves, if it moves. 

· If the ceiling of the next lower story moves, the window of the current story will also be shifted so that 
the parapet height remains constant. 

· Doors will be shifted in an analogous manner. 

· If a window no longer fits in this story after shifting or because the ceiling height of the current story 
has been reduced – in other words, it protrudes upwards – ArCon will ask if this window should be 
deleted or if you would like to continue to use it. If you choose to keep it, you must manually adjust the 
height of the window affected. 

· If because of changes in the current story other stories are changed in their height or position, this 
situation will be dealt with in a similar manner..



MENU ITEM STORIES – DELETE CURRENT STORY …
Just as you are able to add new stories to your plan, you can also delete existing stories again.. If you 
close this dialog box by clicking on OK, the story will be deleted. To avoid deleting a story accidentally, 
ArCon asks once again for confirmation of the delete operation in a separate dialog box. You then have 
the possibility to prevent by clicking on Cancel. If you confirm by clicking on OK, the story will be deleted 
together with all information you have saved for this story (walls, doors, windows and furnishings, also 
texts, guides, etc.). 



WORKING IN CONSTRUCTION MODE
SNAPPING

ArCon provides various aids which simplify your work in the plan views of the Construction Mode and 
Design Mode. The method used is called snapping. With this function, you don’t need to place elements
exactly on the spot where you want them to appear, but you simply move the mouse pointer into a certain 
area around the desired point, which you define yourself, the so-called snap radius.

The aids mentioned above include the grid, the rule and the guides. In addition, it is possible to snap to 
wall axes, wall faces, openings and floor panels as well as intersections and ends. In general, the basic 
rule applies that it is only possible to snap to visible elements or aids. Therefore, if you, for example, 
switch off the guides with the button , snapping to these will no longer be possible - even if you have 
activated Snap to guides in the snapping settings. 

If you wish to freely place an object without changing the snapping settings, you can switch snapping off 
for all elements by pressing the F3 key until setting down the object. Note however that this function only 
remains active while placing the one object and snapping must be switched off again for every further 
object with the F3 key. Therefore, if you wish to freely place a number of items, it is advisable to switch off
snapping permanently in the snapping settings.

If several possible snapping points lie close together, you can switch between these with the key 
combination Ctrl+F before finally placing the object. 



DIALOG BOX SNAPPING

You access this dialog box by clicking with the right mouse button on  or by choosing Snapping from 
the Options – Program menu

ON/OFF

You can permanently deactivate snapping by choosing the option off. In this case, no further input is 
possible in this dialog box and you will be able to freely place all objects and elements on your page. If 
you activate the option on, you can make adjustments to this function using the settings described in the 
following.

RANGE

Here the so-called snap radius is entered. ArCon will attempt within this radius to find a point it can snap 
to. This could be a point on the grid, on the rule or an element within the Snap to range.

As it can frequently happen that several snapping points are situated within the snapping radius, the 
possibility exists to switch between these points using the key combination Ctrl+F.

The size of the snapping radius you enter depends to a large extent on the “elegance” with which you 
operate the mouse. Experience has shown that this depends very much on the person operating ArCon, 
so you should adjust the setting to your personal taste. If the snapping radius is too large, then input of 
the various elements can prove to be rather “laborious”, as you will never hit what you are aiming at. On 
the other hand, if the snapping radius is too small, it can often happen that you are not able to snap to the
point that you wish to snap to because you haven’t quite hit it. It is best if you experiment with various 
settings.

SNAP TO

Here you select the elements to which you would like objects to snap simply by checking the elements for
snapping to. It is basically possible to snap to guides, wall axes, wall faces and openings/floor panels.
In addition, selections can be made in the field Intersections and ends of to snap to all sections and end
points of the stated elements.

If the elements selected are not visible in your plan, then it is not possible to snap to them, even if the 
relevant option has been activated.

If you are working with several stories , then you can snap to all elements of the visible stories. Therefore 
also to elements in stories different from the current story . You can use this function to place walls exactly
above each other in various stories, for example.



 SETTING THE CO-ORDINATE AND GRID ORIGINS
Apart from the guides and the rule, the grid is probably the most important aid to construction. You can 
switch the grid on or off using the  button    and edit the grid characteristics by clicking on the button 
with the right mouse button. When placing objects and constructing elements, the mouse pointer will only 
snap to the grid if the grid is switched on – i.e., visible. Snapping is described in detail in the previous 
section.

Closely associated with the grid is the origin, as all co-ordinates shown in the status line are calculated 
based on this. Thus the origin, just as the grid, will provide you with a very useful aid for constructing and 
equipping your house. With the option switch  you can set either the co-ordinate origin alone, the 
grid origin alone or both the co-ordinate and grid origins together, depending on the selection you make.

The grid origin in this connection means the position of the grid dots in your plan. As the grid repeats 
periodically, there are in principle many possible grid origins. If you wish any one particular point which 
presently does not coincide with a point on the grid to coincide with a point on the grid, use the buttons 
or 

 and position the grid on this point. All grid points will then shift accordingly by +/- one half of the grid 
measurement.



GRID DIALOG BOX

You access this dialog box by clicking with the right mouse button on  or by choosing Grid.... from the 
Options – Program menu.

SPACING

There are five different ways in which you can define the grid spacing. This spacing applies both to the x 
and y values, as it is only possible to define a “square” grid pattern. The first four options provide four 
fixed spacings which are nominal building dimentions and thus in multiples of 12.5 cm. 

The last option allows you to define your own grid spacing, which can lie in the range 1 cm to 10m. In this 
field, you can enter this information directly via the keyboard or increment or decrement the value in steps
by clicking on the arrows to the side with the left mouse button. The units of measurement for spacing 
depend on the units you have entered under Project options .

Note: Upwards of a certain grid point density (depending on the grid point spacing and the current degree
of enlargement) ArCon no longer displays the grid even when it is switched on. This is because the 
situation may arise that so many grid points are displayed that you would “not be able to see the wood for
the trees”.



 THE RULE
In Construction Mode    you have the possibility to enter constructional details with the help of the rule. 
You can only see the rule when the button  is depressed.

You can use the rule on the one hand for measuring, but also for constructing. If the rule is visible, then 
an entry bar appears in the current window at the lower left edge of the window into which you can enter 
values exclusively for the rule.
Before dealing with the individual parts of this entry bar in detail, first a few fundamental words on the use 
of the rule: in principle, the rule functions in a manner similar to a perfectly normal rule. You can use one 
edge of the rule as a rest, turn and shift the rule on the paper however you like, or even lift the rule in 
order to get your “pencil” (the mouse) past the rest edge of the rule. Together with snapping    and the 
tabulators which can be assigned to the rule, the rule provides a clearly understandable, but nonetheless 
powerful tool in ArCon. 

CONSTRUCTION OF THE RULE

The rule basically consists of two areas: one area in which you will find the scale graduations, and a 
second area in which you find the scale inscriptions of the rule. Both areas behave differently when you 
click on them. The area with the scale inscriptions serves as the “gripping” area of the rule. If the rule 
selection button  is pressed, you can move the rule by clicking in this gripping area and moving the rule
while holding down the left mouse button. This type of rule movement only permits parallel movement. 
Note that during movement, the rule will snap to other elements of your project in the region of the mouse.
When moving the rule as described above, the position of the origin of the rule does not change. In 
principle, all scale divisions of the rule run on lines vertical to the rule. 

If in addition to moving the rule the origin of the rule is also to be shifted, this can be done by pressing and
holding the Shift key during movement. You are then able to position the rule absolutely freely and the 
point at which you release the mouse button is the new zero position for the rule. 

A third way of moving the rule is to rotate it. You access this function by clicking on the scale area while 
holding down the Ctrl key. You can then freely turn the rule about its origin. 



RULE TABULATORS

Imaging that your timber rule had a notch at a certain position along its rest edge. If you were to run along
the edge of the rule with a pencil without exerting too much pressure, the pencil would come to rest in the 
notch.

The equivalent of the notch(es) in ArCon are the tabulators. These tabulators are marked in color within 
the rule. There are three different types of tabulator: those marked green are periodic tabulators – they 
repeat at fixed intervals, whereby measurements always begin from zero. You can modify these periodic 
tabulators or even switch them off completely. You access the dialog box in which you make the relevant 
changes by right-clicking on the scale area of the rule. You will find a detailed description of this in the 
following section. 

Apart from the periodic tabulators, you can set additional tabulators as needed. You do this by clicking in 
the graduation area of the rule at the required position. After clicking, a dialog box appears in which you 
can enter the exact numerical value for the tabulator. Tabulators defined in this way are colored red. You 
can move these red tabulators by clicking on them and then dragging them along the rule. If you drag 
them out of the rule, the tabulator will be deleted. You are possibly aware of this function with the rule of 
Word for Windows. Also after shifting a tabulator a dialog box appears again in which you can enter the 
exact positions. 

Tip: If you wish to suppress the dialog box that appears on moving or setting “red” tabulator stops, press 
the Ctrl key while clicking.

The value used will then be the scale value that is closest to the mouse pointer when clicking. 



OPTIONS FOR THE RULE

In the rule settings dialog box you determine which tabulators are to be used, where the origin of the rule 
is and the behavior of the rule when editing and scrolling your plan.

The settings you make for the rule apply only for the current window. If you have several windows in your 
view, you can make different settings for all views.

TABULATORS

Rule tabulators function as capture positions during construction. You can use periodic tabulators, for 
example to define a capture position every 50 cm on the rule. Periodic capture positions appear in green 
on the rule.

The significance of the individual elements in the Tabulators field is as follows.

Periodic tabulators every

When you check this box, you can enter the frequency of the periodic tabulators in the associated input 
field.

Use standard tabulator

Check this box in order to be able to use the standard tabulator. The standard tabulator is shown in blue.

ORIGIN

If the box Origin at last point (see below) is not checked, you can enter the zero position of the rule 
here. When you exit the dialog box by clicking on OK. the rule will be moved to this position relative to the
0-position you have fixed in the drawing 

Note that the setting Keep rule visible (see below) has priority over the setting for the origin. If after the 
settings you have made the rule would not be visible, the settings will be adjusted after you click on OK 
so that it becomes visible.

KEEP RULE VISIBLE

Check this box to prevent the rule from scrolling out of sight when you scroll a view on the screen.

THE CHECK BOX ORIGIN TO LAST POINT

If this box is checked, the 0-position of the rule will always be moved to the point where you last clicked 
with the mouse to enter the position of walls, windows, doors, etc. 





THE ENTRY BAR FOR THE RULE

In the rule entry bar, which when you are in Construction Mode and the button  is depressed is always 
to be seen in the current window, there are certain entries you can make directly via the keyboard. Apart 
from the input range for numeric input, six buttons exist with which you can initiate certain operations for 
the rule: 

 
 
 
 
 and 
 .

With the button  you lift the rule. This has the effect that when inserting walls, etc., the mouse or the 
element being inserted can be dragged past the rule without hindrance. This is not the case when the 
button 

 is not depressed. In this case, you can only pass the rule unimpeded from “below”, when attempting to 
pass the rule from “above”, the element will slide along the edge of the rule. 

The function of the  button is to reverse the definition of below and above for the previous button. 
Normally the edge of the rule is on top; but when you click on this button, the edge of the rule will be 
underneath and the button will change to 

 . This procedure is identical in use to that of a genuine rule, which you sometimes have above the 
pencil and sometimes also below. 
The purpose of the  button is to shift your rule by a certain offset in a parallel fashion. When you click on 
it, the direction of the rule will be maintained, but the edge will be shifted by a certain value. You enter the 
magnitude of this shift in the first numeric field of the rule entry bar. For example, if the value entered is. 1 
meter and you click on the button, the rule will be moved up by one meter. Note that negative values in 
the entry field will cause the rule to shift down. 

The button  rotates the rule by a fixed angle. The “axis of rotation” is the 0-position of the rule. You enter
the magnitude of this angel in the second numeric field of the rule entry bar. The units for data entry are 
degrees, whereby positive values will turn the rule anti-clockwise, i.e., to the left, and negative values will 
turn the rule to the right. 

The purpose of the  button is to rotate the rule by 90 degrees. For example, if your rule is horizontal and 
you click on this button, it will turn to the vertical position. Clicking on the button again will turn the rule 
back to the horizontal position. 

The final button  always positions the rule horizontally. Regardless of the present angle of the rule, 
clicking on this button will always cause the rule to take on an absolute rotational angle of zero degrees. 

THE ENTRY FIELDS OF THE RULE ENTRY BAR

The first two entry fields have already been described in the previous section. The first field defines the 
offset to be used for parallel shifts on clicking the  button. The second defines the relative angle of 
rotation to be used on clicking the 

 button. For example, if you have entered 15 degrees, you can rotate the rule by 45 degrees by clicking 
three times on the 

 button. 
The third entry field is used to define a standard tabulator . This fixed tabulator position can be entered at 
any time without the need to call up a dialog box on every occasion. 

In the final entry field you can enter an absolute angle of rotation. If you enter 45 degrees, for example, 
the rule will be turned by this amount. Additionally, if you click in the numeric area of the rule while holding
down the Ctrl key, this field will also display the current angle of the rule after the rule has been turned.



KEYBOARD SHORTCUTS FOR USING THE RULE

You can also operate the six buttons in the rule entry bar via the keyboard. The function keys F5 - F10 
have been assigned for this purpose. Function key F5 is assigned to the first button, i.e., this is the “lift 
rule” key, F10 is assigned to the last button, i.e., the “rule horizontal” key. With a little practice using these
keyboard shortcuts, you will be able to make very effective use of the rule for drawing your construction 
plans. Try constructing a 20-sided floor plan, for example, with the help of the rule.

Hint: Use the standard tabulator and turn the rule each time by a fixed angle of 18 degrees.



 GUIDES
ArCon provides guides to help you quickly and accurately construct your floor plan and using these you 
and the various positioning facilities you can construct a grid of guides in very little time. You can define 
the type of lines to be displayed in the dialog box Guides, as well as entering the angle and the 
distribution ratio relative to reference lines in the dialog box entering guides. You can save these values 
as defaults for use in other projects. 

You switch the display of the guides on or off by clicking on the  button.

 DEFINE GUIDE TYPE
You will find the button for the guide functions in the vertical toolbar. This is an option switch, indicated by 
the black triangle in the bottom right corner of the button. By clicking and dragging the left mouse button 
into the view window, a selection of two different types of guide will appear. Information on each type will 
be displayed at the bottom left of the screen. Move the mouse pointer onto the required type while holding
down the left mouse button and then release the mouse button. The selected type will now appear in the 
toolbar.

DRAW GUIDE

With the first selection  the guide will be drawn over the entire work area. In the second case 

 only a guide segment will be drawn. You can determine for yourself the length of the guide you insert.

After you have selected a guide, ArCon will offer you a selection of different placement possibilities in a 
second vertical toolbar (the “how” toolbar). By clicking on one of these buttons with the right mouse 
button, the same dialog box will appear in each case. Here you can enter the following numeric values by 
clicking on one of the entry fields and entering the data via the keyboard.

For the entry type , Angle to reference line provides the defined angle, for the entry type 

 the Distribution ratio

You click on the screen with the left mouse button at the insertion point. If you wish to cancel a guide 
insertion operation, press the Esc key.
In the following section, guides and guide segments will be described together. The term guide applies to 
both types. 



PLACING GUIDES
 DRAW VERTICAL GUIDE

Place a guide by clicking at any point in the work area. Vertical orientation is mandatory.

For a guide segment, the first entry point if the starting point of the segment, a second point designates 
the end point of the guide segment and therefore defines the length the guide segment. If when entering 
the starting point you press the Shift key at the same time, ArCon remembers the position of the vertical 
line. By then entering a second and third point on top of this, you determine the start and end of the guide 
segment.

This extended function allows you to position a guide segment, the extrapolation of which goes exactly 
through a certain point. 

 DRAW HORIZONTAL GUIDE
The procedure for placing horizontal guides and guide segments corresponds exactly with that for vertical
guides. The possible means of entry are identical. 

 DRAW FREEHAND GUIDE
After clicking the first entry point, you can freely rotate the guide around this fixed point and then locate 
the guide at any required angle by clicking on the second point.

Two entry points are also required for positioning guide segments. These define the start and end points. 
The Shift key has no effect.

 DRAW GUIDE VERTICAL TO A REFERENCE LINE
Guides: Click with the mouse on the desired reference line (wall face etc.). The run of the new guide 
vertical to the reference line will appear on the screen. Place the guide by clicking with the left mouse 
button at the required position. If you press the Shift key when marking the first point, ArCon remembers 
the angle of the guide. The position of the guide can still be shifted, even past the reference line that was 
clicked on.

Guide segments: By marking the first point you identify the reference line. This is at the same time the 
starting position of the guide segment. The second point determines the length of the guide segment to 
be set vertically on the reference line. If you press the Shift key when marking the first point, ArCon 
remembers the angle of the guide segment. The position of the segment can still be shifted. By marking 
the second and third points on this line, define the start and the end of the segment. 

 DRAW GUIDE AT A FIXED ANGLE TO A REFERENCE LINE
By using this function it is possible to place a guide at a fixed angle.

Placing guides and guide segments with or without the Shift key is performed in the same way as placing



a guide vertical to a reference line. The only difference is that the guide is not positioned at a right angle, 
but at any desired angle. You can set a value for this angle by right-clicking on the “how” toolbar when 
placing guides, and then entering the required value in the dialog box that appears. 

 DRAW GUIDE PARALLEL TO A REFERENCE LINE
Right click on the line parallel to which the guide is to be placed. With the second point you click on, you 
determine the offset to the parallel line.

In the case of guide segments, the first click identifies the reference line. With the second point you click 
on, you determine the offset to the parallel line and the start of the guide segment and, with the third click,
the end. The Shift key has no effect.

 DRAW PARALLEL GUIDE AT A FIXED OFFSET TO A REFERENCE LINE
First click on the reference line and then to the left or the right next to the reference line, depending on 
which side the guide is to be placed. ArCon now displays a dialog box in which you can enter the offset to 
the reference line. 

Entries that you make in this dialog box are retained. Therefore, if you place several guides using this 
placement method, you do not need to re-enter the value each time. 

You can suppress the display of this dialog box by pressing the Ctrl key when clicking on the second 
entry point.

When placing guide segments, ArCon uses the parallel position of the second click relative to the 
reference line for the starting point. You determine the end point of the guide segment with the third click. 
Between the second and the third click a dialog box appears in which you enter the offset to the reference
line. You can also avoid displaying this dialog box by pressing the Ctrl key. In this case, the “previous” 
entry will be used.

 DRAW GUIDE MIDWAY BETWEEN TWO POINTS
Between two points entered, the starting point with any desired distribution ratio is calculated. You access 
the dialog box for entering the distribution ratio by clicking with the right mouse button on the “how” 
toolbar for guides. The guide will be placed in the form of an axis between these two points.

In the case of guide segments, the starting point lies in the stated distribution ratio between the two 
reference points. A third point determines the direction (left or right) and the length of the guide segment. 
If the Shift key is pressed during entry of the first two points, the position of the guide segment will be 
shown on the screen. You can then determine the start and end points by marking a third and fourth point.



DELETE GUIDE

You select the guide to be deleted by clicking on  with the left mouse button and then clicking on the 
guide. The selected guide will be displayed on the screen in red. It will be deleted on pressing the Del 
key. If you want to delete all guides in the display, you can do this by choosing Delete all – guides from 
the- Edit menu.



GUIDES DIALOG BOX

This dialog box is opened when you click with the right mouse button on  or by choosing Program - 
Guides... in the Options menu.

CHOOSE LINE TYPE

Five different line types are available for you to choose from.

CHOOSE COLOR

If you wish to use a certain color for your guides different from the previously used color, then click on the 
button Select color. A color palette will be displayed in which you can either choose from one of the basic
colors offered or mix your own color together by selecting Define colors.

DEFAULT BUTTON

By choosing Make default in the dialog box, you can permanently save the values you use most 
frequently. Changes you make without saving as default will only be available for the current construction 
project. 



 SELECTING IN THE CONSTRUCTION MODE
When you are working in ArCon’s Construction Mode , the button  appears right at the top of the left 
vertical toolbar. It has a special significance compared with all other buttons on this toolbar. It is not used 
for placing elements, but to select elements. If this button is depressed, you can select elements placed in
your plan in order to then delete or move them, for example, or to change their properties in some way. To
select an element, click on the desired element while the 

 button is depressed. The element will then be marked red. If several elements are located at the point 
you are clicking on, then the smallest element will be selected first. If you click again, then the next larger 
will be selected, etc.. Selectable elements are walls, window, doors, labeling, texts, floors and ceilings 
(the internals of rooms), floor panels, openings, staircases and roofs. If you click in a room and there is a 
roof above this room, then the floor and the ceiling of the room will be selected first, if you click again, 
then the roof (which is, of course, larger than the floor and ceiling) will be selected.

You can perform the following operations on selected elements:

· You delete a selected element by pressing the Del key

· You move an element after having selected it by clicking again on the element and then moving the 
element without releasing the left mouse button. 

Note: Not all elements can be moved in Construction Mode. For example, you cannot move staircases. If 
necessary, you must first delete these and then re-insert them. Some elements can be moved only under 
certain restrictions. For example, windows can only be moved within a wall.

· You can change the properties of elements. If an element is selected and you double-click on it while it
is marked red, a dialog box for this element will appear in which you can alter its properties.

Note that when you switch from the Design to the Construction Mode, you are automatically presented 
with a pressed  button.



ELEMENTS IN THE CONSTRUCTION MODE

The following chapter explains how you work with elements such as walls, windows and doors in the 
Construction Mode. The various elements are described in the order in which they appear on the left 
vertical toolbar. The description of each element is divided into in following sub-items: 

· General description of the element

· Types of input for the element

· Options for the element

In the description of the types of input for the element, you will find precise explanations of the possible 
buttons on the “how” toolbar for this element. 

The options for an element can be used in several ways:

· You can change the size and appearance of an element that has already been placed.

· By right-clicking on an element button, e.g. the  button, you can determine how elements should 
appear that are newly placed after this clicking. Of course, you will still be able to change new 
elements as described immediately above.

· The possibility described immediately above refers only to your current project after right-clicking. 
However, you can make default settings for all future projects, which will then be used after these default 
settings have been made. For example, if you start ArCon again at a later point in time and use a window 
without having made changes as described above, then the default values stored will be used. You 
always have the possibility to define or change the default settings for a certain element whenever a 
dialog box for this element is open. Here you will find the button Make default. If you click on this button, 
the settings presently visible in the dialog box will be used as default settings from this point onwards.

Note: Using this function, you have the possibility to adjust the characteristics of ArCon within a wide 
range to suit your own requirements. After installation of ArCon, some standard settings are already 
defined, but these might not necessarily meet with your requirements. After a period of getting to know 
ArCon, you should review these settings again as described.



THE ELEMENT WALL

Using the wall function, you can quickly and easily construct your floor plan. It is possible with the help of 
a dialog box    to change the wall options, such as dimensions, texture and display, in accordance with 
your requirements. Additionally, it is possible to enter seven different wall types as standard inter-project 
defaults. Through having various input possibilities for walls and the additional benefit of construction 
aids, such as the grid, guides and the rule, you will very soon be able to construct accurately scaled 
plans. However; first make sure that the grid is switched on.

DEFINE WALL TYPE

In the vertical toolbar you will find the  button for the wall function. The button is an option switch, 
indicated by the black triangle in the bottom right corner of the button. By clicking and holding down the 
left mouse button and dragging the mouse into the view window, a selection of wall types will appear. 
Information on the individual types will be displayed at the bottom left of the screen. Move the mouse 
pointer onto the required wall type while holding down the left mouse button and then release the mouse 
button. The selected wall type now appears in the toolbar. You access the dialog box for changing the 
values by clicking with the right mouse button on 

 or by choosing Walls... from the Options menu. By saving in the dialog box using Make default you 
can permanently store the values you use most frequently. If you change the values for a selected wall 
type without saving them as default, these values will only be valid for your current work. By selecting and
then double-clicking on a wall, you can also make changes to the wall using the dialog box that appears. 

When you have selected a wall type, ArCon shows a selection of various insertion possibilities in a 
second vertical toolbar (the “how” toolbar). After clicking on one of these buttons with the right mouse 
button, a dialog box will appear. Here you can enter the values appertaining to the various inputs. These 
are similar to the options for guides: the angle to the reference line for the selection of  and the 
distribution ratio for 

. The offset to a parallel for 
 is entered via a dialog box during positioning.

If you wish to cancel a wall insertion procedure, press the Esc key.



PLACING WALLS

CHANGING THE WALL REFERENCE POINT

After the start position of a wall has been set, a colored cross marks the current reference point for the 
wall. Swapping between the wall axis and both long sides is achieved by pressing Ctrl + W –: the entire 
wall will be shifted.

If only the points of an end of the wall are to be shifted, then press Ctrl + Q – for the start of the wall and 
Ctrl + E – for the end of the wall.

 INSERTING MULTIPLE WALLS
With this command you set up the walls as a polygon, i.e. the first point clicked on is the starting point of 
the first wall section, the second point is the end point of the first wall section and at the same time the 
starting point of the second wall section, etc.

 INSERTING SINGLE WALLS
Enter the starting point and the end point for each individual wall. 

 INSERTING A WALL VERTICAL TO A REFERENCE LINE
If you click with the left mouse button on a wall or a guide, this becomes the starting point of wall lying 
vertically to this reference line, the end point of which is determined by the second point entered. 

If you press the Shift key while clicking on the first entry point, ArCon will draw a guide vertical to the 
selected reference line. This guide can be moved as required along the reference line (also outside of it). 
If you enter the second point without pressing Shift, then this determines the starting point on the 
reference line. The third entry point determines the end point on the guide.

If you enter the second point also with the Shift key pressed, this enables the position of the guide 
vertical to the reference line to be fixed. The third and fourth entry points determine the start and end 
points of the wall. Both points are situated on the guide, however they do not need to be connected any 
longer to the reference line.

 INSERTING A WALL AT A FIXED ANGLE TO A REFERENCE LINE
With this command you can construct a wall at any desired angle to the reference line you have selected. 
The required angle can be entered in the Wall data dialog box. 

The various insertion methods using the Shift key function are exactly as for the system described above 
for constructing a vertical wall.

 INSERTING A WALL PARALLEL TO A REFERENCE LINE
Click on a wall or a guide with the left mouse button. A guide will appear which can be moved parallel to 



this reference line. The second and third points of clicking determine the start and end points on the 
guide.

If the guide is to be fixed at a certain offset to the reference line, then press the Shift key while performing
the second click. The guide is now fixed and on this, the start and end points of the wall are determined 
by the third and fourth points clicked.

 INSERTING A PARALLEL WALL AT A FIXED OFFSET TO A REFERENCE
LINE
With this command you can construct a wall parallel reference line you have selected. After the second 
click, the Offset for parallel guides dialog box appears, in which you can define an offset. The various 
insertion methods using the Shift key function are exactly as for the system described above for 
constructing parallel walls.

 INSERTING A WALL MIDWAY BETWEEN TWO POINTS
You click on two entry points, between which the wall is to be constructed vertically with a certain 
distribution ratio. You define the default value for the distribution ratio in the Wall data dialog box. If you 
click on the first two points without the Shift key, then the start point of the wall will lie between these two 
points. The third point determines the length and direction of the wall.

If you click on the second point with the Shift key pressed, a guide will be drawn vertically to the points 
with the selected distribution ratio, on which the position and length of the wall are determined by the third
and fourth points clicked on. These last two points do not need to be on the guide, they can be any two 
points within the plan. They will be projected vertically onto the guide by ArCon.

 SHADING
By clicking on this button you can the switch wall shading on or off.



SHIFTING A WALL

To shift a wall, whether entirely or only at the ends, the wall must first be selected. You do this by 
activating Selection Mode with     and clicking again on the wall. When you select a wall, not only will 
the entire wall be marked red, but also the side of the wall on which you clicked will be marked with a 
thick red line. If you then double-click the wall, you can change the properties of this marked wall side 
individually.

To shift the entire wall, click on it, keep the left mouse button pressed and then move the wall by moving 
the mouse. When the wall has reached the desired position, release the mouse button. 

To shift the end of a wall (to lengthen or shorten the wall) press the Ctrl key when clicking the end of the 
wall. While keeping the mouse button pressed, lengthen or shorten the wall as you wish and then release 
the mouse button when the desired position has been reached. 

If you shift a wall and snap to grid    is active, the corner of the wall that will act as the snapping point is 
that which was closest to the mouse pointer on moving the wall. For example, if you have clicked close to 
the left upper corner of the wall, then you will basically be moving the whole wall, and you can then 
determine the new position for the left upper corner by snapping it to the grid. If you wish to use one of the
other four corners of the wall as snap points, you can do this by pressing Ctrl-W. The other corners of the 
wall will then be selected in turn to be used as snap points. Which of the fours is selected is indicated, as 
usual, by a small red mark.

If when commencing to move a wall you hold down the Ctrl key, then the behavior on moving is 
completely different from that of free shifting without the use of the Ctrl key. If you have clicked close to a 
free head end of a wall, you can move this free end, which means that you can change the length of the 
wall. A free head end is an end which as not attached to any other wall. If the wall is inserted between two
other walls (similar to the case of the cross-bar in the letter H), then you can move the wall within the two 
existing walls. It is irrelevant whether the two walls are parallel. If they are not parallel, the length of the 
wall to be moved will be adjusted automatically (like shifting the cross-bar in the letter A). Finally, you can 
also rotate the wall about one end as long as the other end of the wall is not joined to any other wall. To 
do this, you click in the proximity of the free head end while pressing the Ctrl key. This time, however, not 
with the left, but with the right mouse button. Finally you will be able to rotate the wall (with the right 
mouse button pressed) around the other end without changing its length. If you also want to change the 
length during rotation, then press the left button together with the right mouse button. (If you find this latter
procedure too complicated – after all, you need to press Ctrl, the left and the right mouse buttons together
- then simply delete the wall and construct it again.)



DELETING A WALL

You select the required wall by activating Selection Mode by clicking on     with the left mouse button 
and then clicking on the wall. The selected object will be shown in red on the screen. When you press the 
Del key, the selected object will be deleted.

If you want to delete all walls in the display, you can do this using the Delete all walls command.



THE WALLS DIALOG BOX

You access the walls dialog box as for all dialog boxes for elements in the Construction Mode either by 
double-clicking on a wall, by right-clicking on the wall-button  or by choosing Walls... in the Options 
menu. This then refers to all surfaces of a wall.

When you open a dialog box for the walls of an existing wall, then the function of the dialog box is 
modified. When you double-click, you are able to select not only a wall, but also a complete wall surface. 
This wall surface will be marked in heavy red. 

In this way you can pre-define the type of material, for example, for all surfaces of walls to be newly 
constructed: In the case of existing walls, you can change the material of a specific wall surface.

WALL TYPE

Here the text is displayed describing the wall type you have selected. If you with change an existing wall 
using this dialog box, then the button for the wall type will be displayed as an option switch. In this case, 
the wall type can be changed in the dialog box by clicking on the button and, while holding down the left 
mouse button, dragging the mouse pointer to the desired wall type and releasing the mouse button again.

DIMENSIONS

The option Thickness

In this area the wall thickness can be entered or changed. 

The option Length

It is not possible to enter the wall length before inserting the wall and this option field is therefore grayed 
out. The length of a wall can only be entered afterwards and only if at least one free wall end exists. An 
isolated wall shrinks or expands in both directions, a wall joined at the head only in the direction of the 
free end. 

The button Set initial values sets the thickness of the wall to its originally defined value.

SURFACES
The option Color

If you wish to select a color, click the button define.... A color palette is displayed in which you can either 
select one of the colors offered or mix your own color together by selecting Define colors.

In Design Mode, it is not possible to change the texture when a color has been defined. However, the wall
texture in Construction Mode can be changed at any time.



The option Texture

The wall is covered with the texture shown in the drop-down list below. If you wish to choose a different 
texture, click on the browse... button. You are then presented with a standard dialog box from which you 
can select a texture. 

The option Mix color and texture

Below the drop-down list for textures you will find a check box. Check this box if you wish to combine 
color and texture. For example, if you choose black stripes on a white background and combine this with 
a blue color, then you will get black stripes on a blue background.

Size of texture

For most textures the standard sizes are predefined in the texture catalogs. The field for original size is 
grayed out if no texture size has been defined. The standard texture size is 100x100 cm, i.e., if you place 
a certain pattern on a wall 3 m long and 2 m high, it will be reproduced 6 times. If the pattern is to appear 
only once on this wall, then the grid must be changed to 300x200 cm. Click on the check box Original 
size, the original texture size will be reinstated. 

You can enter a value for rotation in the Rotation field. The texture will then be displayed with this rotation
angle.

Using the check box Copy from the wall below you can copy wall properties for the walls of new stories.

The final check box invisible in top view / perspective view you control the visibility of a wall surface or 
a wall. This facility is advantageous when walking around projects. You can then look into rooms in a way 
analogous to looking into a doll’s house.



DOORS

The door function provides you with the possibility to insert various kinds of doors into existing walls. You 
can choose from a wide variety of door shapes in the program. The size of the door opening, the direction
of opening and textures can be easily changed using a dialog box. You will find a description of the dialog 
boxes at a later point in this chapter. Using the various types of input described in the following, you will 
be able quickly and easily insert doors that fit perfectly. Additional aids that can be used are the grid, 
guides and the rule function. 

SELECT DOOR TYPE

You will find the button  for the door function in the vertical toolbar. The button is an option switch. You 
access the dialog box for changing doors by clicking with the right mouse button on the button 

 or you choose Doors from the Options menu. If you change the values for a specific door, these 
remain valid only for the current door insertion procedure. By selecting and then double-clicking a door, its
values can subsequently be changed in the dialog box. 

When you have selected a wall type, ArCon shows a selection of various insertion possibilities in a 
second vertical toolbar (the “how” toolbar). After clicking on one of these buttons with the right mouse 
button, a dialog box will appear. Here you can enter the values appertaining to the various inputs, the 
offset to the reference point and the distribution ratio. 

If you wish to cancel door insertion procedure , press the Esc key.



PLACING DOORS

CHANGING THE REFERENCE POINT OF A DOOR

A door has three reference points, which are marked by colored crosses. You can change the reference 
point by pressing Ctrl + W. Depending on your requirements, it can be situated on the corner points of the
door (left, right) or at the center point.

 FREELY PLACING A DOOR
If you have selected this entry option, you can place the door directly in the desired position using its 
reference point. Move your mouse pointer to this position and click with the left mouse button on the 
required position. The door can only be inserted in a wall, whereby the reference point can lie on a guide 
or another snap point.

 PLACING A DOOR WITH OFFSET TO A REFERENCE POINT
You click on a reference point (not necessarily on the wall) and as a second point the approximate 
position of the door on the chosen wall. The offset of the reference point to the reference point of the door
is then entered in the dialog box that appears. If the reference point is not on a wall, but on a grid or a 
guide, for example, then ArCon will project the starting point vertically onto the chosen wall. If when 
clicking on the second entry point you also press the Ctrl key, the dialog box requesting input of the offset
value will be suppressed. The previously entered value or the default value for calculating the door 
position will be used.

 DOOR BETWEEN TWO POINTS
With this method of placing doors, you click on two points on the wall, between which the door will be 
inserted with a certain distribution ratio. If the first two entry points are not on the wall, then a third point is 
necessary, with which you identify the wall. In this case, the two entry points will be projected vertically 
onto the wall. The previously entered value for the distribution ratio or the default value will be used for 
calculating the door position.



DOOR OPTIONS

As for all element options, you access the Door options dialog box by double-clicking on an existing door 
or by right-clicking on the doors button, or by choosing Doors... from the Options menu

Regardless of the type of door whose options you wish to change, you are always presented with the 
same dialog box.

In the area Dimensions you can the enter the width and the height of the door, its angle of opening and, in
the case of double-winged doors. the angle of opening of both doors. In the area Hanging you enter 
information on whether the door opens inwards or outwards and whether it is hung on the left or the right. 
In the area textures you can change the textures used for the frame, the left wing and, in the case of 
doubled-winged doors, the right wing. Finally, in the area Wings you can determine the type of door wing, 
or wings in the case of doubled-winged doors. You change the type of door wing by entering a new type in
the selection list. All changes, also those for the opening angle and the door wings, will be updated 
immediately in the preview window. Click on the button Make default if you want your changes to be 
used in future for all newly inserted doors.

MOVING DOORS

Select the door by clicking on     with the left mouse button and then clicking on the door. The selected 
door will be shown in red on the screen. Leave the mouse pointer on the door and press the left mouse 
button. While the button is being held down, the door can be moved on the wall by moving the mouse.



OVERLAPS WITH OTHER DOORS AND WINDOWS

When you insert windows and doors into a wall and a window or a door already exists at the position in 
which the element is to be placed, a dialog box appears to make you aware of this situation.

If you check the box Do not display this message again in this dialog box, you will not be informed of 
such overlaps in the future. It can often happen that, although in the plan view you think that windows will 
overlap, this is in fact not the case, as they can be at different heights, for example. In such cases the 
dialog box will not be displayed. To be exact, it appears whenever openings of windows and/or doors cut 
across one another. A similar dialog box will also appear if you place a roof on a story that already 
contains windows and doors, which when overhanging the walls would partially or completely obliterate 
windows and doors. You can decide in this dialog box whether the windows or doors should be removed 
automatically or whether you wish to remove them manually.



DELETING A DOOR

Select the required door by clicking on     with the left mouse button and then clicking on the door. The 
selected door will be shown on the screen in red. On pressing the Del key on the keyboard, the selected 
door will be deleted. If you wish to delete all doors in the display, you can do this choosing Delete all – 
doors in the Edit menu.



WINDOWS

ArCon provides you with the possibility of selecting from a wide variety of windows. This includes on the 
one hand windows in free construction, which are computed again specially for the application (as is 
always the case for staircases ), and on the other hand, windows that are loaded from disk, for which you 
can only change the sizes and certain surface characteristics, but not the geometry. 

Loaded windows are in principle nothing other than objects for which you can make appropriate changes. 
The advantage of the loaded windows is that they are very detailed, for example, windows with stucco. 
However, the disadvantage is that they are relatively inflexible to handle. 

It is for this reason that the freely definable window exists. Various settings can be made for these in order
to adapt them to your individual requirements. You access both of these types with the same option 
switch.

In the current version of ArCon the first two are freely definable, the others are loaded windows. You can 
identify these by the special file symbols around the window types.

Note: By virtue of a special feature in the ArCon software, it is possible to extend the windows function 
without making changes in the program, that is, without changing to another version. This allows the use 
of extension modules for freely definable windows as well as for loaded windows. Ask your software 
dealer about the extension modules that are available.



DEFINE WINDOW TYPE

You will find the button for the window function  on the vertical toolbar. The button is an option switch, 
indicated by the black corner at the bottom right. By holding down the left mouse button and dragging the 
mouse pointer into the view a selection of different window types will appear. Information on the individual
types is shown in the bottom left of the screen.

To access the dialog box for changing the values, click with the right mouse button on  or choose 
Window... from the Options menu. By saving in the dialog box using Make default you can permanently 
store the values you use most frequently. If you change the values for a selected window type without 
saving them as default, these values will only be valid for your current work. By selecting and then 
double-clicking on a window, you can also make changes to the window using the dialog box that 
appears. 

When you have selected a window type, ArCon shows a selection of various insertion possibilities in a 
second vertical toolbar (the “how” toolbar). After clicking on one of these buttons with the right mouse 
button, the same dialog box will appear for each field. Here you can enter the required values, for 
example, for the distribution ratio for the type  .

If you wish to cancel the window insertion procedure, press the Esc key.



PLACING WINDOWS

You insert windows by placing the window within an existing wall after you have chosen the window type, 
if required, using the option switch. ArCon then automatically cuts the required opening in the relevant 
wall. How you place the window in detail depends on the entry you have chosen in the “how” toolbar.

Independent of this entry is whether you position the center axis, the left or the right edge of the window. 
You can switch between these three alternative using the Ctrl+W key.

CHANGING THE REFERENCE POINT OF A WINDOW

A window has three reference points, which are marked by colored crosses. You can change the 
reference point by pressing Ctrl + W. Depending on your requirements, it can be situated on the corner 
points of the window (left, right) or at the center point.

 FREELY PLACING A WINDOW
If you have selected this entry option, you can place the window directly in the desired position using its 
reference point. Move your mouse pointer to this position and click with the left mouse button on the 
required position. The window can only be inserted in a wall, whereby the reference point can lie on a 
guide or another snap point.

 PLACING A WINDOW WITH OFFSET TO A REFERENCE POINT
You click on a reference point (not necessarily on the wall) and as a second point the approximate 
position of the window on the chosen wall. The offset of the reference point to the reference point of the 
window is then entered in the dialog box that appears. (this procedure is identical to the insertion of doors 
using ).

If the reference point is not on a wall, but on a grid or a guide, for example, then ArCon will project the 
starting point vertically onto the chosen wall. If when clicking on the second entry point you also press the 
Ctrl key, the dialog box requesting input of the offset value will be suppressed. The previously entered 
value or the default value for calculating the window position will be used.

 WINDOW BETWEEN TWO POINTS
With this method of placing windows, you click on two points on the wall, between which the window will 
be inserted with a certain distribution ratio. If the first two entry points are not on the wall, then a third 
point is necessary, with which you identify the wall. In this case, the two entry points will be projected 
vertically onto the wall. The previously entered value for the distribution ratio or the default value will be 
used for calculating the window position.



WINDOW OPTIONS

As for all element options, you access the Window options dialog box by double-clicking on an existing 
door or by right-clicking on the Windows button, or by choosing Windows... from the Options menu. 
Depending on the type of window, you are presented with three different dialog boxes: one type for the 
two freely definable windows , and a dialog box which is identical for all loadable windows.

OPTIONS FOR FREELY DEFINABLE WINDOWS (TYPE 1)
The dialog box is divided into the three areas Dimensions of opening, Type of opening and Textures. The 
sketch below indicates the various values:

DIMENSIONS OF OPENING

If you enter a non-zero value for Lower reach, no window sills will be used for this window.

Note: If you enter zero for the height and you enter the same value for Upper reach and Lower reach, i.e.,
equal to half of the width, then you can produce round windows. 

TYPE OF OPENING

In the area Type of opening you state whether the window is to be left or right hung and whether it is to 
open inwards or outwards.

Note: ArCon automatically recognizes where “outside” is for a wall.

TEXTURES

In the area Textures you can define the textures that are to be used for the Frame and for the internal and
external window sills. If you select none, the corresponding elements will appear untextured.

You should always use the Preview button if you have made changes in the area Dimensions of opening.



When working in this dialog box, ArCon does not update the preview window while changes are being 
made.

OPTIONS FOR FREELY DEFINABLE WINDOWS (TYPE 2)
In this dialog box you not only have the possibility to change the shape of the window within a wide range,
but you can also equip the window internals with posts and locks. As for all other windows, you can also 
define the textures for the frame and both window sills. And finally, it is possible to enter the cross-
sectional dimensions of the frame.    Thanks to the preview window it is much simpler to change certain 
values and to see the result of the changes directly on the screen. For orientation you can refer to the 
above explanations regarding input for Type 1.

OPTIONS FOR LOADABLE WINDOWS

This dialog box is in principle a subset of the data entry possibilities for freely definable windows. 
However, in contrast to these, the frame width, for example, also changes when you change the overall 
width of a loadable window. As no new input elements exist in this dialog box, a detailed description will 
be dispensed with. If necessary, you can read the description of the two freely definable window types 
above.



MOVING WINDOWS

Select the window by clicking on     with the left mouse button to activate Selection Mode and then 
clicking on the window. The selected object will be shown on the screen in red. Leave the mouse pointer 
on the door and press the left mouse button. While the button is being held down, the window can be 
moved on the wall by moving the mouse. 

By pressing Ctrl-W when moving a window, the left or right edge of the window will be moved instead of 
the center. Thus, with the help of the snap to grid    feature, you can the reposition the window according 
to your requirements.



DELETING A WINDOW

Select the window by clicking on     with the left mouse button to activate Selection Mode and then 
clicking on the window. The selected object will be shown on the screen in red. On pressing the Del key 
on the keyboard, the selected window will be deleted. If you wish to delete all windows in the display, you 
can do this choosing Delete all – windows in the Edit menu.



CHIMNEY STACKS AND SUPPORTS

Using the chimney stack and support function, you can quickly and easily insert chimney stacks and 
supports into your floor plans. It is possible with the help of appropriate dialog boxes to change the 
options such as dimensions and texture according to your requirements. Apart from this, various types 
can be entered as standard types to be used in other projects. By using the construction aids such as the 
grid, guides and the rule you will very soon be able to insert accurately dimensioned chimney stacks into 
your plans. 

DEFINE TYPE

In the vertical toolbar you will find the button  or 

 for the chimney stack or support function. Using the option switch, ArCon provides you with chimney
stacks with and without additional ventilation shaft. In the case of supports, you have the choice between 
rectangular and round supports. To access the dialog box for changing the default values, click with the 
right mouse button on the button 

 or 
 or choose Chimney stack... or Supports... from the Options menu. You will find the description of 

the dialog boxes at the end of this section. By clicking on the button Make default you can permanently 
store the values you use most frequently. 

If you change the values for a selected type without saving them as default, these values will only be valid
for your current work. By selecting and then double-clicking on a chimney stack or a support, you can also
make changes to the individual element using the dialog box that appears. 

PLACING CHIMNEY STACKS AND SUPPORTS

After clicking on the appropriate button  or in the vertical toolbar, you can place your chimney 
stack or support in the floor planThe aids you have at your disposal are the grid, guides and the rule. The 
reference point of the chimney stack can be changed with Ctrl+W. Possible reference points are the four 
corner points and the chimney stack center. The reference point is marked with a red cross.

MOVING CHIMNEY STACKS AND SUPPORTS

To move a particular element it must first be selected. This is done by clicking on     and then clicking on
the element. The element will be shown on the screen in red.

To move the element, click on it, keep the left mouse button pressed and then move it by moving the 
mouse. When the element at the desired position, release the mouse button. As is the case for placing an
element, the reference point for moving can be altered by pressing Ctrl+W.

DELETING CHIMNEY STACKS AND SUPPORTS

Select the desired element by clicking on     with the left mouse button and then clicking on the element.
The selected element will be shown on the screen in red. When you press the Del key, the element will be
deleted.



If you wish to delete all doors in the display, you can do this choosing Delete all – chimney stacks or 
Delete all – supports in the Edit menu.



THE CHIMNEY STACK DIALOG BOX AND THE SUPPORT DIALOG BOX

You open these dialog boxes by clicking with the right mouse button on  or 

 or by selecting Chimney stack... or Support... from the Options menu. You can modify an existing 
element by first selecting it and then double-clicking it with the left mouse button.

CHIMNEY STACK TYPE / SUPPORT TYPE

The text describing the type of chimney stack or support you have selected is displayed in this area. If you
modify an existing element using this dialog box, then the button for the element will be presented in 
addition as an option switch. In this case, you can change the type in the dialog box by clicking on the 
button, moving the mouse pointer onto the required type while holding down the left mouse button and 
then releasing the mouse button again.

DIMENSIONS
The options Width and Depth

The cross-sectional dimensions (width and depth) can be entered or later amended in these areas. 
Because supports are always symmetrical, only the thickness can be changed for these.

The option Height

This input defines the height of the chimney stack. By selecting the option to the ceiling, the height will 
be adjusted automatically to the story height.



STAIRCASES

ArCon provides the following staircase functions: single-flight staircases include the straight staircase, the
quarter-turn spiral staircase and the circular staircase, double-flight staircases include the L-landing 
staircase and the U-landing staircase. All staircases can be either solid or timber construction. After you 
have selected a staircase type and clicked on the requisite number of entry points, the associated dialog 
box for entering the values appears. 

DEFINE STAIRCASE TYPE

You will find the option switch for the staircase function  in the vertical toolbar. The button is an option 
switch, indicated by the black corner at the bottom right. 

After selecting a staircase and positioning the mouse in the data input area, a mouse pointer with a 
staircase contour appears, the size of which indicates the approximate size of the staircase. After you 
have positioned the staircase (click 3 times), ArCon automatically opens the dialog box for entering the 
staircase values.

To position the staircase you must provide three points. The first determines the position of the bottom 
step, the second the direction and length of the entrance flight and the third the direction and length of the
exit flight. The staircase will be calculated and displayed using these entry points.

STRAIGHT STAIRCASE

Supply the entry points in accordance with the following sketch. The values can be corrected in the dialog
box. The correction causes the entry points to be moved as shown below.

If the flight is lengthened or shortened, the position of the top step will be moved. Point 1 remains fixed. If 
the staircase width is changed, point 3 will be moved.

L-LANDING STAIRCASE

Supply the entry points in accordance with the following sketch. The values can be corrected in the dialog
box. The correction causes the entry points to be moved as shown below.

If you change the number of steps or the width of the entrance flight, the positions of the bottom and top 
steps will be moved. Point 2 (landing) remains fixed. If the staircase width is change, the staircase will 



move in the direction of point 3.

U-LANDING STAIRCASE

Supply the entry points in accordance with the following sketch. The values can be corrected in the dialog
box. The correction causes the entry points to be moved as shown below.

The landing depth is equal to the flight width of the staircase. If you change the flight width, then the 
landing depth will change automatically and therefore also the landing width in most cases. Movements 
take place in the direction of points 1 and 3. Point 2 (back of the landing) remains fixed. The number of 
steps for the entrance flight and exit flight can be set as required. The landing width can be altered 
independently of the flight width.

L-TURN STAIRCASE

Supply the entry points in accordance with the following sketch. The values can be corrected in the dialog
box. The correction causes the entry points to be moved as shown below.

The length of the entrance flight (L1) is kept at a fixed size with reference to point 2. If you enter a fixed 
step depth, the position of the top step (point 3) will be moved. On entering the exit flight length (L2), the 
appropriate top step position will be calculated and adjusted. If the staircase width is altered, the staircase
will be shifted in the direction of point 1.

CIRCULAR STAIRCASE

Supply the entry points in accordance with the following sketch. The values can be corrected in the dialog
box. The correction causes the entry points to be moved as shown below.



Starting point 1 is the only unalterable point. Otherwise you have a wide variety of alternatives for the 
circular staircase. The flight width is shifted to the inside, unless you change the external radius. By 
entering the angle of curvature you determine the direction of the entrance flight and the exit flight. A 
value of up to 360 degrees can be entered.



DELETE STAIRCASE

Mark the required staircase by activating the selection mode     with the left mouse button and then 
clicking on the staircase. The marked staircase will be displayed in red on the screen. It can be deleted by
pressing the Del key.

If a staircase is moved, the required opening in the ceiling of the current floor will be created 
automatically. If you now select a staircase, the opening will normally be selected first. By clicking once 
again, you will select the staircase instead of the opening. You can delete the opening and the staircase 
independently of one another.

If you wish to delete all staircases in the display, you can do this by choosing Delete all - Staircases in 
the Edit menu.



AUTOMATICALLY CREATED CEILING OPENINGS

If you have moved a staircase, ArCon automatically creates an opening in the ceiling of the current floor. 
You can edit this opening afterwards by dealing with it in the same way as you would for an opening 
created using the  button . 



DESCRIPTION OF THE STAIRCASE DIALOG BOXES

All staircase dialog boxes open automatically after you have entered the three points for insertion of the 
staircase. The values established on entry of the points are shown in the dialog box and can be changed 
here. You can alter an existing staircase by first selecting the staircase and then double-clicking with the 
left mouse button. All dimensions in the staircases dialog boxes use the unit cm, regardless of the 
General Settings in ArCon .

GEOMETRY
The flight width

For the straight staircase, the flight width is determined by the third entry point. For the other four 
staircase types, a standard value is initially used for the flight width. You enter the flight width required as 
a numeric value in the appropriate entry field of the dialog box.

The steps

Here you enter the required number of the steps or, in the case of double-flight staircases, the number of 
steps of the first and second flights.

The step depth

Here you enter the required step depth. Changes in the step depth result in changes in the staircase 
length (see sketch of the staircase type description ).



The landing width

In the case of double-flight staircases, the landing width is normally equal to the flight width. For a U-
landing, the value can be altered in the dialog box.

The external radius

The external radius of the circular staircase is calculated from the three entry points, however, it can be 
later changed to meet your requirements. Changes in the flight width have no influence on the external 
radius, only on the internal radius.

The angle of circumference

This determines the angle between the entrance flight and the exit flight.

The following three values are grayed out in the dialog box, as they are calculated from the upper 
dimensions.

The story height

The story height is the vertical height difference between the finished floor of one story and the finished 
floor of the story above.

The step height

This is the quotient resulting from the story height and the number of steps.

The step size

The step size or step size rule describes the step proportions of a staircase. The step size for staircases 
according to DIN 18065 is 59 to 65 cm, and results from the addition of two step heights and one step 
depth.

Optimal proportions

As the staircase is inserted using the dimentions exactly as given, it can happen that it runs at a very 
shallow or very steep angle. If required, the proportions of the staircase can be recalculated using the 
button Optimal proportions. This computation takes account of the step size rule as well as the 
minimum and maximum values for height and depth in accordance with DIN 18065. The length of the 
staircase will be recalculated using the optimal step sizes being strived for, whereby the dimensions can 
change depending on the staircase type .



BALUSTRADE

Using the first two check boxes you can select whether a balustrade is to be shown on the Right, Left or 
on both sides (both check boxes checked). The balustrade will normally be shown with rectangular-
section posts. If you check the box Round posts, ArCon will display round balustrade posts.

TEXTURES

This input field consists of three or four individual drop-down lists. If you wish to select different textures, 
click on Browse.... You are presented with a dialog box in which you can select a new texture.

The texture data for timber staircases includes information for the string, step and rungs, whereby the 
texture for the string will also be used for the handrail and the posts. 

For concrete staircases you can enter various textures for steps, covering, rungs and handrail, 
whereby the texture of the handrail will also be entered for the posts.



ROOF

With this command you have the possibility to place a gabled roof, a shed roof, a hip-roof, a false hip-roof 
or any combination of these roof types on any polygonal floor plan.

To place a roof on your floor plan, you should first create a create a roof story . If you put your roof on the 
same story, ArCon will continue the walls of the current story into the roof surface. 

Using the Roof settings   dialog box    , it is possible to make basic adjustments and to save these as 
default values. Three different types of input are available.

ACTIVATE ROOF FUNCTION

By clicking on the button  in the horizontal toolbar, the display of the roof is switched on and off in 
Construction Mode as well as in Design Mode. If no roof yet exists, this button is grayed out.

You will find the button for the roof function  in the vertical toolbar. To access the dialog box for 
changing the roof settings, click with the right mouse button on 

 ( dialog box ).
By saving using the Make default function in the dialog box, you can permanently store the values you 
use most frequently. These values are used as basic values, and are shown in the Roof editor after you 
have entered a roof polygon. You will then be able to change these values in the Roof editor.



SELECT ROOF INSERTION TYPE

After you have clicked on the button  in the left vertical toolbar, ArCon displays a selection of insertion 
possibilities in a second vertical toolbar (the “how” toolbar). 

 INSERTING A RECTANGULAR ROOF CONTOUR
Using this insertion type, you can insert a roof with a rectangular plan view regardless of the geometry of 
the floor plan. Two points on the screen must be clicked on which describe the diagonal. After the first 
click, the plan view of the roof will be displayed together with a “rubber band”. After the second click, the 
Roof editor    dialog box appears.

 AUTOMATIC INSERTION OF A ROOF CONTOUR
To insert a roof automatically, proceed as follows: after you have clicked on the appropriate button, point 
with the mouse pointer to the edge of the external wall which represents the roof shape you require. The 
roof shape appears on the screen as a red dotted line, and the moment you press the left mouse button, 
the Roof editor    dialog box appears

 INSERTING A ROOF AS A POLYGON
By entering the roof as a polygon, you have the possibility to freely design the shape of the roof, i.e., to 
depart from the existing wall structure. This method is needed if the outlines of the eaves and the floor 
plan are different, e.g., in the case of bays, dormer windows, above terraces, etc. 

To enter the polygon, click on the desired corner points in order. You end the input by pressing the Esc 
key or by clicking again on the starting point of the polygon.

If a roof with the same contour already exists, ArCon will inform you of this and you can cancel the 
operation.



DELETING A ROOF

Select the roof by clicking on     with the left mouse button and then clicking on the roof. The selected 
roof will be shown on the screen in red. On pressing the Del key the selected roof will be deleted.

Because ArCon always selects the smallest element positioned under the mouse pointer when using the
 button, it will frequently occur that you do not select the roof with the first click, but the floor and ceiling 

of a room, for example. In this case, simply continue to click until the roof is marked in red and then press 
the Del key. This also applies, by the way,, if you want to make changes to a roof.



ROOF SETTINGS DIALOG BOX

This dialog box is opened by clicking with the right mouse button on . General values for the roof frame
are to be found here which in this dialog box you can also save for use in other projects using the Make 
default option. Any values deviating from standard for individual roofs you change using the Roof editor .

In deviation to most dialog boxes in ArCon, this dialog box always uses the unit cm, regardless of the 
general project settings .

ROOF SURFACES
The options Angle, Overhang, Apron height and Eave height

Here you enter the numeric values for the slope of the roof, the roof overhang and the apron height. 
The eave height is calculated automatically from the supplied values for apron height and roof overhang, 
and is therefore grayed out in this input field. In the Roof editor dialog box    on the surfaces tab, it is 
possible for individual roof surfaces to make settings for the angles, overhangs and eave heights which 
differ from the standard settings made here.

Construction heights

The term roof construction includes the constructional elements (e.g. rafters) and the roof sub-
construction (e.g. battens, lining).

The roof covering includes everything that lies on top of the roof construction – shuttering, insulation, 
battens, roofing tiles. The information you are in the process of entering as preliminary values can later be
changed in the Roof editor dialog box    on the General tab.



a = Covering (shuttering, insulation, battens, tiles)

b = Constructional height (rafter thickness, shuttering, plasterboard)

ROOF SURROUND

In this area you can define the way in which eaves, ridges, valleys and verges are displayed.

Eaves

Here you define the way in which the eave section is displayed, whether without or with roof gutter, 
without or with cornice box. The display of the eaves can be changed on the Surrounds tab in the Roof
editor. The gutter diameter is initially set at a standard value, but it can be changed in the Roof editor on
the General tab.

Ridges/verges

Entries in the option fields allow you to choose whether the ridges and verges of your building are shown 
with ridge stones or with rectangular beams. 

The display with rectangular beams can be used for example when drawing winter gardens. If you click 
on this radio button, the input fields for width and height are no longer grayed out, and you can enter the 
dimensions as required. These settings can be changed again at any time on the Surrounds tab in the 
Roof editor.

TEXTURES 
This area consists of four single-line drop-down lists. If you choose a different texture for the covering, the
internal space, the cornice box or the rectangular beam, click on Browse.... You are presented with a 
dialog box, in which you select the texture. 

The textures for the covering and the internal space can also be changed on the surfaces tab in the Roof
editor, the textures for the cornice box and the rectangular beams on the General tab.

The Covering drop-down list

The upper surface of the roof will be displayed with the texture selected in this drop-down list. 

The Interior space drop-down list

If you look under the roof, the shuttering of the interior space will be displayed with the texture selected 
here.

The Cornice box drop-down list



If you have checked this check box, the cornice box and the open area in your drawing will be displayed 
with the texture selected here.

The Rectangular beams drop-down list

If you have checked this check box, the rectangular beams in your drawing will be displayed with the 
texture selected here.



ROOF EDITOR DIALOG BOX

You access the Roof editor dialog box after entering the final point when placing a new roof    or if you 
have clicked on the  button    and then double-clicked on a selected roof. 

In this dialog box you see three selection tabs at the top left: surfaces, Surrounds and General. When 
you click on a tab, the contents of the dialog box change and the fields belonging to the specific items as 
described above are displayed. You can switch between the different tabs as often as you like. 

Through the use of the Roof editor you can change the entire roof form by entering values for the 
individual roof surfaces different from the standard roof settings. You can insert gables, change the roof 
slope, alter the height of the eaves, thereby creating a false hip-roof, for example.

The Roof editor uses the unit cm for all dimensions. 

THE SURFACES TAB
Roof slope

ArCon provides four radio buttons for selecting the roof slope: gable end (90 degrees), slope 38 
degrees, slope 45 degrees and define slope.

When you choose the radio button define slope, the input field below it will be activated, in which you can 
enter the required slope (from 1-179 degrees).

Overhang

In this input field you can change the roof overhang, whereby the eave height of the roof remains 
constant.

Eave height

Here you change the eave height and thereby create gables or false hip-roofs, for example.

Apron height

If the eave height is changed in the upper field, the apron height of the building will also automatically 
change for these roof surfaces. This value is therefore shown here for information purposes, but is grayed
out.

Textures

In these drop-down lists, the texture for the roof covering and the interior of the entire roof can be 
changed. 

If you wish to choose a different texture for the covering or the interior, then click on Browse.... You are 
presented with a dialog box, in which you can select the texture. 



SURROUNDS TAB
Eaves

In these two check boxes you completely change the way in which the eave section is displayed, whether 
with gutter or without, whether with cornice box or without for the entire roof.

Ridges and verges

In these two data input areas you can change the type for ridges and verges by activating or deactivating 
the radio buttons. In both cases you can choose between ridge stones and rectangular beams. 

Rectangular cross-section

If in the above selection you chose the radio button for display with rectangular beam, here you enter the 
required width and height. Otherwise these values will be grayed out.

GENERAL TAB
Construction

In both of these input fields it is possible to change the predefined values for the roof settings for the 
entire roof. Construction refers to the constructional elements of the roof (e.g. the rafters) as well as the 
roof sub-construction (e.g. battens, lining). The Covering refers to everything that lies above the roof 
construction, such as shuttering, insulation, battens and roofing tiles.

Note: You can enter the value 0 for Construction. In this case, the roof will receive no interior structure.

Gutter diameter

The gutter diameter, which is initally set to a standard value, can be changed here.

Textures

The texture for the cornice box and the rectangular beams can be entered in these drop-down lists. If 
display of an element is not switched on , the associated drop-down list is grayed out. Textures are 
selected as described for textures on the surfaces tab.

Editing individual roof surfaces

To enable a specific roof surface to be edited, the possibility exists to address individual surfaces. Two 
buttons displaying arrows exist for this purpose, located above the preview window after the information 
Floor plan pages. Using these arrows you can swap between the roof surfaces from left to right by 
clicking on the corresponding arrow. 



If you have checked the check box Animated rotation, the arrow buttons cause the project to 
automatically rotate by 90o in the corresponding direction.

If the Show all details check box right above the preview window is unchecked, you can recognize which
is the current roof surface by the fact that the floor plan has a green background and the associated roof 
surface is shown with texture. In the case of gable-end walls, you will then only see the green floor plan 
page in the preview window. If you check the Show all details check box, ArCon will apply the texture to 
all roof surfaces in the preview window and will also display gutters, cornice box, ridges, valleys and 
verges in accordance with your entries.



FLOOR PANELS

Normally you don’t need to worry about laying ceilings yourself, as ArCon automatically recognizes when 
a room is enclosed and then inserts the appropriate ceiling itself. You have the possibility, however, to 
define floor panels yourself in order to construct a terrace, for example. For this, you use the  button in 
Construction Mode.

The floor panel to be inserted will always be inserted at the height at which other ceilings of the current 
story are situated. To enter a floor panel, you proceed as follows:

Fist select the floor panel with the  button. Following this, select one of the two input selections 

 or 
 from the “how” toolbar. You enter rectangular floor panels using the 
 button; input is analogous to inserting rectangular roof plan views .

Using the button  you insert floor panels with any desired contour. Insertion is identical with the 
definition of roof polygons . 

OPTIONS FOR FLOOR PANELS

· As for all elements inserted in Construction Mode there are two possibilities for setting the options for 
floor panels: Either by right-clicking on the button  or by selecting an existing floor panel using the 
button 

    and then double-clicking on the floor panel. You are then presented with the current Options-dialog 
box for this particular floor panel. Because this dialog box for floor panels is almost identical with the 
dialog box for floor and ceiling, it will be described in a separate section . 



CEILING OPENINGS

The  button exists in order to cut openings in automatically inserted ceilings and floors. Incidentally, 
such openings will be generated automatically when you place a staircase in the current story. After 
defining a staircase, the automatically generated opening is no different from an opening manually 
generated by clicking on this button. In contrast to all other elements in the Construction Mode, you 
cannot define properties for an opening. As a facing for the opening, ArCon uses the floor material from 
the upper surface of the unfinished floor to the upper surface of the finished floor, for the rest it uses the 
ceiling material.

Two possibilities exist for inserting a ceiling opening. Insertion as a rectangle  and insertion as a 
polygon 

. Both insertion possibilities are identical with the corresponding insertion possibilities for roofs. You will 
find a more detailed description in that place. .



FLOORS AND CEILINGS

FLOOR AND CEILING DIALOG BOX

You access this dialog box by choosing Floors/ceilings... from the Options menu. You can obtain the 
settings for an existing room by selecting the appropriate element and then double-clicking on it with the 
left mouse button. The dialog box applies in the same way also to the settings for floor panels. They differ 
in the number of tabs. Floor and Ceiling in the one case correspond with Lower surface, Upper surface 
and Edge ) in the other.

SURFACE
The option Color

If you want to paint your ceiling a simple color, click on the button Define.... A color palette will be 
displayed in which you can either choose from one of the basic colors offered or mix your own color 
together by selecting Define colors. 

The option Texture

The texture shown in the drop-down list will be applied to the element. If there is no suitable texture in the 
list, click on the button Browse.... You are presented with a standard dialog box in which you can choose 
a suitable texture from the entire texture catalog.

The option Mix color and texture

Use this option in order to be able to combine the settings made under Color and Texture. For example, if 
you choose black stripes on a white background and combine this with a blue color, then you will get 
black stripes on a blue background.

Texture sizes

For most textures, i.e., images (*.BMP files), the size is pre-defined in the texture catalog. If this is not the 
case, then the option Original size is grayed out. The standard value for a texture size is 100x100 cm, 
i.e., if you “paste” a certain texture on a surface 3 m long and 2 m wide, the texture will be displayed six 
times. If the texture is to appear only once on this surface, the settings for width and height of the texture
must be adjusted. If you click on the check box Original size, the original texture size will be re-instated. 

You can enter a value for rotation in the Rotation field. The texture will then be displayed with this rotation
angle. Using rotation, you have the possibility, for example, to lay the floor tilers in your bathroom 
diagonally. 



DEFINITION OF MATERIALS FOR FLOORS, CEILINGS AND FLOOR 
PANELS

You can enter the materials to be used for floors and ceilings and for floor panels in the following dialog 
box:

 Using these three (or two) tabs, you select the area for which you wish to determine the color and 
texture. Each tab has entry fields for color and texture, a check box Mix color and texture and an area 
Texture size. If for Color you click on the Define... button, you can change the color as required. 
However, this color will only be used if you select None in the Texture entry field or you check the check 
box Mix color and texture.

If you choose None for the texture, the color will be used as defined – if you select a texture of any kind 
and check Mix color and texture, the result will be a mixture of the color and the texture. The texture 
appears as it would if you viewed it through a glass color filter, whereby the color of the filter is the color 
selected. If you have not checked Mix color and texture, but you have selected a texture, the color 
information will be ignored. 

In the area Texture size you can enter information on how the texture on floors, ceilings or floor panel is 
to be “pasted”. If you check the check box Original size, the external measurements used for the texture 
will be those stored with the texture itself. 

Note: In the case of self-defined textures, it can happen that no original size – or an incorrect original size
– is entered. If non is entered, the check box Original size will be grayed out. The values defined in the 
areas width and height will then be used. If your self-defined texture contains size information which is 
unusable (for example, because the scanner cannot know how large the wallpaper from which you have 
made a scan really is) you can then deactivate Original size and enter your own width and height 
information for the texture.

And last, but not least, by entering a value for Rotation, you can cause the texture to be applied at an 
angle instead of being straight. This enables you to have diagonally laid tiles on the bathroom floor, for 
example. 

If you wish to permanently store the information entered in the dialog boxes, i.e., use them the next time 
you start ArCon, click on the button Make default.



LABELING

With the text function you can label your floor plans using various fonts, colors and text sizes. The options
are set up in the Text dialog box. 

Note that the labeling is linked to the current story . Therefore you can enter different labeling for the 
different stories. 

 LABELING ON/OFF
By clicking this button in the upper horizontal toolbar you have the possibility to turn the labeling on the 
screen on or off. Labeling must be switched on in order to enter text, as the button for text entry is 
otherwise grayed out.

 ENTERING TEXT
Click on a point on the screen at the position where text entry is to begin. ArCon opens a dialog box in 
which you enter the desired text. 

TEXT INPUT WINDOW

Here you enter the text. The text can be spaced over several lines by pressing Enter.

Beneath the text field you will find the button Define type.... If you click on this button, ArCon will open the
Type dialog box in which you can make the required settings.

You can pre-define the text type in advance for all new text entries by right-clicking on the button . A 
dialog box then appears in which you enter the text type. When you close the dialog box by clicking on 
OK, ArCon will ask if these settings are to be used as defaults. If you confirm this by clicking on OK, the 
settings made will be retained after exiting ArCon. 

MOVING LABELING

Select the text to be moved by clicking on     and then clicking on the text. The selected text will be 
marked red. After clicking again, the text can be moved to any position while holding down the mouse 
button. While the text is selected, you can turn it in 90-degree steps by right-clicking on it. 

DELETING LABELING

When you press the Del key, the selected text will be deleted. If you the wish to delete the entire labeling 
on the display, you can do this by choosing Delete all - Labeling in the Edit menu.



DIMENSIONS

With the dimensions function, you can apply both individual and series dimensions to your floor plans. 
You can define the selection criteria for this in the Dimensions dialog box . A special dialog box exists for 
series dimensions which you access by right-clicking on the “how” toolbar while entering the dimensions.

 DIMENSIONS ON/OFF
By clicking this button in the upper horizontal toolbar you have the possibility to switch the display of 
dimensions on the screen on or off. Dimensions must be switched on for the entry of dimensions to be 
possible, as the button on the left vertical toolbar is otherwise grayed out.



 SELECT DIMENSIONS DISPLAY
Using this option switch you can place the dimensions above, below or in the center of the dimension line 
and select either strokes or circles to mark the ends of the dimension lines. Information on the individual 
types is shown at the bottom left of the screen. In the second vertical toolbar you can now select between 
the two different types of dimension.

 INDIVIDUAL DIMENSIONS
For these you need three entry points. The start and end positions of the measurement line and the 
position relative to the item to be measured. Assistance for positioning on the screen will be provided by a
red cross. Check that the required snapping options    have been set.

 CATENATED DIMENSIONING
For this type of dimensioning, ArCon takes into consideration all guides, axes, edges and openings that 
are checked in the dialog box which appears upon right-clicking on the “how” toolbar when dimensioning 
entry is selected.

With the first two entry points you defined an axis through the floor plan. All activated points of intersection
that lie on this axis are included in the dimensions series. The third entry point describes the exact 
position of the measurement line, as for individual dimensions.



MOVING THE POSITION OF THE DIMENSION LINE

Select the dimension line to be moved by clicking on     with the left mouse button and then clicking on 
the dimension line. The dimension line is marked red. A selected dimension line can be “grabbed” and 
moved at three points.

· Click near to the dimension line itself. In this way, you can move the dimension line in parallel.

· The two points between which the actual dimensions are to be made, i.e., the two points entered first 
when entering the dimensions, can be later moved. For this purpose, two red squares are used to 
mark these points. If you position the mouse pointer on these squares, You will be able to move them. 
Note that when a dimension is moved, the measured value is adjusted automatically. In general, 
dimensioning will be moved automatically if the element on which the dimension line “hangs”, is also 
moved. 

DELETING DIMENSIONS

Select the dimensioning to be deleted as described above. When the Del key is pressed, the selected 
object will be deleted. If you wish to delete all dimensioning in the display, you can do this by choosing 
Delete all - dimensioning in the Edit menu.



DIMENSIONING DIALOG BOX

The dialog box is opened by clicking with the right mouse button on the button  or by choosing 
Dimensions... in the Options menu. 

You can also open this dialog box by double-clicking on an existing measurement. You are then able to 
change the settings for this dimension.

NUMBER OF DECIMAL PLACES

Three radio buttons are provided allowing you to select either one, two or three places of decimal.

DIMENSIONING OPTIONS DIALOG BOX

You access this dialog box by right-clicking one of the buttons  or 

 in the “how” toolbar. 
In the dialog box you enter which intersections with constructional elements are to be used when inserting
series dimensions. This can include intersections with guides, wall axes, wall faces or openings and floor 
panels.



WORKING IN DESIGN MODE
In ArCon’s Design Mode you furnish your home. For this purpose, in addition to the upper horizontal 
toolbar, you are provided with a second horizontal toolbar with which you can make specific settings for 
the current window, as well as a vertical toolbar with which you can perform certain actions on selected 
objects. In the following section we begin by describing all buttons on the second toolbar. The condition of
these buttons applies to the current window. Therefore, if you are working with several windows, the 
buttons can change when switching between two windows. It is thus possible, for example, to work in the 
top view in one window and at the same time to work in the perspective view in another. When objects are
changed, they are updated in all windows which enables you, for example, to check directly in the 
perspective view the results of an action carried out in the 2D view. 

If you have furnished your home in the Design Mode and then change back to the Construction Mode to 
make additions or modifications, by clicking on  you can switch the display of the furnishings on or off.



VIEWS

In Design Mode you have three different ways of displaying your plan. These are the 2D view , the top 
view 

 and the perspective view 
. If you are working with several windows at the same time, you can choose different views in each of 

the different windows.



 PLAN VIEW

The appearance of the plan view differs only in a few details from that shown in Construction Mode . Here
you can see all walls and constructional elements as if you were in the construction view. The only 
difference: the elements of the current story are also grayed out, as you cannot alter them in Design 
Mode. On the other hand, elements of furniture are shown as line drawings in black. In contrast to the two
other types of view, selected objects in the plan view are marked with a red rectangle. In the other two 
view types, marking of selected items is done using the selection frame. This view type is highly suited to 
line objects up with one another or to enable them to be accurately positioned. Naturally, height 
positioning of objects is somewhat more difficult in this respect. However, because objects automatically 
fall downwards, in most cases you do not need to worry about the height.

If you wish to furnish you home, you should not “forget” that these views exist. Sometimes it is easier to 
work in this view type than in the perspective, for example. 



 TOP VIEW

In the top view you see the same thing as in the plan view, except that everything is in color, i.e. you see 
all surface properties of floors and furnishing items. In the top view, only ever the current story is 
displayed. Contrasting to the plan view, the top view is a three-dimensional view, even if you can’t see the
third dimension (the height) directly. You can, however, when placing objects enter the height using the 
right mouse button. This display type provides the advantages of the plan view combined with the 
possibility to place objects in terms of height, although this is not very easy. In most cases you will merely 
notice that an object disappears under a table, for example, when you move it. This is an indication that 
the object is placed at an incorrect height. 

In contrast to the plan view, the top view can also be calculated using ray tracing . 



 PERSPECTIVE VIEW

The perspective view is the view in ArCon. In this view you can the walk around the building, place 
objects at will and just “do your own thing”. The perspective view has the advantage that you here it is 
easily possible to enter object heights and that in this view you obtain a very good spatial impression of 
your home. However, it does have the disadvantage that placing objects in terms of depth is somewhat 
more difficult, so that this is better done in the top view or in the plan view. The perspective view is the 
only view type in which you can wander through your home. For this purpose, and only in the perspective 
view, the     button appears in the second horizontal toolbar. As also in the top view, calculations of 
shadows etc. with the help of the ray tracing    can also be performed in the perspective view.



 SELECT VIEW TYPE
With this option switch you select one of four different view types in which your project is to appear in the 
view window. The button appears only in the view types top view and perspective view. This button does 
not appear in the plan view.

The view function includes an option switch indicated by the black corner at the bottom right in the button.
By dragging the mouse with the left mouse button pressed into the view window, you can select the 
required view type in the sub-menu displayed by moving the mouse pointer to one of the view types and 
then releasing the mouse button. Information on the individual view types is shown in the status line at the
bottom of the screen. The required view type then appears in the button the toolbar.

After you have selected a view type, the view will be modified immediately in your current window. The 
various view types are briefly described in the following.



DISPLAY AS WIRE MODEL

This view type shows only the contours of the item and the contours of walls, windows and doors. The 
colors for these contours correspond approximately to those of the object being displayed. For example, if
you have a blue sofa as wire model, then its contours will be seen as blue lines.

For generally working on your project, the wire model is the fastest of the four view types.



DISPLAY IN COLOR WITHOUT TEXTURE

In this view type, the program uses a uniform color for every surface. If a texture has been applied to the 
surface (catalog ), then the color it will be given will be the average value of all texture colors on its 
surface. For example, if you have displayed a blue sofa with a light- and dark-blue pattern, the surfaces of
the sofa will be shown in a uniform mid-blue color.

The view type Colored without texture is a little slower than the wire model, but considerably faster 
than the type Colored with texture.



DISPLAY COLORED WITH TEXTURE (AVERAGE QUALITY) AND 
COLORED WITHOUT TEXTURE (HIGH QUALITY)
These two view types show the object with its defined textures. The blue sofa in this case would be 
shown with the light- and dark-blue pattern. 

Using these colored view types you can produce views which come as close as possible to reality.

One difference is to be found in the quality of the two view types. In this way, the colors on large wall 
surfaces in Colored with texture (average quality) may not be evenly distributed, whereas no difference
is found with the objects. However, this difference will only become noticeable if you have switched to 
night view by clicking on  .

A further difference is in the display speed, whereby the latter types cannot be as fast as the two types 
mentioned first on account of the high to extremely high computational power required. If you are using an
MMX computer , there will be no difference in display speed between the two view types Colored with 
texture (high quality) and Colored with texture (average quality). In this case, you should in any case 
use the view type Colored with texture (high quality), to achieve the best possible quality for your 
views.



 RAY TRACING
Try not to be put off by the terminology. Ray tracing in ArCon basically means clicking on a button and 
waiting for the results. Before going into detail, first a few introductory words on the subject of ray tracing.

Ray tracing is a method with which the lighting conditions in a scene can be fairly accurately simulated on
the computer. In contrast to the “normal” illumination and representation in ArCon, here you can also 
simulate shadows, reflection and refraction. The disadvantage of ray tracing compared with the “normal” 
representation is the considerably greater computational time required. Whereas the normal display is so 
fast that you can walk around your home in an almost seamless series of images, the calculations 
required for a ray tracing-image can take several minutes or even hours. However, the highly realistic 
representation of the scene more than makes up for this disadvantage. 

Because ray tracing simulated the lighting effects very precisely, the placing and brightness of the light 
sources in the scene play a very important role. Just as for normal photography, you can create special 
atmospheric effects through the positioning of light sources. But you can also over- or underexpose your 
image by using too few or too many light sources, or lighting that is too bright or too weak. This requires a
certain amount of experience to get it right, but you will quickly gain this experience thanks to ArCon’s 
simple operation. Don’t be afraid when producing a ray tracing image to site lamps in positions where you
may not otherwise need them – this is exactly what the photographer does in the studio in order to 
improve the overall effect of a scene. 

OVER- AND UNDER-ILLUMINATION IN ARCON
In normal photography, if you are not careful, you can easily over- or underexpose a scene. To prevent 
this from happening in ArCon, you should observe the following notes: for technical reasons, ArCon will 
not display textured surfaces brighter than the brightness of the original texture. Therefore, if you use a 
mid-gray texture, you will never see these textured surfaces brighter than mid-gray – regardless of the 
number of light sources you use in your scene. If you then place a chair on this mid-gray surface, it may 
happen that in spite of “removing” the light sources from which the chair casts shadows, the surface is 
still over-illuminated. What then happens is that you do not see the shadows, as the surface is still over-
illuminated, also in the shadows. To avoid this effect, proceed as follows.

In the normal view, right-click on the button . The brightness control that appears in the following dialog 
box must now be adjusted so that the scene at the current level of illumination just begins to get darker. 
For the gray surface given as an example, this means that it just starts to become a slightly darker shade 
of gray. It is easy to make the fine adjustment using the preview button. When you close the dialog box by
clicking on OK, you can assume that the illumination conditions are now optimally set. Now start the ray 
tracer by clicking on the button 

and you will also see the expected shadows on the gray surface. 

RAY TRACING ITSELF

After you have set up the optimal illumination for your scene and click on the button , ArCon will start by
producing a rough ray tracing computation of the scene followed by a series of calculations increasing in 
detail. This step-by-step approach to producing an accurate result has the advantage that you can 
interrupt the ray tracing procedure at an early stage in order to adjust the brightness setting or to re-
position the objects in your scene. If you are satisfied with the result, just wait until the image has been 
calculated completely. Depending on the resolution and complexity of the scene, this can take anything 
from a few seconds to several hours. By complexity of the scene we mean the number of light sources 
and objects you use, and particularly the number of these objects that are transparent or reflective with 



reference to the visible surface of your image. 

Moreover, surfaces that require very high computational times are those which are illuminated by very 
many light sources and do not lie in the shadows. 



SPECIAL SETTINGS FOR RAY TRACING

Apart from the settings for light sources mentioned above, you also have the possibility to make certain 
other settings for ray tracing. These are made in the dialog box which you obtain after right-clicking on the

 button. 

This is divided into the two options Ray tracing and Pure Phong shading, whereby ray tracing has 
several sub-areas. Phong shading is a term derived from computer graphics which was introduced in the 
seventies by a man named Bui Tuong Phong. It is in principle the same as ray tracing with regard to the 
computation of illumination, however it does not take into consideration such effects as shadows, 
reflections or refraction. In contrast to the normal representation, with Phong shading, illumination 
calculations are performed for every pixel that you see on the screen. 

In the normal screen representation, which uses so-called Gouraud shading, the illumination conditions 
are only calculated at the corners of a surface and then uniformly distributed over the surface. The 
mathematician would refer to this as bilinear interpolation. This uniform distribution of Gouraud shading 
has the disadvantage that lighting effects which occur within a surface are incorrectly displayed. 
Therefore, if you place a lamp on a relatively large floor consisting of only one single surface, the lighting 
conditions will only be calculated at the four corners of the surface and the bright spot under the lamp in 
the middle of the surface cannot be seen. Phong shading, however, computes the lighting conditions for 
every pixel, with the results that you will be able to see the bright spot. 

The advantage of Phong shading compared with Gouraud shading is therefore the improved computation 
of the illumination distribution. The disadvantage compared with ray tracing is that shadows, reflections 
and refraction are not taken into consideration. Pure Phong shading requires less computational time than
ray tracing, but more than for the normal display using Gouraud shading. 

If you choose ray tracing in the dialog box, you have the further possibility to choose ray tracing with 
shadows, with reflections and/or with refraction. You can switch off each the individual types to achieve 
special effects or simply to reduce computation time. 

As already mentioned in the introduction to ray tracing, calculations for shadows or for surfaces which do 
not lie in the shadows and are illuminated by many lamps are very demanding on computing power. To 
keep computation times to a minimum, we have included two different methods for the computation of 
shadows that you can use. The first is the exact computation of shadows, the second is not quite exact – 
but considerably faster. The important difference between these two is that in the faster version no check 
is made on whether the walls of a room cast shadows in this room. This is normally correct: If you imagine
a rectangular room; you will never see shadows of the walls in the room itself. 

However, this can lead to errors if the room is L-shaped, for example. If a lamp is situated in one leg of 
the L, a real possibility exists that a wall in the other leg of the L will cast shadows. If you choose fast for 
the computation of shadows, you will not see these shadows – if you choose exact, you will see them. 



RAY TRACING OF ILLUMINATION SWITCHED ON OR OFF

In ArCon, by clicking on the button     you have the possibility to switch the lights in your scene on, or to 
select standard daylight illumination. This daylight illumination corresponds with sunlight. A scene in real 
life is illuminated during the day through light from the window; in spite of this, you will not see a sharp 
outline of the light from the window on your walls, but there will be an overall brightness in the whole 
room. 

This effect of indirect illumination, which results from the fact that the light entering through the window is 
scattered back and forth from the individual surfaces in your scene and, in the final result, illuminates the 
whole scene, is very difficult to simulate with ray tracing. Although methods do exist, such as so-called 
radiosity, with which such effects can be realistically simulated, these methods are very demanding on 
memory and computational power – for this reason they have not (yet) been implemented in this version 
of ArCon. 

For you this means that the brightness of a scene is brought about only by means of direct illumination 
through light sources. In the case of daylight illumination, you would therefore only see a bright spot in the
room, i.e., the spot directly illuminated by “the sun”. This is, of course, very unsatisfactory, as you would 
like to see the rest of the scene as well. For this reason we have simply taken steps to prevent the walls 
from casting shadows during computation of ray tracing scenes, so that the sun shines seeming 
unobstructed through the walls (and also through the windows and doors, by the way). However, this 
does not mean that your furniture cannot cast shadows on walls or on other items of furniture. The best 
thing is if you experiment a little with ray tracing in the day view. 



RAY TRACING-SAVING AND PRINTING IMAGES

Starting on    you will find a general description of the procedure to be followed if you wish to save an 
image or print it. As a reminder: you enter in the appropriate options dialog box whether the image is to be
computed using ray tracing. Therefore, if you save an image and have selected Ray tracing for this, the 
ray tracer will be activated for saving the image to allow the image to be computed. 

Depending on the other options entered for the saving, such as Dimensions, Oversampling, etc., it can 
sometimes take a very long time before the result is actually saved, as the image must be computed 
again for saving. Therefore, if you have chosen a resolution of 2000 x 1500 pixels, added to this 16 times 
oversampling and then also ray tracing, then you can probably forget about using your computer for next 
weekend. So when you say ray tracer, you should first think carefully about the settings you make. 

If you need a fairly high resolution for a high quality printout, we recommend the following settings: 
resolution ca. 1500 x 1500, depending on the edge ratio of the image, 4 times oversampling and edge 
filter. On a 90 MHz Pentium and a scene of normal complexity, you can expect to use the result the next 
morning if you start the save the evening before. 



 WALKING AROUND PROJECTS
By clicking  in the perspective view    of Design Mode, the Walkabout function is activated. In the view 
is then no longer the normal mouse pointer, but, depending on the position in the view window, a mouse 
pointer in the form of

Direction arrows, (e.g.  ), when you walk,

or rotation symbols (e.g.  ), if you are turning round on the spot.

The arrows indicate the direction you are going in. You begin your tour by pressing the left mouse button.

Depending on the position of the mouse pointer, you can move in the following directions:

• forwards and backwards 

• to the left and to the right

• to the front left and to the front right

• turn left and turn right

When you press the left mouse button within this view, you begin to walk around your project. The speed 
at which you carry out the tour depends on the position of the mouse pointer in the view window. The 
closer the mouse pointer gets to the center of the window, the slower you will move. At the center of your 
project, the mouse pointer is replaced by the following symbol:

If while holding down the left mouse button you move towards an edge of your view window, you will walk 
through your project, the closer you get to the edge the faster you will get. If the mouse pointer 
approaches the upper edge of your view window, for example, your movement will become faster and 
faster. This applies equally to all other directions. 
You obtain a further increase in speed if, in addition to the possibilities described above, you press the 
Ctrl key. You will become even faster if you press the Ctrl+Shift keys together. If you release the left 
mouse button, you will remain stationary at the current position in your project. If you press the mouse 
button again, your tour will continue. The Walkabout function is terminated by clicking any toolbar button 
and the button will automatically return to the non-depressed position.

Using the Walkabout function requires a little practice which you can best obtain by walking around a 
simple room.

The view type of your project (e.g., as wire-frame model or colored without texture) during walkabouts can
be selected in the General settings dialog box. You access this dialog box by choosing Program - 
General... in the Options menu.



BRIGHTNESS
 DAY AND NIGHT VIEW

This function is only active in the top view    and in the perspective view    and when at the same time you 
are in one of the colored view types .

By clicking with the left mouse button on the  button, you can switch between day and night view. 
During the day, your project will be illuminated at a pre-defined brightness which you can set in the 
Brightness dialog box  . In the day view, lamps in the project have no influence on the brightness of the 
view.

On the other hand, in the night view, your project can only be illuminated by lamps that are accessible and
which are also switched on . All rooms in which no light sources are present will appear dark.



BRIGHTNESS DIALOG BOX

You obtain this dialog box by clicking with the right mouse button on the  button or by choosing 
Brightness... from the Options menu.

THE SLIDE CONTROL

With this slide control you can adjust the numeric value for brightness by dragging the control, and thus 
set the intensity of illumination for your project either darker (<1.0) or brighter (>1.0).

The current setting will be shown at the input field at the bottom left, where the value can also be entered 
directly via the keyboard. If the numeric value is less than 1, your project will be appear increasingly 
darker as the value gets less.

You can check the light intensity entered by clicking on the Preview button. The values entered will then 
be accepted directly and transferred to the project.



 ONE STORY UP  OR 
 DOWN (“ELEVATOR”)
 ONE STORY UP

When you click on this button, you move the view of your project up by one story. By pressing the Ctrl 
key, your project will be moved dynamically when you click on .

This button is only present in the perspective view. In the other view types  it is not included .

 ONE STORY DOWN
When you click on this button, you move the view of your project down by one story. By pressing the Ctrl 
key, your project will be moved dynamically when you click on .

This button is only present in the view type perspective . It is not included in the other view types.



ADJUSTING THE PERSPECTIVE VIEW

Two possibilities exist in the perspective view to change the position of the observer and the point towards
which the observer is looking. One of these is the Walkabout  , in which you change your position in a 
sort of interactive way; the other is to make the adjustment via the following dialog box.

You obtain this dialog box by right-clicking on the Observation button . The appropriate settings are 
made in the three areas of the dialog box Position of the observer, Viewpoint and other information. 
The Position of the observer and the viewpoint can be defined with the mouse by clicking on the relevant 
button. After this, the dialog box disappears briefly and you can select both positions with the aid of the 
3D mouse.

In contrast to the x- and y co-ordinates, you can also enter the numeric height of the observer or of the 
viewpoint. For this, you can either enter the height relative to the floor, or even the absolute height. Input 
to Height above floor is only possible if the position of the observer or of the viewpoint is in a room – 
otherwise this field is grayed out. 

OTHER DATA

In the area other information you can also change the Head inclination and the Field of view. Head 
inclination corresponds in principle to a nodding of the head on the part of the observer. For this you can 
either use the slide control or enter a numeric value in the field. Note that when using head inclination, the
height of the viewpoint changes, as you are then looking further up or further down. 

Changing the Field of view corresponds in principle to changing the lens on a camera. You can choose 
between wide-angle and telephoto views of any desired value – whereby narrow corresponds to a 
telephoto lens, wide to a wide-angle lens. You can also enter the field of view directly in degrees, i.e., a 
numeric value.

Last, but not least, you can also adjust the visible depth of field. For technical reasons, ArCon cannot 
display everything that lies before the observer in the perspective view; the depth of field is limited. If you 
choose Automatically determine visible depth of field, ArCon will set the values such that you can 
generally see your complete plan – i.e., everything that begins in front of you and reaching up to the end 
of the plan. However, if you choose Use the following values for visible depth of field, you can define 
the visible range from and up to which your plan can be seen by the observer. You can thus cut “slices” 
out of your plan which you then see – everything before and after this is invisible. To check the data 
entered, you can click on the Preview button before you close the dialog by clicking on OK. 

Note: While you are defining the position of the observer or the viewpoint with the mouse, you can cancel
the input by pressing the Esc key. The dialog box will then re-appear; but the position of the observer and
of the viewpoint will not have changed. 



 VIEWING
Using this button it is possible to view your project from all sides in the three different views of the Design 
Mode .

The function of this button is very different from the others, which you can either click on or press down. 
The difference lies in the position on which you press them. If you press the button at the left side, the left 
arrow will turn red. This applies also to pressing the right, up and down arrows.

In the perspective view, the image changes such that you are always looking at the same point, however 
you are moving in accordance with the arrow button pressed. In the plan view and top view, actuating this 
switch causes your view to “scroll”.

The viewpoint from which you wish to look at your project can be defined in the Viewing dialog box and 
changed again at any time. You obtain this dialog box by clicking with the right mouse button on  or by 
choosing Viewing... from the Options menu. 



 THE TEXTURES AND OBJECTS CATALOG
In ArCon’s Design Mode, you have a large number of materials, textures and objects at your disposal 
which cover the whole area of furnishing, e.g. for the bathroom or kitchen. To assist in the management of
this large number of textures and objects, they have been grouped together and arranged in a Textures 
and Objects Catalog.

The Textures and Objects Catalog is activated or deactivated by clicking on  or by choosing Textures 
and Objects Catalog in the View menu.

The Textures and Objects Catalog is in its form and function very similar to the Windows 95 Explorer.

The Catalog can be positioned anywhere on the screen as an independent window, separately from 
ArCon’s main window, or it can be “docked” in ArCon’s main window. You switch between these two 
possibilities by choosing Dock catalog in window in the View menu. If the Catalog is “docked” in the 
main window, you can choose the position for the Catalog at the left, right, upper or lower edge of the 
main ArCon window by moving its title bar. 

The functions of the Textures and Objects Catalogs will be described briefly in the following.



AREAS OF THE TEXTURES AND OBJECTS CATALOG

TITLE BAR

This displays the name of the application (Catalog). The title bar also contains the usual Windows 95 
facilities 

· for minimizing

· for maximizing and closing.

MENU BAR

The menu bar contains the menus

· Catalog, View and Help. Catalog allows selection of the individual index catalogs for objects, textures, 
loaded textures and materials, to then transfer these into the Catalog.

· The menu item View is provided for switching the toolbar and the Detail List on and off. With the latter 
you are given more detailed information on the objects or textures, e.g. manufacturer, article number., 
price and filename of the object.

· You can obtain specific information on the various items via Help.

TOOLBAR

If the toolbar is switched on, you can execute the menu bar commands directly by clicking with the left 
mouse button on the appropriate toolbar button.

DIRECTORY TREE

In the left column of the Textures and Objects Catalog below the menu bar is the Directory tree, 
containing the directory structures used by ArCon, in which the Catalogs of objects, textures and 
materials are arranged.

Note: When you see the Catalog for the first time – after starting ArCon – the directory tree is 
“minimized”. Thus you see very little of it. To enlarge the area, drag the thin bar next to the toolbar to the 
right while holding down the left mouse button. In this way you are free to set the partition between the 
directory tree and the contents area according to your requirements.

With the button  you move to the next higher folder in the directory structure.

CONTENTS AREA

In the right column is the Contents area, in which the contents of the current textures and objects folder 
are displayed.

ArCon automatically saves all size information of the Textures and Objects Catalog on exiting from the 
program, so that when you restart ArCon, the Catalog appears in the same position and there is no need 
for you to move it around each time.



You have the possibility to store groups of objects, such as a complete dining room suite, in the Textures 
and Objects Catalog as a user-defined group, in order to define your own furniture catalogs.



OBJECTS IN THE CATALOG
ArCon provides a large stock of furnishings for your home. This comprises of more than 1,.000 objects, 
such as bathroom, kitchen and living room furniture. To assist in the management of this large number of 
objects, they have been grouped together and arranged in the Objects directory of the Textures and 
Objects Catalog.

This directory consists of several sub-directories, the Object catalogs (e.g. bathroom, kitchen, living room,
etc.), which in turn also contain catalogs or individual objects (e.g. cupboards, tables, chairs). 

These Object catalogs and individual objects are illustrated as graphics in the contents area of the 
Catalog, giving you an optical impression of the objects to be placed. Catalogs appear on a yellow 
background, objects - i.e., the items you can place - on a gray background.



LOADING OBJECTS

By clicking with the left mouse button on the Objects directory, the directory tree of the Catalog displays 
all sub-directories, such as hall, bathroom, office, etc., and loads these into the contents area. In the 
directory tree you open the sub-directories by clicking with the left mouse button, while in the contents 
area of the Catalog you open these folders by double-clicking on them.

If any other sub-directories (e.g. in the case of Office the folders Desk, Chair, Cupboard etc.) exist, open 
these in order for the Catalog to display the individual objects in this folder. If a sub-directory contains a 
large number of individual objects, a dialog box will appear in which the current list of loaded objects is 
displayed and constantly updated.

To prevent all individual objects from loading, you can terminate the loading operation by clicking on 
Cancel. The contents area of the Catalog will show only the objects that have already been loaded.

With the button  you move to the next higher folder in the directory structure. You change to the last-
used object folder by clicking on the 

 button or via the menu bar, in which you choose the Objects command.
Via the button  Details, the Catalog displays the object folder and the individual objects as small 
preview windows in the contents area. You can obtain further information on the individual objects with 
regard to manufacture, article number, price and filename.

The current version of ArCon contains no manufacturer-specific objects, but “fantasy furniture”. For this 
reason, the information on manufacturer, article number and price is currently “Unknown”. In the case of 
manufacturer-specific additional modules for ArCon, the corresponding information will be filled with real 
values. 



SELECT OBJECTS

An individual object in an open folder in the contents area is selected by clicking on it with the left mouse 
button. This object will then be highlighted in color to differentiate it from the other objects in this folder. 

Just as textures can be dragged from the Catalog into your view using drag and drop, using drag and 
drop you can also drag objects into an ArCon view. The precise way in which objects are then placed in 
the view is described in the section placing objects and groups.

OBJECT VIEWER DIALOG BOX

You obtain this dialog box by double-clicking on an object (here, for example, the “Laptop”) in the 
contents area of the Catalog. The dialog box is split into two main areas. 

In the upper area, information is provided on the Manufacturer, Order No. and Price for the current object.
This area is currently not used by ArCon. In further versions, complete manufacturers’ catalogs with all 
necessary information will be displayed in the dialog box. ArCon then will use information from dealer 
catalogs further in order to produce order lists or price lists for the objects placed in a project.

In the lower area is the preview window, in which you can view the selected object from all sides, 
enlarged or reduced, however you wish. 

In addition to these functions, in ArCon you also have the possibility to produce user-defined groups of 
objects which reoccur. For example, you can define a dining room suite consisting of six chairs, an oval 
table with table decoration and a matching ceiling lamp as an object group “Dining room” and store it in 
the Catalog using drag and drop. This swaps around the “source” and the “target”: the current view is the 
source of the group – the Catalog the target.

Loading such object groups from the Catalog is performed in the same way as loading the individual 
objects. Saving user-defined groups ...



TEXTURES IN THE CATALOG
The textures in the Textures and Objects Catalog    used in ArCon are surface structures such as carpets, 
wallpapers, etc. Textures can be understood on the one hand to be the appearance of textile materials 
(e.g. as used in the manufacture of furniture) or similar coverings, and on the other hand (in the case of 
computer graphics), images which are “pasted” onto three-dimensional objects. Using these images, 
structures can be simulated which are akin to natural structures. 

The use of textures has a particular significance in ArCon. They allow the creation of a high degree of 
reality, but without the geometry of the objects becoming too complex.

All these textures are stored in the directory textures of the Catalog and are displayed in the contents 
area.

With textures you can design and change the surface structures of your project at the flick of the wrist. 
You can lay carpets or wood block on your floors, paper or panel your walls and ceilings, fit doors and 
windows of spruce or pine, choose curtains in a wide variety of fabrics and colors to match your furniture. 
There are no limits on your freedom as a designer. You can switch and swap textures to your heart’s 
content.

If the textures offered by ArCon are not enough for you, you of course have the possibility to produce your
own textures. The format of these textures (images) is that of Windows bitmap files (BMP files), which you
can create using Photoshop or any other Windows drawing program. such as Paint.

Loading, Selecting, Swapping and Placing textures will be described briefly in the following.



LOADING TEXTURES

By clicking with the left mouse button on the textures folder or on the  button on the toolbar, the entire 
texture directory will be loaded into the contents area of the Catalog. The various textures are sorted in 
various separate sub-directories. Therefore, before you actually see the textures, you must first choose a 
corresponding sub-directory. 

Note: As for the object sub-directories, the texture-sub-directories are also displayed in the form of a 
picture. 

If you are loading a large number of textures from a directory, a dialog box will appear in which the current
list of loaded textures is displayed. To prevent all individual textures from loading, you can terminate the 
loading operation by clicking on Cancel. The contents area of the Catalog will show only the textures that 
have already been loaded.

Via the button  loaded textures, the Catalog only shows the textures that you are already using or have
once used in your project. This has the advantage that you are not always forced to load the entire texture
catalog. In the loaded textures there is a “special texture” with which you can delete textures used in 
your project. This Deletion texture is applied just as you would apply any other texture.

Via the Details button, the Catalog displays the textures in the contents area of the Catalog as small 
preview windows and also provides you with further information, such as the width and height the 
textures.

SELECTING TEXTURES

When one of the texture catalogs has been opened and loaded in the Catalog, you choose a texture by 
clicking on it with the left mouse button. The chosen texture after being selected is highlighted in color to 
differentiate it from the other textures in the contents area of the Catalog.

APPLYING AND REPLACING TEXTURES

With the left mouse button pressed, drag the selected texture into the view window of your project. If the 
mouse pointer is situated above an area in which a texture can be applied or replaced (e.g. a wall), the 
mouse pointer changes its appearance to indicate “textures can be applied or replaced here”. 

On releasing the mouse button, the corresponding surface of the wall will change and you have, for 
example, redecorated the wall. In this way you can completely alter the appearance of your entire project.
This procedure of applying and replacing textures can be applied equally to almost all areas and objects 
in your project. For example, you can also change the covering material of your armchairs and sofas in 
this way.

However, there are also objects for which it is not possible to apply or replace textures. This was planned 
in this way in the construction.

DELETING TEXTURES



You delete existing textures by dragging the Delete texture from the loaded textures over the object. In 
this operation, the texture is not replaced by a new one, but deleted.



USER-DEFINED TEXTURES

You can transfer your own images to ArCon to be use as textures. The following should be observed in 
this respect: 

· Textures are stored internally with a maximum resolution of 256 x 256 pixels. So even if you load 
images which have a higher resolution, these will first be re-computed for reduction to this lower 
resolution.

· Textures are stored in the program using color index. This means that 8 bits will be used for each pixel 
of a texture. If you load a TrueColor image, it will first be converted to an 8-bit color index image.

· In ArCon it is not possible to load compressed Windows bitmap files. Attempting this could lead to an 
appropriate error message being displayed.

· Your PC has a limited amount of memory. If you use very many textures, it is possible that you will not 
have enough memory or that Windows will swap part of the program to the hard disk (in a swap file).



MATERIALS IN THE CATALOG

By assigning material characteristics, you have the possibility to define certain texture structures and 
properties for your objects. This enable you to alter gloss effects and reflections which crop up in the 
views, particularly in the case of ray tracing .

LOADING MATERIALS

By clicking with the left mouse button on the Materials folder, the  button on the toolbar or via the 
Materials Menu bar-  you load the entire materials index into the contents area of the Catalog. 

SELECTING AND APPLYING MATERIALS

You choose a material by clicking on it with the left mouse button in the contents area of the Catalog. The 
chosen material after being selected is highlighted in color to differentiate it from the other materials.

With the left mouse button pressed, drag the selected material into the view window of your project. If the 
mouse pointer has reached an area in which a material can be applied or replaced, the mouse pointer 
changes its appearance to indicate “materials can be applied or replaced here”. 

On releasing the mouse button, the surface properties of the object will change. This has now been 
assigned to a material.

In contrast to textures, which you can apply differently for all objects in your scene, when materials are 
changed, all similar objects will be change together. For example, if you have two identical washbasins in 
your bathroom and apply a different material to one of the two washbasins, the other washbasin will 
change as well. 



OBJECTS AND GROUPS

PLACING OBJECTS AND OBJECT GROUPS

Placing of these items differs slightly, depending on which of the two possibilities you have used to select 
your objects and groups.

Placing of these items furthermore depends on which of the three view types you are currently in. In the 
following, the placing of objects and groups is described in dependence on the view type and the means 
of selecting the items.

In the plan view , the mouse pointer has the form and functions of the 2D mouse pointer as for the 
Construction Mode , while in the top view    and in the perspective , the mouse pointer uses the forms and 
functions of the 3D mouse pointer. Detailed information on the 3D mouse...

 PLAN VIEW
 If you have selected an object or an object group via the Objects and Textures Catalog , drag it with the 
left mouse button pressed into your project. When you release the left mouse button, the item will be 
placed. 

The mouse pointer changes its form from an arrow to a cross as soon as you drag it into the view window 
in order to place the object. The selected object will not be displayed as long as the mouse pointer is 
moving over the view window. Only after placing of the object will it be displayed in a selection frame as a 
selected object.

If you have selected an object or an object group via the Furnishings menu, drag it into your project 
without pressing a mouse button. By clicking on the left mouse button, the position for the item is 
confirmed and the item placed.

When placing the item, the collision detection function becomes available by pressing the Ctrl key. Using 
collision detection, you can prevent individual items from interfering with one another. 

 TOP VIEW
 In this view type, the mouse pointer has the full function of the 3D mouse. You can place your objects in 
the x, y and z directions. Detailed information on the 3D mouse...

Loading using the Catalog

If you have selected an object or an object group using the Objects and Textures Catalog , you can 
drag it into your project while holding down the left mouse button. With the left mouse button alone you 
place the object in the x and y directions, whereas you can place the object in the x and z directions by 
pressing the left and right mouse buttons together. When you release the left mouse button, the object will
be placed. 

The mouse pointer can be seen in the view from above as a red “cross”. The selected object will not be 
displayed as long as the mouse pointer is moving over the view window. Only after the object has been 
placed will it be displayed in a selection frame as a selected object. 



Loading via the menu

If you have selected an object or an object group via the Furnishings menu, you can drag it into your 
project without pressing a mouse button. You then place the object in the x and y directions, whereas by 
pressing the right mouse button alone, you place the object in the x and z directions. By clicking on the 
left mouse button, the position of the object is confirmed and the object is placed.

The selected object will be displayed immediately in the view window, and after placing will be shown in a 
selection frame. 

When placing the item, the collision detection function becomes available by pressing the Ctrl key. Using 
collision detection, you can prevent individual items from interfering with one another. 

 PERSPECTIVE
In this view type, the mouse pointer, as in the top view, has the full functions of the 3D mouse. You can 
place your objects in the x, y and z directions. Detailed information on the 3D mouse...

The motion and function of the 3D mouse in the room in combination with the left and the right mouse 
button depends on the settings made under Movement while holding down the right mouse button in 
the General settings dialog box. You access this dialog box by choosing General... from the Options – 
Program menu. more detailed information on these settings... 

In the perspective view, the 3D mouse is displayed as a spatial cross-wire (six-fold arrow) with a “shadow 
streamer”.

Loading using the Catalog

If you have selected an object or an object group using the Objects and Textures Catalog , you can 
drag it into your project while holding down the left mouse button. 

Depending on the settings made in the General settings dialog box, there are considerable differences 
between placing objects by pressing the left mouse button alone and pressing the left and right mouse 
buttons together. If you release the left mouse button, the object will be placed. 

Loading via the menu

If you have selected an object or an object group via the Furnishings menu, you can drag it into your 
project without pressing a mouse button. By clicking on the left mouse button, the position of the object is 
confirmed and the object is placed. The left mouse button has no other function. With the right mouse 
button you control the depth.

The selected object will be displayed immediately in the view window, and after placing will be shown in a 
selection frame. 

When placing the item, you can use the collision detection function by pressing the Ctrl key. 



SELECTING AND DESELECTING OBJECTS

All objects that you wish to edit in any way whatsoever must first be selected. The process of selecting is 
identical in all three view types of the Design Mode. It applies both to objects and object groups. Only the 
selection frames differ    in appearance from one another.

SELECTING AND DESELECTING ONLY ONE OBJECT

You can select one object by clicking with the left mouse button above or in the required object. The 
selected object will be displayed in a selection frame. You deselect an object by selecting a different 
object or by clicking at a position where there is no object.

SELECTING AND DESELECTING SEVERAL OBJECTS

You can select several objects by holding down the Shift key and with the left mouse button clicking on 
the objects one after the other. If you click again on a selected object while the Shift key is still pressed, it 
will be deselected.

SELECTING ALL OBJECTS

You select all objects by clicking with the left mouse button on  or by choosing Select all from the Edit 
menu.



MOVING OBJECTS AND OBJECT GROUPS

Only selected objects and object groups can be moved. The nature of the movement differs slightly for 
the three types of view . The selection frames have different types display. While you are moving objects 
or groups, the associated selection frame is temporarily switched off. The form and function of the mouse 
pointer depends on the view type you are currently in. 

To prevent the individual objects from submerging into one another or moving an object into a wall, press 
the Ctrl key during movement of the object over the groups. This will switch on collision detection. The 
object can now be placed directly next to another object or directly at the wall. 

MOVING OBJECTS AND OBJECT GROUPS WHEN THE GRID IS SWITCHED
ON

If in Design Mode the button  is depressed, moved objects snap to position just as elements laid in 
Construction Mode. This is valid also in the perspective view, where the objects then snap to the grid not
only in width and depth, but also in the height. 

Note: The grid is not displayed in the top view and in the perspective view, even if it is switched on. 

 MOVING IN THE PLAN VIEW
 The selected objects and object groups are surrounded by a black selection frame. The objects can only 
be moved in the x and y directions. The mouse pointer has the function of a 2D mouse pointer.

 MOVING IN THE TOP VIEW
Moving in (x)width and (y)depth

Move the mouse pointer into the selection frame of the object or the group and with left mouse button 
pressed move the object or the object group. When you release the mouse button, the object will be 
placed at the new position. 

The selected objects and groups can only be moved in the x and y direction. Moving in the z direction by 
only pressing the left mouse button is not possible.

Moving in (x)width and (z)height

Move the mouse pointer into the selection frame of the object or the object group and with the left and 
right mouse button pressed, move the object or the object group. After releasing the mouse buttons, the 
object will be placed at the new position.

The selected objects and groups cannot be moved in the x and z direction. Movement in the y direction 
with the left and right mouse button together is not possible. 

 MOVEMENT IN THE PERSPECTIVE 



 In this view type the 3D mouse has the appearance of a shadow streamer. Because of the shadow 
streamer of the mouse pointer under the selection frame, the association is shown between the floor level
of the story and the object or group to be moved..

You can use this shadow streamer to estimate the position on which the object    will “landÓ after 
releasing the left mouse button, assuming that Object dropping has been switched on for this object. 

In the General settings   dialog box    you can additionally influence the direction of motion when moving 
objects with right mouse button held down

Moving by (x)width, (y)depth and (z)height

The motion and function of the 3D mouse in the room in combination with the left and the right mouse 
button depends on the settings made under Movement while holding down the right mouse button in 
the General settings dialog box. You access this dialog box by choosing General... from the Options – 
Program menu. more detailed information on these settings... 

Note: To simplify the movement of objects, it can be useful to load a second view in the main window. 
The first window then shows, for example, the plan view or the top view, and the second window the 
perspective view.

In the plan view or the top view, it is quite simple to move objects in the x or y direction, whereas in the 
perspective view it is easier to move them in the z direction. 



LOADING AND SAVING OBJECTS

Apart from the management of objects and object groups using the Textures and Objects Catalog, these 
objects can also be managed via the menus. If you choose Load object... or Save object... from the 
Furnishings menu, an appropriate dialog box will appear for the command. These dialog boxes are 
described in more detail in the following sections.

DIALOG BOX SAVE OBJECT

You are presented with this dialog box if you choose Save object... from the Furnishings menu. This 
command is only active for a selected object. If no object is selected or if several objects are selected, this
command is grayed out and without function. 

The dialog box that appears is the standard Windows 95 dialog box for saving files. 

DIALOG BOX LOAD OBJECT

You are presented with this dialog box if you choose Load object... from the Furnishings menu.

The only difference between this dialog box and a normal Windows 95 dialog box for loading files is the 
preview window. In this preview window you can view an object before actually loading it into ArCon. For 
this to be possible, a valid ArCon object file (file extension aco) must be selected. 

Note: If there are several ArCon objects in a row in the file list – and you have marked one of these 
objects – you can quickly obtain a preview of the other objects by using the cursor keys Up arrow or 
Down arrow. 



DIALOG BOX OBJECT SETTINGS

This dialog box appears after double-clicking with the left mouse button on an object. This object can be, 
but need not necessarily be selected.

All objects possess predefined properties, such as appearance on the one hand, and on the other hand 
properties you cannot see directly. Using this dialog box you change the properties of the object. For 
example, you can change the behavior of an object on placing it or change information concerning the 
light source of lamps. 

In the upper area of the dialog box you will find the name of the object. Situated below this to the left is 
the area with the editable properties and to the right the area with the preview window.

DIMENSIONS

In this area are the current dimensions such as length (x), width (y) and height (z) as numeric values. 
You can increment and decrement these values in steps by clicking on the arrow buttons or by clicking in 
the input field and then entering the values via the keyboard.

Disproportionate resizing

If you check the check box disproportionate resizing, the dimensions of the object have no direct 
relationship to one another and can be changed completely independently. In this way, you can change 
the length of the object, for example, and the width and height remain at the set values. In contrast to 
this, when this check box remains unchecked, the dimensions of the object are interdependent. If one 
value changes, the other two will also change in the same ratio. The proportions of the object remain 
unchanged.

You can also change the size of your object interactively using the selection frame. The appearance and 
function of the selection frame differ depending on the setting for disproportionate resizing.

Mirroring

If the check box mirror is checked, the object will be mirrored about its central axis. This function is 
identical with clicking on the button  .

HEIGHT

If you check calculate height (‘after free fall’), objects in your project fall automatically. If this function is 
activated, then height above floor is grayed out and has no function.

This function is not active for all objects. It is undesirable for certain objects that they fall to the floor (e.g. 
radiators). In the case of these objects, this check box is grayed out and you can using the function 
height above floor to enter the height of the object numerically. If the field is grayed out, however, the 
actual height of the object above the upper surface of the floor is noted here. If, for example, a cup is 
standing on a table 80 cm high, the height for the cup will be stated as 80 cm. 



If you have not checked calculate height (‘after free fall’), then you can enter a numeric value in height 
above floor at which the object is to be placed. In this way, washbasins, taps and radiators, etc. can be 
installed at an exact height from the floor.

LIGHT SOURCE

This area is only active for lamps, otherwise it is grayed out and without function. Here you have the 
possibility to optimize and adjust a light source and its intensity. You can control the range of the light 
beam, the brightness of the lamp, choose the color of its bulb or switch the lamp off completely.

All settings made in this area influence the appearance of your project only in the night view .

Slide control: Beam range

The Beam range controls the size of the light beam. The larger you make the Beam range, the further 
the light source radiates into the scene. 

Slide control: Intensity

When you move this control, you change the brightness of the lamp. The brighter you set the slide 
control, the more contrast is contained in the shadows of the objects which are illuminated by this lamp.

It is however particularly important when computing ray tracing-images    that you do not set the intensity 
of light sources too high, as this would result in over-illumination. 

Color

Using this function you can determine the color of a lamp.

After clicking on the Define... button, the standard Colors dialog box opens. 

By setting a Color you can mix various lighting effects using lights of different colors. The colors of the 
individual lamps intermingle seamlessly and interesting effects result when ray tracing . 

The check box: causes shadows when ray tracing

If the option causes shadows when ray tracing is active, every object that is illuminated by this lamp will
cast shadows. The contrast of the shadow depends on the setting of the slide controls Range and 
Intensity.

With this setting you can achieve interesting ray tracing effects for objects which are illuminated by 
several lamps. 

The check box: switched on

This check box can be compared with the function of a light switch. The lamp is either switched on or 
switched off, and in the switched off condition has no influence on the illumination of your project in the 



night view . This function is identical with the button     when the lamp is selected in Design Mode. 

With this function you can specifically switch individual lamps of an object on and off to test the various 
effects on the illumination of your project.



USER-DEFINED GROUPS

In ArCon you have the possibility to define groups of individual objects in order to be able to use them 
again or to store them in catalogs for use in other projects. This gives you fast access to frequently used 
combinations of objects. In this way, you save the time you would otherwise need for repeated bringing 
together of individual objects for the same group.

You can thus define and save a complete combination of individual objects, e.g., a complete dining corner
with a table, chairs, ceiling light and table decoration. 

PUTTING GROUPS TOGETHER

All individual objects which you wish to group together in your project must first be selected and grouped. 

To select several objects, hold down the Shift key and click in turn on the objects that you wish to place 
into a group. Now click with the left mouse button on  or choose Group from the Edit menu. The 
selected objects are then grouped together in a selection frame. By clicking on 

 or choosing Ungroup from the Edit menu you can reverse the grouping. You will find more detailed 
information on grouping on page.

In the associated Group settings dialog box you then enter a name for the group. You will find more 
detailed information on the dialog box on.



SAVING AND LOADING GROUPS

If you wish to save an object group that you have produced for later use or use a saved object group 
again, Choose Save group... or Load group....from the Furnishings menu. You can also drag the object
group into a folder of the object index in the Textures and Objects Catalog.

If you choose the route of the Furnishings menu by choosing the Save group... or Load group... option,
the relevant dialog box will open.

After you have loaded and placed a group, the selection frame will appear around the group. These 
groups have the same properties and can be edited as for all other objects.

To delete a saved group, first select the file in one of the dialog box by clicking on the filename under 
which the group was saved. The selected file will be deleted from the dialog box by pressing the Del key.

Group settings dialog box

If you have grouped together several objects or even groups to a group or to a super-group by selecting 
and then grouping them, by double-clicking on one of the objects in this group, you can make settings for 
the whole group. The following dialog box will appear.

This dialog box is almost identical with the Object settings dialog box . In this section only the differences 
will be described, for the similarities, please read the section Object settings.

At the very top of the dialog box an input field is displayed in which you can give the group a name. The 
default name is <Unnamed group>. The other entries in the dialog box refer not just to one individual 
object, as for the object settings, but to all objects together. 

The area Dimensions, for example, does not describe the size of one object in this group, but the size of 
the entire group in terms of width, length and height. If you enter information on the light sources, this will 
be applied to all lamps present in this group. 

Naming groups 

In contrast with objects, for which a name is permanently stored in the objects themselves, groups have 
no pre-defined name. You can enter this name in the upper data entry field of the dialog box. You will see 
your group name on the one hand when you click on the group again, and on the other hand when you 
drag the group into the Catalog    using drag and drop. 



COLLISION DETECTION

In principle you can place an object or object groups, with the exception of automatic falling, at any 
position in the project. It should therefore be possible to place an armchair in a cupboard, although this 
would appear rather dubious, of course.

To prevent this from happening, you can use so-called collision detection. With this method, internal 
computations are made when objects and object groups are moved to check whether they would collide 
with any other objects that have already been placed.

As collision detection requires a relatively large amount of computer time, and it would be rather awkward 
to move a cupboard from one room to another by pushing it through the door, collision detection is 
generally switched off. You can activate collision detection by pressing the Ctrl key.

While you are pressing this key, an object can only be moved in the free room. This means that when you
come too close to the cupboard with the armchair, further movement in this direction is prevented.

Collision detection is also very suitable for placing objects in the plan view     or in the top view 

 .
This method is very useful when putting together cupboards consisting of several individual elements. To 
do this, select a cupboard unit that has already been placed in the room and while holding down the Ctrl 
key drag it against a wall until it cannot be moved any further. The cupboard unit is now situated as close 
to the wall as possible. Proceed now with a second cupboard unit in exactly the same way as the first, 
however, drag this cupboard unit against the other until it cannot be moved any further. The cupboard 
units are now situated directly next to one another. It may be necessary to move the last-placed cupboard
unit a little closer to the wall. To do this, simply push the cupboard unit towards the wall while holding 
down the Ctrl key until it cannot be pushed any further.. Both cupboard units are now situated as close to 
one another and as close to the wall as possible. Any number of objects (e.g., cupboard units) can be 
arranged next to each other without them intertwining.

You can compare this procedure with moving furniture around in a room. The main difference is that the 
result of moving the furniture can be seen on the screen— without the involvement of large amounts of 
physical effort.



THE SELECTION FRAME

If an object is selected, it is shown in the plan view with a black frame and in the top view or perspective
view surrounded by a transparent frame. In ArCon’s Design Mode, you can edit objects only if they have 
been selected in this way.

Depending on the view you are currently in, the display of the selection frames varies.

 PLAN VIEW
In the plan view, the selected objects or object groups are shown red with a black selection frame which 
encloses these objects. In the corners of this frame, or, depending on the setting for distortion, also at the 
sides, small black squares with which you can distort the object uniformly. To do this, place the mouse 
pointer onto one of the squares and drag the object with left mouse button pressed. The right mouse 
button has no function in this view and therefore also no influence on the selection frame.

If distortion is not permitted (Object settings dialog box), then it is only possible to uniformly resize the 
object in width, depth and height. 

By double-clicking on the selected object or the object group, the dialog box Object settings    or Group 
settings will be opened. In this box you can activate distortion. The selection frame now shows eight 
squares: Four in the corners and another four in the middle of the edges of the selection frame. With 
these squares either the width and height or depth and height of the object can be changed.

 TOP VIEW AND 
 PERSPECTIVE VIEW

 If you are in one of these view types, the selected objects or object groups will be enclosed in a three-
dimensional selection frame. The edges and corners as well as the surface centers of this frame are 
highlighted in color. These colored markings mean that you can alter (distort) the selection frame in its 
dimensions.

Colored marking of the selection frame:

red corners alter all three dimensions 

(width, height and depth).

The diagonally opposite 

corner remains unchanged.

green edges alter two dimensions 

(width + height, width + depth

or height + depth). 



The diagonally opposite

side remains unaltered.

blue ball segment at center of the selection surfaces 

alter one dimension 

(width or height or depth). 

The opposite surface 

(side) remains unaltered.

If the mouse pointer is situated above one of the colored marks, its shape changes to a cross. You can 
then perform the distortions by dragging with the mouse pointer with left mouse button pressed.

If distortion is not permitted, then you can the only uniformly resize the object in width, depth and height at
the red corners. The blue hemispheres are then missing on the surfaces in the selection frame and the 
green edges have no function.

By opening the Object settings dialog box, you can activate distortion as described in the previous 
section. The blue hemispheres on the selection frame surfaces are then displayed. All corners, edges and
surfaces then have the functions described above.

You can reset all of the changes you make to the objects and object groups to their initial settings using 
the command Reset initial values in the Object settings dialog box.



WORKING WITH THE VERTICAL TOOLBAR IN DESIGN MODE

With the functions described in the following you can alter the position of objects already placed and 
selected. They apply equally to individual objects and to object groups in the plan view , in the top view    
and in the perspective view . You cannot make a direct change to the dimensions of these objects with 
these functions.



 SELECT ALL
Each object in your project which is to be edited in any way must first be marked with a selection frame 
(selected).

By clicking with the left mouse button on  or choosing Select all from the Edit menu, you can select all 
objects and object groups. Every object in your project will be selected and enclosed by its own selection 
frame.

Please note that this really does select absolutely every object and object group, therefore also those in 
stories set to invisible . 



 GROUPING
By clicking with the left mouse button on  or by choosing Group from the Edit menu, you can join all 
individual selected objects and object groups together into a group. The individual selection frames will be
replaced by a large selection frame which encloses all objects. 

You treat such a group as if    it were a single object; i.e. you can, for example, move, copy    or delete    all 
objects in this group at once. 
Groups of frequently required objects can be saved as user-defined groups in the Textures and Objects 
Catalog. In this way you can define your own Catalogs in which you can store and manage frequently 
required objects or object groups. The Furnishings menu also provides for this purpose the commands 
Save group    and Load group .



 UNGROUPING
With the function Ungroup you can return an existing grouping back to the individual objects or to the 
individual object groups. This menu item is only active if an object group is present among the selected 
objects.

Ungrouping is performed by clicking with the left mouse button on  or by choosing Ungroup from the 
Edit menu.



 COPYING 
This function is only active for selected objects and object groups. If no selected objects or groups are 
present, this button has no function. 

You copy the selected objects or object groups by clicking with the left mouse button on  or by selecting
Copy from the Edit menu. The newly copied object is always displayed with the selection frame and can 
therefore be further used as an original for copying. In the Copy dialog box, you can define the position in 
your project where the copy is to be deposited (front, back, right or left with reference to the selection 
frame).

The copied objects have the same properties as the original, which you can change in the Object settings 
dialog box or using the selection frame.

COPY DIALOG BOX

You access this dialog box by clicking with the right mouse button on the button . In the area 
Positioning, you now select the direction in which the object is to be copied with reference to the 
selection frame.



 DELETING
This function is only active for selected objects and object groups. If no selected objects or groups are 
present, the button is grayed out and has no function. 

You delete the selected objects and object groups by clicking with the left mouse button on  or by 
choosing Delete from the Edit menu or pressing the Del key.

In the Delete dialog box, you can set whether in the case of several selected objects or object groups 
additional confirmation by means of a “precautionary message” is required.



DELETE DIALOG BOX

This dialog box is opened by clicking with the right mouse button on the button  or by choosing 
Delete... from the Options menu.

If you check the box by more than one 3D object, an additional dialog box is opened if deleting several 
selected objects or object groups with which you have the possibility to prevent deletion of each individual
object or group.

CONFIRM DELETE DIALOG BOX

This dialog box is automatically opened when, as described above, you have checked for several 3D 
objects and execute the Delete command. If you are only deleting one object, this dialog box does not 
appear.

The object name of the individual object or the individual object group appears in the dialog box. You can 
now confirm the delete command with Yes or with the Enter key, prevent further requests for confirmation
with Delete all and delete all selected objects immediately or, by entering No, omit individual objects 
without deleting them. You quit the dialog box with the Cancel button or the Esc key, whereby you must 
note the fact that all objects or groups confirmed with Yes up to that point will be deleted.



 ROTATION
This function is active only when one or several objects or object groups are selected . If no objects are 
selected, this button is grayed out and has no function.

The selected objects and object groups are rotated by clicking with the left mouse button on the Rotate 
button or by choosing Rotate by...from the Edit menu.

You have the possibility to rotate the objects and object groups by 90°, -90°, 45°, -45°, 30° and -30°. 

Using the option switch you can also choose the option Free rotation. This special form of rotation allows
you to turn the object in infinitely variable steps by any desired angle. If this option has been selected, a 
slide control appears in the vertical toolbar with which you can set the angle of rotation to any desired 
value. If the new angle is to your liking, you confirm this by clicking on the left mouse button. The object 
remains in the new position and the slide control is removed from the screen. You can also cancel the free
rotation setting by pressing Esc.

All objects and object groups rotate around their center, i.e., around the vertical central axis of the 
selection frame. Positive angles mean rotation in a clockwise direction and negative angles rotation in a 
counter-clockwise direction.



 MIRRORING OBJECTS AND GROUPS
This function is only active if one or several objects or object groups are selected . If no objects are 
selected, this button is grayed out and has no function.

The selected objects and object groups are mirrored by clicking with the left mouse button on  or by 
choosing Mirror from the Edit menu.

All objects are mirrored around their center axis, i.e. the sides of the objects are swapped over. In objects 
of an object group, not only are the sides exchanged, but also the position of the objects relative to one 
another.



 ALIGNMENT
These functions are active only if at least two objects or object groups are selected . If only one object or 
no object is selected, this button is grayed out and has no function.

The selected objects and object groups are aligned by clicking with the left mouse button on the 
Alignment option switch or by choosing Alignment from the Edit menu.

Using the Alignment command on the menu bar, the alignment type currently shown on the option switch
will be executed. Via the menu bar you have no influence on the settings for the alignment type.

You have following possibilities to change the relative position of objects and object groups:

· align objects and object groups to the left or right

· align objects and object groups horizontally centered or horizontally equidistant

· align objects and object groups to top/rear or bottom/front

· align objects and object groups to top/bottom (front/back) centered or top/bottom (front/back) 
equidistant

· align objects and object groups in height or on the floor

· align objects and object groups in height centered or in height equidistant

The use of the terms left, right, front, back, top, bottom in the items above will appear on first sight 
somewhat confusing; for this reason, a few explanations will now follow. 

· In the 2D views, i.e., the plan view and the top view, the terms left, right, top and bottom are clear. 
You refer directly to the image that you see. Although alignment in the z direction is also possible in 
these views, you will hardly ever use it as you are not able to observe the effect. 

· For the perspective view, the specification left and right is also oriented on your screen (this depends 
on whether you view your scene from the back or from the front). The specifications to the back 
and to the front are relative to your position – therefore    if you have selected to the back, the objects 
will always be aligned “away from you” (this is independent of the direction from which you are looking 
into your scene). The specifications on z direction always describe the direction vertically to the floor, 
i.e., upwards in your plan (but not necessarily on your screen). 

If you have selected at least three objects or object groups, you can move these such that they are all 
spaced at the same distance from one another in one particular direction. If you select four objects, for 
example, and then choose the button horizontal equidistant (in x), then the first and the last (the fourth) 
objects will remain in the same position. The objects in between will be moved to the left and to the right 
until the resulting distance between the individual objects is identical.

Alignment of objects and object groups requires a little practice. Try out the individual functions provided 
by ArCon using a simple example.





 LAMPS ON/OFF
This button is active only when you have selected one or several self-illuminating objects (standard lamp, 
ceilings, table lamps, etc.). If no lamps are selected    or there are none at all in your project, this button is 
grayed out and has no function.

You can switch lamps on or off by clicking with the left mouse button on  or by choosing Lamps on/off 
from the Edit menu.

If you then switch to night view with  , then all rooms with their objects will be illuminated by these 
lamps. However, if you are in the day view , the button Lamps on/off has no influence on the appearance
of the rooms in your project.

The brightness of the lamps is adjusted via the dialog box Brightness. 



 OPTIMAL COLOR PALETTE
This button appears only if you are operating Windows in color index mode; i.e., Windows uses only 256 
colors or fewer. When Windows is operating in High Color or True Color mode, this button will not be 
shown.

If you are operating Windows in color index mode, ArCon reduces the colors for the computed images 
before displaying them. The method used, so-called dithering, is similar to the screening of images for a 
newspaper. It has the advantage that the computation is very quick. The result is that your images may 
appear somewhat grainy. 

You are given the possibility by clicking on  to compute the optimal color palette for a colored view. It is 
thus possible to achieve an acceptable output in terms of color quality, in spite of the 256 or fewer colors.

However, your current view will only be temporarily optimized. All other views and Windows application 
will appear “more colorful”, as their color palettes no longer match the display.
You also have the possibility to use an optimal color palette when you save colored views to a file . This 
reduces the hard disk space required for saving an image by a factor of 3 with almost no loss in quality.



SPECIAL
Two features of ArCon will be described in the following section which you will only need to use if you 
have certain types of hardware connected to the PC on which you are running ArCon.

One special feature the ability to transmit ArCon-projects via e-mail using the mb-Mail Assistant, the other 
is the use of processors with MMX technology. Even if you have never used e-mail before, the term will 
certainly not be unfamiliar to you. With the help of the mb-Mail Assistant integrated in ArCon you can send
ArCon projects to anywhere in the world, e.g. to your architect if you are building a house, or to a potential
client if you are an estate agent. The use of MMX processors will probably possible from January 1997, 
when these processors will be generally available. ArCon already contains special code for these 
processors, by means of which a considerable increase in display speed can be achieved.

THE MB MAIL ASSISTANT

The Assistant assists you in transmitting your ArCon-project via e-mail. In order to be able to send e-
mails, you need access to the Internet and have Microsoft Exchange correctly installed on your computer.
You call up the mb-Mail Assistant by choosing Send from the File menu. Apart from sending your current 
project, you can also attach an accompanying letter to your e-mail or even draft a new letter from within 
the Assistant. To use this function, Microsoft Word for Windows 7.0 must be installed on your system. 
Operation of the Mail Assistant is divided into the five steps described in the following.

STEP 1 OF 5
This is merely an introductory    window in which no input is required. Click on Continue to proceed with 
Step 2 of 5 or exit the Mail Assistant with Cancel.

STEP 2 OF 5
Here you select whether you wish to attach an accompanying letter to your project. If so, you check the 
box Attach letter and choose one of the options described in the following. If you do not intend to attach 
an accompanying letter, click on Continue to proceed with Step 5 of 5 or exit the Mail Assistant using the 
Cancel button.

THE OPTION ATTACH EXISTING FILE

If you select this option, a valid document name must be present in the Name field to be able to proceed. 
You have the possibility to enter this directly via the keyboard or to choose a filename with the help of a 
standard dialog box by clicking on the button Browse.... When you have entered a valid filename, you 
proceed to    Step 5 of 5 by clicking on Continue.

THE OPTION PRODUCE NEW FILE

If you have selected this option, the Continue button will take you to Step 3 of 5. Please note that this 
option is only possible if Microsoft Word for Windows 7.0 is installed on your system.

STEP 3 OF 5
Here you select a document template with which Word for Windows is to be started. You can choose 



between the Word Normal template and five mb-templates. Furthermore, you also decide on the ultimate 
name for your document in this step. You can enter this by clicking directly on the input field or enter it in a
standard dialog box by clicking on the button Change.

Please note that you must save your accompanying letter in Word for Windows with the same document 
name as the one entered here. The Mail Assistant will otherwise not be able to recognize it.

STEP 4 OF 5
No input is required in this step. Information is merely displayed briefly explaining the further procedure. 
Once you have read the message, click on Continue and Word will be started automatically. When you 
have written and saved your accompanying letter, you must leave Word for Windows and will then be 
taken to Step 5 of 5. To correct the entries you made previously, click on the button Back and you will be 
returned to Step 3 of 5. By clicking on Cancel you can cancel the entire procedure and return to ArCon.

STEP 5 OF 5
In this step you are shown once again the files that are to be sent. These include the name    of your 
project file and, assuming you are attaching an accompanying letter, the corresponding document file 
name. If this information is correct, click on Send. This will start Microsoft Exchange and the documents 
displayed will be automatically attached to a new e-mail. Finally, you only need then to enter the e-mail 
address and your project will be sent as an e-mail by clicking on Send.



RUNNING ARCON ON PROCESSORS WITH MMX TECHNOLOGY

First introduced to the public in the spring of 1996, Intel’s MMX technology has created the possibility to 
vastly increase the computational speed of three-dimensional graphics on standard processors. ArCon 
supports these latest-generation processors. Therefore, if you have installed a processor with MMX 
support in your computer, this will be used by ArCon. If you do not have an MMX processor, the relevant 
processor instructions will not be used. 

The only difference that you will see when using an MMX processor is the speed advantage. This will be 
particularly noticeable when walking around your home. You can even determine whether the MMX 
processor instruction set is to be used for a certain view. If such a processor is installed in your computer, 
a button with the MMX symbol will appear at the far right of the second horizontal toolbar in the Design 
Mode.

If this button is depressed, ArCon will use MMX instructions, otherwise it will not. You can therefore decide
for yourself whether the display should appear quickly or slowly and you can get an idea of the actual 
difference in speed produced from the use of an MMX processor. Please note that the MMX ability of your
processor will only be used when images are computed in High Color mode. However, if you are using 32
bits per pixel, no MMX support is provided in the present version of ArCon. 

Even when using MMX, the same premise applies: the smaller the images in the walkabout, the faster 
they will be generated on the screen. In contrast to image generation without MMX, however, it is 
practically irrelevant whether you use the view type  or the view type 

. Because 
 produces the better results, you should always select this view type when using MMX processors.



WINDOWS

Placing of windows in ArCon conforms with the procedure used in Windows 95.

STANDARD DIALOG BOXES

The dialog boxes Load, Save, Print, Printer setup conform with the standard dialog boxes of Windows 95.

STANDARD DIALOG BOXES WITH PREVIEW FIELD

The dialog boxes for loading objects and loading texture have been updated to include a preview window 
to make selection simpler.



APPENDIX
 KEY ASSIGNMENTS IN ARCON

Apart from the keys mentioned in the following table, you can also use the keys or key combinations you 
will find next to the menu items in the individual menus.

Function keys

F1 Help

F3 In the Construction Mode, temporary deactivation of

snapping up until the next mouse click

F5 In the Construction Mode with the rule on:

Switching between raised and lowered rule

F6 In the Construction Mode with the rule on:

Switching between rule edge below and rule edge

on top

F7 In the Construction Mode with the rule on:

Parallel shift of the rule

F8 In the Construction Mode with rule on:

Rotate rule by a relative angle

F9 In the Construction Mode with rule on:

Rotate rule vertically to current direction

F10 In the Construction Mode with rule on:

Set rule to horizontal position



Zoomen

Key 0 Corresponds with the function Show all

Key 1 Shift image section to bottom left

Key 2 Shift image section down

Key 3 Shift image section to bottom right

Key 4 Shift image section left

Key 6 Shift image section right

Key 7 Shift image section to top left

Key 8 Shift image section up

Key 9 Shift image section to top right

Key + Image section enlarged centrally

Key - Image section reduced centrally

Key * Image section enlarged centrally around the

current mouse pointer position

Key / Image section reduced centrally around the

current mouse pointer position



Cursor keys

In entry fields of dialog boxes

Arrow up Increment value by 1

Arrow down Decrement value by 1

Page up Increment value by 10

Page down Decrement value by 10

In all views, with the exception of the perspective view, both in the Construction Mode and in the Design 
Mode the cursor keys have the same function as the keys 4, 8, 2 and 6 on the numeric pad

In the perspective view, the cursor keys correspond with the four directions on the button  .



Special keys in the Construction Mode

Ctrl-W Swapping reference points of elements

or swapping between wall axis entry / left wall side entry/ 

right wall side entry

Ctrl-Q Swapping between wall axis left / right wall side 

for beginning of a wall just inserted

Ctrl-E as Ctrl-Q or Ctrl-E, but for end of the wall just inserted

Ctrl-F select next possible snap point



Special significance of the Ctrl and Shift keys

Ctrl 1. Prevents dialog boxes from opening

in the Construction Mode

2. Extended input on moving walls 

3. Moving objects in the Design Mode:

Collision detection

4. During walkabout in the Design Mode:

speeds up by a factor of 4

Shift 1. When inserting elements in the 

Construction Mode: extended input

2. During walkabout in the Design Mode:

speeds up by a factor of 4

3. Selection of several objects

Ctrl/Shift 1. During walkabout in the Design Mode:

speeds up by a factor of 4




